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Summary of Changes

This revision of the user’s guide contains the following changes to the 
district integration process.

Page Number Change

29, 50 Added the DILogFileRetention entry in the example of 
the SASIxp.ini file.

35–36 Added the "Instructions for Schools using Oracle or 
dBASE IV Databases with Oracle Database at the 
District Level" section.

36–38 Added the "New Entries in the RDBMS.ini File of the 
Task Server Folder" section.

39 Added the "Sample RDBMS.ini File for Oracle 
Database at District and School Level" file.

40 Added the "Instructions for Schools using Microsoft 
SQL Server Databases with a Microsoft SQL Server 
Database at the District Level" section.

41 Added the "Sample RDBMS.ini File for Microsoft SQL 
Server Database at the School and District Sites" file.

42–43 Added the "Instructions for Schools using dBASE IV 
Databases with a Microsoft SQL Server Database at 
the District Level" section. 

47–49 Revised the "Site Setup" section.

51–52 Revised the "Campus Setup" section.

58, 60 Revised the "Automated Upgrade" section.
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Description

This guide describes the process of planning, implementing, configuring, 
verifying, and using the District Apps module of the SASIxp™ student 
administrative software made available by Pearson School Systems.
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Description

Prerequisites
Pearson School Systems recommends having these skills and knowledge 
sets for the proper use and understanding of this guide:

! Installation, configuration, and operation of the SASIxp™ software.
! Network Administration operations of the LAN/WAN environment 

where you plan to implement the SASIxp District Integration software.
! TCP/IP networking protocol installation and configuration operations of 

the LAN/WAN environment where you plan to implement SASIxp 
District Integration.

! Configuration and Operation of desktop operating systems and 
Graphical User Interfaces (GUIs) necessary to the environment where 
you plan to implement SASIxp District Integration. 

Instructional Objectives
1. Contrast the operational differences between the two standard 

configurations of a single-school SASIxp installation.

2. Define these parts of the SASIxp District Integration software:

! Features and benefits of SASIxp District Integration
! Basic District Integration Theories of Operation
! Product Requirements

3. Perform District Integration installation tasks.

4. Address data installation and conversion issues.

5. Perform District Integration configuration and setup tasks.

6. Perform District Integration operation and user tasks.

7. Set up and operate District Consolidation.
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Description

Scope
This guide addresses the District Integration implementation of the SASIxp 
software. This reference manual is for those individuals who are 
implementing the District Integration operation of the SASIxp software. 
Knowledge of basic SASIxp operations is necessary to understand and 
use this training guide effectively.

The manual contains:

! Topic 1, Description. This topic describes the concepts and 
requirements of the District Integration implementation of the SASIxp 
software.

! Topic 2, Installing Software. This topic covers the information and 
procedures to perform the installation tasks of a District Integration 
implementation.

! Topic 3, Configuring District Integration. This topic provides a 
description of the tasks to configure the systems for the District 
Integration implementation.

! Topic 4, Transaction Monitor. This topic describes using District 
Integration to monitor enrollment transactions districtwide.

! Topic 5, Using District Integration. This topic provides an explanation of 
the District Integration interactive and automated operations.

! Topic 6, District Consolidation. This topic provides a description of how 
to set up and use the District Consolidation feature.

! Topic 7, New Year Rollover. This topic provides an explanation of the 
New Year Rollover processes involved in District Integration.

! Topic 8, Setting Up Summer Schools. This topic explains creating and 
setting up the files for summer school.

In addition, this document contains these appendixes:

! Appendix A, Sample Configuration Worksheets. This appendix 
provides sample worksheets you use to help configure your own 
installation.

! Appendix B, Troubleshooting. This appendix provides information on 
possible errors you may encounter when using the SASIxp District 
Integration.
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Description

District Integration Overview
The District Integration (DI) module expands on the basic SASIxp 
software’s functionality to provide centralized district processing between 
the schools and the district office using a Wide Area Network (WAN.) 

Implementation
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Description

One of the most significant features of District Integration is the ability to 
add, drop, and transfer students in real time. A district file is a form of the 
standard SASIxp school database, which incorporates student data from 
all schools within the DI environment. 

District Integration also provides for scheduled background operations to 
upload student data files from school sites to the district office and update 
the district file on a nightly basis. In addition, District Integration provides 
the ability to download certain files to the school sites.

Because you can replicate data at the district office on a nightly basis, the 
district office staff can view an individual school’s files. District office staff 
no longer log into a school site file server to view school data. District office 
staff can run reports against copies of the individual school site files 
residing on the district file server. They can also run reports against 
consolidated data in the district file.

District Integration is a normal SASIxp installation at the district office with 
some configuration changes and additional directory creations.

District Integration also requires the addition of a specialized type of 
workstation. This workstation is dedicated to running one of the major 
programs of the SASIxp DI module and resides at the district office. This 
workstation runs the SASIxp Task Server program that performs the core 
DI communication operations.

Task Server runs 24 hours a day on one or more workstations at the 
central office. Pearson School Systems recommends a minimum of one 
Task Server workstation for every 10 school sites. The Task Server 
workstations run on either the Windows NT® Workstation version 4.0-SP4 
operating system or the Macintosh System 7.5 operating system. For 
performance reasons Pearson School Systems recommends running the 
Task Server program only on the Windows NT 4.0-SP3 Workstation 
operating system.

Task Server supports these database scenarios:

Note: The configuration changes are also necessary at each of the 
school site SASIxp installations.

District School Site

dBASE IV dBASE IV

Oracle® dBASE IV

Oracle Oracle
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Description

It is possible to run multiple Task Servers on one workstation, if 
appropriate for your installation.

MS SQL dBASE IV

MS SQL MS SQL

District School Site
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Description

DI Real Time Operations

Uploading requires the Task Server to use a valid user account on a 
supported SASIxp site server, and access rights to the resource containing 
the school data.

Operation Description

Add, Drop, and Transfer The Enrollment atom running at the school 
site communicates with Task Server at the 
central office. Together the Enrollment atom 
and the Task Server program immediately 
upload and download student information 
between the school site and central office to 
add, drop, and transfer students throughout a 
district.



8  Implementation Copyright © 2005 Pearson School Systems

Description

Scheduled Background Operations

Operation Description

Upload At the end of the school day, the Task Server 
logs into the school site servers to upload 
data files to the central office. This data can 
be either all qualified site files or only those 
qualified site files that have changed from the 
previous upload process. 

During this process, the SASIxp software 
stores the file you select to copy in the 
Upload folder of the district SASIxp 
installation directory structure. 

In this process, the data for all students 
copies from the school sites to the central 
office. 

Download In this process, selected files download to 
school sites automatically.
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Description

Overnight Update

Overnight Updates require the Task Server to use a valid user drivemap 
on the District server and access rights to the resource containing the 
District data.

Operation Description

Overnight Update After the files copy from the school sites each 
night in the Upload process, the Task Server 
creates a mirror copy of all DI school site 
qualified files. It then updates the central 
office student demographic file with new 
demographic data from the school sites. 

Note: When it finishes this function, the Task 
Server program returns to add, drop, 
and transfer mode.
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Description
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Installing Software

This topic provides a description of the software installation tasks for a 
SASIxp DI implementation. 
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Installing Software

Pre-Installation Considerations
The Pearson School Systems Implementation Manager for your 
installation will review these items with you before the installation visit. 

Pre-Installation Checklist

Note: If these items are not addressed, contact the Implementation 
Manager before installing. 

Step Description

1. Identify contacts

! Pearson School Systems Implementation Manager
! School Representatives

2. Identify the following school record information:

! General tab in the School atom
! Schedule tab in the School atom

3. Confirm all Student IDs are unique.

4. Confirm the Code files at all sites are identical.

5. Confirm the Table files at all sites are identical.

6. Confirm the Course files at all sites are identical.

7. Confirm the File definitions at all sites are identical.

8. Confirm the SASIxp software versions are identical at all 
school sites, including the District Office.

9. Have all data installation questions answered by the Pearson 
School Systems Implementation Manager.
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Installing Software

Contacts

Before installing the SASIxp DI software, identify the Pearson School 
Systems and school representatives responsible for the DI 
implementation. Within Pearson School Systems, the SASIxp 
Implementation Manager is the primary internal contact for addressing and 
resolving any issues that arise during the DI implementation. 

School Records

Identify the school site record information from the General and Schedule 
tabs in the School atom. All schools taking part of the DI implementation 
have a type of District configuration worksheet. This information facilitates 
the initial configuration of the district site SASIxp software installation. The 
district site representative should be responsible for collecting this 
information before the installation.

Student IDs

The students’ identification numbers must be unique at all school sites. 
After installing District Integration, if two or more students have the same 
Student ID only one will continue to exist in the system. The other 
student’s information is written over by the next student with the same ID. 

Code Files

Pearson School Systems recommends the Code files be the same at all 
school sites. Operational irregularities within the SASIxp software occur 
when Code files are not identical. 

For example, the SASIxp software provides the ability to create custom 
discipline codes. This code file contains all of the possible discipline codes 
a district uses within its entire system. Verify all schools, including the 
District school uses identical discipline codes, or your enrollment 
transactions will be affected. If transferring a student to a school that does 
not have the same discipline code, the student may have a value in the 
record that differs from the existing data at the new school.

For instance, school 100 has a Discipline Code 05, Fighting, while school 
200 has a Discipline Code 05, Smoking. When transferred from school 
100 to school 200, the student would have a smoking offense instead of a 
fighting offense. 
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Installing Software

Table Files

Pearson School Systems recommends all Table files be the same at all 
school sites. Operational irregularities within the SASIxp software occur 
when Table files are not identical.

For example, the SASIxp software provides the ability to create custom 
ethnic code tables. This table file contains all of the possible codes a 
district uses within its entire system. Verify all schools, including the 
District school uses identical ethnic codes. If transferring a student to a 
school that does not have the same ethnic code, the student may have a 
value in the record that differs from the existing data at the new school.

For instance, school 100 has an Ethnic Code 1, Asian, and school 200 has 
an Ethnic Code 1, Hispanic. When transferring from school 100 to school 
200, the student would be listed as being Hispanic instead of Asian.

Course Files

Pearson School Systems recommends all Course files be the same at all 
schools sites entering information into a student’s transcript including 
student transfer data. Operational irregularities with in the SASIxp 
software occur when Course table files are not identical.

For example, the SASIxp software provides the ability to create custom 
course code tables. This table file contains all of the possible codes a 
district could use within its entire system.

For instance, school 100 has a Course 1000, English 9, and school 200 
has a Course 1000, English 10. A student transferring from school 100 to 
school 200 would be in an English 10 class, instead of the English 9 class.

File Definitions

Pearson School Systems recommends all File definitions be the same at 
all District Integrated school sites. For District Integration to operate 
properly, the file layout or the record structure of all files at all sites must be 
identical. If adding fields to a school site using the File Definition Pro atom, 
you must add the same fields to the District Office SASIxp installation. 

Verify these files have the same date and time stamp at each school site 
and at the district office:

! FILES.DBF and FILESOLD.DBF
! FILES.MDX and FILESOLD.MDX
! FILES.DBT and FILESOLD.DBT
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Installing Software

Version of the SASIxp Software

All sites, including the district office installation, must use the same version 
of the SASIxp software.

Data Installation

Discuss the following basic concerns of the data installation with your 
Implementation Manager:

! Does the installation include the application of site data or converted 
data? Is it just a basic software load, configuration, and verification?

! What is the type of data installation?
! Is it newly created data, a fresh installation?
! Is the data provided by the SASIxp Data Services Team?
! Is the existing school site data ready for District Integration?
! What type of data is provided by the SASIxp Data Services Team?
! Confirm all Student-related data; Student, Parent, Emergency, 

Discipline.
! Confirm all Non-student related data; Course, Scheduling, Teacher.
! If data installation is included in the implementation, what is the 

estimated availability of data?
! Prior to installation?
! At time of installation?
! After scheduled installation?

! If data installation is not included in the implementation, is the DI 
installer expected to be available when the customer applies data?

! Implementation Manager must verify the installer is aware of all data 
conversion and installation issues relevant to the installation.
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Installation Considerations and Requirements
Consider the following requirements before installing the SASIxp software.

Application Performance and Infrastructure Review (APIR)

Pearson School Systems offers a comprehensive Application 
Performance and Infrastructure Review (APIR) service, which ensures 
your network will support the new Pearson School Systems software. 
Pearson School Systems combines network planning, design, 
implementation, and maintenance expertise with experience in optimizing 
the use of your Pearson School Systems software across a wide variety of 
networks.

Application Performance and Infrastructure

In conjunction with members of your District’s staff, we work through a 
checklist of key elements about your network infrastructure. The checklist 
helps identify your network’s strengths and weaknesses:

! Major Systems/Subsystems.
! Optimization of the Pearson School Systems software on your current 

system.
! Utilization of current hardware.
! Roadmap for your future needs.

Benefits

Using Pearson School Systems professional network services to evaluate 
your current system prior to a major implementation is like having your 
own professional services staff. Without having to make the investment of 
adding full-time staff to the project.

! Pearson School Systems understands how to optimize your use of 
your Pearson School Systems software running on your network.

! Scalable Network Application Site Review options fit your district/
school needs.

! Pearson School Systems can provide a Total Solution, one solid 
company responsible for your complete satisfaction.
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What You Get

Comprehensive review of your network infrastructure by an Pearson 
School Systems network professional. 

! An on-site evaluation by a network engineer familiar with the concepts 
and requirements of your Pearson School Systems software.

! A complete written report documenting the findings.
! Recommendations for your next steps to ensure a complete and 

successful Pearson School Systems experience.

Outcomes

! Determination of District/School Readiness.
! Identification of customer savings through additional site surveys.
! Proposal for additional services and hardware to save you even more 

money.

Contact 

For more information contact your Pearson School Systems 
representative, or call 1-800-336-3426.

Resolving Data Issues

Before beginning a data installation or conversion operation, consult the 
SASIxp Implementation Manager and your school representatives. This 
step ensures all school site-specific data issues are addressed. Pearson 
School Systems recommends all parties agree on the procedures and 
responsibilities for the data installation, creation, or conversion for a 
specific implementation.

The SASIxp DI installer, SASIxp Implementation Manager, and school 
representatives must determine the level of the DI installer’s involvement 
in the process. To avoid any misunderstanding between you and Pearson 
School Systems, perform this task before creating any school site data 
files.

If there is an installation of school sites with no converted data available, 
create new data files for the school sites. Before creating these new data 
files, consult the SASIxp Implementation Manager and your school 
representatives to agree on the files to create and how to populate the 
files. 



18  Installation Considerations and Requirements Copyright © 2005 Pearson School Systems

Installing Software

Networking Requirements

DI implementation requires the use of the TCP/IP protocol for DI real-time 
operations.

! Install and configure TCP/IP protocols on all Task Server workstations 
and SASIxp client workstations performing real-time DI operations.

! Use the Dynamic Host Configuration Protocol (DHCP) to assign TCP/
IP addresses to SASIxp client workstations. Pearson School Systems 
does not recommend DHCP address assignment for SASIxp File 
Servers. Use static TCP/IP addressing on SASIxp Task Server 
workstations.

! Install and configure all other networking protocols necessary for basic 
networking inter-activity of the networking operating system on all 
SASIxp file servers, Task Server workstations, and SASIxp client 
workstations. This process provides access to the shared SASIxp 
database files.

! If SASIxp DI is to operate in a WAN environment and you do not use 
the TCP/IP for file and print service access to SASIxp file servers, the 
networking protocol must be routable.

! For performance reasons, Pearson School Systems recommends the 
LAN topology support at least a 10Mbps-throughput rate. These are 
some examples:
! 10BaseT Ethernet
! 16Mb Token Ring
! 100BaseTX Ethernet

! For performance reasons, Pearson School Systems recommends the 
WAN topology support at least a 128Kbps-throughput rate. The 
throughput rate required will vary depending on the number of students 
at a school. These are some examples:
! 256K analog leased lined
! ISDN-BRI
! T1
! Using Network Address Translation (NAT) at the district location 

will cause enrollment operations to fail.

Task Server Installation Considerations

Pearson School Systems recommends running the DI Task Server 
applications on a dedicated-purpose workstation.
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! For Windows NT or Novell® NetWare® networks, Pearson School 
Systems recommends running the Task Server application on a 
Windows 2000 Pro, Windows XP Pro, or greater workstation platform.

! For an AppleShare® network, run the Task Server on at Macintosh-
type platform using at least MacOS Version 7.5 with 300 MB virtual 
memory.

! When allocating Task Server workstations, consider the network speed 
and number of students. Pearson School Systems recommends 
allocating at least one Task Server workstation for every 10 DI school 
sites.

! Install and configure the Task Server workstation with the TCP/IP 
network protocol and a static TCP/IP address.

! Install the Task Server applications to a local hard drive on the Task 
Server workstation.

! The Task Server software requires some modification to an 
initialization file named SASIxp.ini before running the Task Server 
application.

! The District site installation of the SASIxp software requires 
configuration before running the Task Server application.

! Designate a network user account with multiple logins for each Task 
Server workstation in the network. If the network operating system 
requires a separate user account and password at each file server, 
each Task Server workstation must have a valid user account and 
password. Also, assign a valid Task Server workstation user account 
and password to the District Office SASIxp file server.

! The Task Server workstation user account must have at least Read 
access privileges to the resource holding the school site SASIxp data 
files. If using the download capability, the user account must also have 
Write access to the download directory at the school sites.

! The Task Server Workstation user account must have Full Access 
privileges to the resource holding the district SASIxp software.

! You can run multiple Task Server applications on one computer.

District Office Software Installation Considerations

The SASIxp software requires a separate and distinct installation and user 
license for District Office use. 

Note: Pearson School Systems recommends running not more than 
five Task Server applications on one computer.
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! If using the file server for the District Office installation, you can use it 
as a school site server. To use the District Office installation as a 
school site server, perform the SASIxp installations using a different 
installation directory structure in the file server hard disk.

! All Network user accounts directly accessing the District Office SASIxp 
software and data files must have full file and directory access rights to 
the District Office SASIxp installation directory structure.

! After completing the software installation and updating the SASIxp 
modules, the District Office installation provides additional District 
Apps atoms to facilitate the configuration of District Integration.

! Before installing the SASIxp software at the District Office site, verify 
the SASIxp Software Distribution cover sheet is with the software 
shipment and lists a SASIxp and DI password.

! After installing the SASIxp software, create a folder called Transfer in 
the SASIXp folder on your hard disk.

Cross-Platform Software Installation Considerations

! If your District Office environment uses a Windows NT Server to host 
the SASIxp software and only Windows-based client workstations are 
accessing the SASIxp software, install the SASIxp software either at 
the WindowsNT server console or from any Windows-based client 
workstation.

! If your District Office environment uses Novell NetWare or IntraNetWare 
Server to host the SASIxp software and only Windows-based client 
workstations are accessing the SASIxp software, use a Windows-
based client workstation to install the SASIxp software. 

! If your District Office environment is a mix of Windows-based client 
workstations and Macintosh client workstations, install the SASIxp 
software from a Macintosh client workstation.
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District Office Server Software Installation
These procedures describe an installation on a Windows NT server. The 
actual installation procedures may differ slightly depending on your 
networking environment. These concepts apply, regardless of the actual 
networking environment.

Installing at the Server Console

1. Log on at the server console under an Administrative user account.

2. Create the Network Resource Share location where the SASIxp 
software is installed.

3. Apply appropriate access permissions to the Network Resource Share 
directory structure.

4. Make Network Resource available to network users.

Note: Before installing the software, coordinate the network server 
software installation location, network resources, and user access right 
privileges setup with the site network administrator. 
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Installing from the CD-ROM

Follow the load instructions that accompanies the SASIxp distribution CD-
ROM to install the SASIxp software.

Note: Have the SASIxp Software Distribution cover sheet available to 
provide information required during the software installation.
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Verifying the DI Installation

1. Start the SASIxp software by selecting: Start>Programs>NCS 
Applications>SASIxp. The SASIxp software opens and the Logon 
screen displays.

2. Enter SASI in both the User and Password fields, then click Login.

3. Double-click the SASI Modules icon. A SASI Modules window opens, 
providing access to SASI atom folders.

4. Double-click the System Setup folder. The System Setup window 
opens, providing access to the system setup atoms.

5. Double-click the SASI Modules Setup atom. An informational dialog 
window opens, displaying the following message:

The SASI Modules have changed and will be recreated
for all users.

6. Click OK.

7. When the system displays the SASI Modules Setup window, scroll 
through the list to verify District Apps appears. 

8. Click Save.

9. Click Close.

10. From the File pull-down menu, select Save Desktop.

11. From the File pull-down menu, select Quit.

12. Restart the SASIxp software by selecting: Start>Programs>NCS 
Applications>SASIxp.

Creating a Transfer Directory

Create a folder called Transfer in the SASIxp folder on your hard disk.

Note: SASIxp software displays the SASIxp workspace, with a 
SASI Modules icon in the upper-right hand portion of the 
workspace.

Note: If you cannot locate District Apps in the list, contact the 
SASIxp Support group for assistance. 

Note: The District Apps folder now displays in the SASI Modules 
window.
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Installing at a Client Workstation
Note: Before completing the following procedures, verify the network 
administrator created an “upper-level” applications installation directory 
on the district office file server. Also, verify the network administrator 
distributes this area information, or it is accessible to network users and 
granted “Full but Non-Administrative” access permission to this Shared 
Network Resource directory structure for all individuals who use the 
SASIxp software.

1. Using the user account provided by the Network Administrator log on 
to the network or server, depending on the type of authentication 
process in use.

2. Map the local drive letter to the Shared Network Resource where the 
SASIxp software is installed.

3. Have the SASIxp Software Distribution cover sheet available to 
provide information during the software installation.

4. Follow the steps in the loading instructions.

Task Server Workstation Installation
Use these procedures to install the software for the client dedicated 
workstation for the DI Task Server application. This topic also describes 
network access configuration for the client workstations.

The procedures in this topic describe a Windows NT client workstation 
interacting with a Window NT server. Your installation procedures may 
differ slightly depending on your actual networking environment.

Note: For consistency, map this drive to automatically re-connected 
at login. You can set SASIxp software to re-connect either through 
the use of a login script, or by the mechanism available to the client 
workstation operating system.

Note: Coordinate network server software installation location, network 
resources, and user access right privileges setup with the site network 
administrator before installing the software.
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Task Server Installation Considerations

! Enable the TCP/IP Network Protocol Stack on the Task Server 
workstation for SASIxp DI real-time operations to work.

! Use static TCP/IP addressing on SASIxp Task Server workstations.
! Assign each Task Server application a unique Poll ID number to 

control the Task Server application, which performs specific operations 
within the DI environment.

! Assign a Poll ID of 1 to the Task Server application that performs the 
Update District Student File process.

! The initial installation of the SASIxp Task Server application files occur 
with a SASIxp installation. You can then do installation and 
configuration of a SASIxp Task Server workstation with a “file-copy and 
edit” installation process.

! You must install and configure any networking protocols requiring 
basic networking interactivity of the networking operating system, 
using the LAN/WAN on all SASIxp Task Server workstations. This task 
provides access to all SASIxp database files.

! If not using TCP/IP for file and print services access to SASIxp file 
servers, the networking protocol must be a routable protocol if SASIxp 
DI Task Server Workstations are to operate in a WAN environment.

! The DI Task Server application is intended to run on a dedicated-
purpose workstation. The dedicated-purpose is defined as:

The Task Server workstation will be used for no other purpose than to 
run the SASIxp DI Task Server application.

! For Windows NT or Novell NetWare networks, Pearson School 
Systems recommends you run the Task Server application on a 
Windows NT Workstation platform running NT Version 4.0 with a 
minimum update of Service Pack 3.

! For an AppleShare network, run the Task Server application on at 
Macintosh-type platform running at least MacOS Version 7.5.

! Pearson School Systems recommends at least one Task Server 
workstation be allocated for every ten school sites for the DI 
implementation.

! Install the Task Server application to a folder on a local hard drive of 
the Task Server workstation.

! The Task Server software requires modification of the SASIxp.ini file 
before running the Task Server application.

! The District site installation of SASIxp software requires configuration 
before the Task Server application can run.
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! Make a separate network user account and password available for 
each Task Server Workstation in the network. If the network operating 
system in use requires a separate user account and password at each 
file server, each Task Server workstation must have a valid user 
account and password assigned at each school site SASIxp file server 
that the Task Server workstation will manage DI functions. A valid Task 
Server workstation user account and password must be also assigned 
at the district office SASIxp file server.

! The Task Server workstation user account must have at least read 
access privileges to the resource holding the school site SASIxp data 
files. 

! The Task Server workstation user account must have full access 
privileges to the resource holding the district site SASIxp software.

! To facilitate the installation and configuration process, Pearson School 
Systems recommends creating a permanent drive map to provide 
access to the SASIxp shared data files for each SASIxp school site file 
server that the Task Server workstation supports. In addition, create 
another permanent drive map to provide access to the SASIxp district 
office file server shared databases.

Task Server Configuration for Macintosh

Before installing Task Server on a Macintosh workstation, do the following:

! Set the ApplicationInHomePath entry to False in the SASIxp.ini file.
! Ensure that the Task Server folder on a Mac OS 9 computer contains 

Task Server, license.ini, sasixp.ini, and CSClassicLib files.
! Map the Task Server to the parent folder of the school server’s SASIxp 

folder. The name of the parent folder is not critical as it is not 
referenced in any of the .ini files. The school server and the Task 
Server must be on separate computers. The Task Server can access 
the school server only through a mapped or mounted drive.

! When you install Task Server for a Macintosh workstation, define an 
AppleTalk® zone before the Remote Site Data Path in the Campus 
Setup atom. If you do not define a zone you need to place an asterisk 
before the path. For example, 
*:192.168.100.100:sharepoint:SASIxp:Datafile:
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Installation Procedures

Before beginning this procedure, verify the Task Server workstation was 
logged on to the network/file server, and a permanent drive map to the 
district office network resource containing the SASIxp software and shared 
database files was created.

Also, Pearson School Systems recommends you complete the Task 
Server Configuration Worksheet to aid in the installation and configuration 
of each Task Server workstation. See the Task Server Workstation 
Configuration Worksheet on page 252.

Installing Task Server 

1. Find the Network Resource Share location of the SASIxp software.

2. On a local hard drive of the Task Server workstation, create a folder to 
hold the Task Server application files. Pearson School Systems 
recommends naming this folder TASKSVR.

3. Find the original installation location of the Task Server application files 
on the district office SASIxp file server, and select the Tasksrv.exe, 
TskAdm.exe, TskNTSrv.exe, SASIxp.ini, and RDBMS.ini configuration 
files.

4. Copy the files to the new TASKSVR folder on the Task Server 
workstation.

5. Create a Shortcut to the Task Server program.

Task Server SASIxp.ini Modifications

Using a text editor, open the SASIxp.ini configuration file for Task Server 
Workstation modifications.

Make these modification to the SASIxp.ini file:

1. Change the PrimaryServerAddress entry to reflect the TCP/IP address 
of the local Task Server workstation.

2. Change the PrimaryServerPort entry to reflect the port of the primary 
server task.

Note: Modify the SASIxp.ini file at each school, including the District 
school to verify the port number matches the port number of the Task 
Server at each of the schools.
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3. Change the ID entry to reflect the Poll ID assigned to this Task Server 
workstation.

4. If using Oracle or SQL server, change the LoginName entry to be the 
same as the ODBC User ID.

5. Set the ApplicationInHomePath entry to False.

6. Depending on the system type of the Task Server Workstation, modify 
either the HomePathMac or HomPathWindows entry to be the same 
location as the SASIxp software on the district office SASIxp file server.

Pearson School Systems recommends this path be a fully qualified drive 
specification. Do not use a network UNC resource.

Note: To enable the Task Server to start in Transfer mode, change the 
[Client/ServerConnection] inside the SASIxp.ini file to include the 
instruction, StartTransferOnStartup=True.
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SASIxp.ini File Example
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SASIxp.ini Command Definitions

Command Definition

MaxPacketSize Do not use. Do not change.

WaitTimeOldMessage Do not use. Do not change.

AutoMessageRetries Number of times to retry sending a message. 

WaitTimeResend Delay time, in seconds, between failures and 
next tries.

WaitTimeRejectMessage Number of seconds to wait without receiving 
data before aborting.

Note: The SASIxp software and Task Server use AutoMessageRetries, 
WaitTimeResend, and WaitTimeRejectMessage. Do not set these 
parameters too high, or you may wait a long time to find out if a Task 
Server is available. Also, do not set these parameters too low, or you 
may not give enough time for the process to complete. Pearson School 
Systems recommends a 1:3 ratio.

Command Definition

StartTransferOnStartup Change to True so the server will enter 
Transfer Mode immediately upon startup.

[TCP/IP] Communication parameters. Parameters 
default to 25 MaxThreads/ 50 
MaxConnections.
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MaxThreads Sets the number of simultaneous connection 
threads, including the routing and multiple 
receiving threads. There is an absolute 
minimum of 2 connection threads, 1 to route 
and 1 to receive. An efficient setting depends 
on how quickly the Task Server can process 
database access functions, such as 
MaxThreads and MaxConnections. If 
measuring the average time it takes for a 
single transaction to process without 
competition, divide that figure into the amount 
of time a client connection waits for a 
response.

MaxConnections The maximum number of simultaneous TCP/
IP connections allowed before new incoming 
connections are rejected. MaxConnections 
must be equal to or greater than 
MaxThreads, because this count includes all 
possible connections. When the number of 
simultaneous connections exceeds 
MaxThreads, but is still less than 
MaxConnections, the new connection is 
accepted and queued, but waits to be 
handled by one of the MaxThreads. An 
advantage to having MaxConnections 
greater than MaxThreads is that it puts a 
throttle on the number of threads competing 
for CPU time, and the queued connections 
consume less memory than an active thread. 

Note: To avoid client connections timing out, do not allow more 
connections than MaxConnections can process in the time allotted 
through WaitTimeRejectMessage.

Command Definition
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District Office Client Workstation Installation
Configure the District office SASIxp client workstation to permit access to 
the SASIxp software and shared database files located on the district 
office file server. 

Client Workstation Software Installation Considerations

! Before installing software on a client workstation, ensure that a drive 
map is available to provide access to the SASIxp software and the 
shared database files. Perform this task either through a network user 
account login script or by configuring the client workstation to 
automatically reconnect the network resource on startup of the client 
workstation operating system. For consistency and ease of support, 
Pearson School Systems recommends all client workstations use the 
same <drive letter> to <network resource> mapping references (for 
example, drive M: maps to network resource \\DistSvr\ncsapps). 

! Client workstation access to the SASIxp software and shared database 
files can be accomplished by either:
! Network server hosted application and data file access; or
! Local workstation hosted application and network server hosted 

data file access. Each method requires a different approach to 
software installation, application access, and data file access 
configuration.

! Network server hosted application and data file access is the preferred 
method of client workstation access to the SASIxp software. While this 
approach can consume more available network resources, it 
minimizes the amount of system administration required to maintain, 
support, and update the SASIxp LAN environment.

! Local workstation hosted application configuration should be 
implemented only in those environments where network traffic and 
bandwidth usage are extremely critical concerns. This method 
consumes network resources only for interacting with the centrally 
accessible data files. All application programs and support files are 
accessed directly from a hard disk located on the client workstation. In 
this implementation environment, you must individually maintain and 
administer each of the client workstations for functionality, software 
version compatibility, and custom configuration and operations. An 
example is user-defined queries.
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Installation Procedure

This procedure is for Server-hosted application, atoms, and data files.

Before beginning, verify the client workstation is logged on to the network/
file server and a permanent drive map to the network resource containing 
the SASIxp software and shared database files were created.

1. Locate the Network Resource Share location of the SASIxp software. 
Complete this by a, drive map, which references to the network 
installation of the SASIxp software.

2. Open the SASIxp installation folder and locate the SASIxp application 
executable.

3. Perform the operation for the client operating system in use to create a 
shortcut or alias to the server-hosted SASIxp program. 

4. Access to the SASIxp application by double-clicking the shortcut.

5. Repeat this procedure for every SASIxp client workstation at the 
District Site.

Modifications for DI Client Workstation 

Address the SASIxp.ini modifications on two levels: 

! The district office copy of the SASIxp application must have the 
SASIxp.ini modifications to support all SASIxp client workstations 
accessing the district office copy of the SASIxp shared database files. 

! Modify the SASIxp.ini file for every school site installation.

Modifying the SASIxp.ini File

1. Find the SASIxp.ini file in the SASIxp installation folder for the specific 
district or school site requiring modification.

2. Open SASIxp.ini file with a text editor.

3. In the [Client/ServerConnection] section of the file, modify the 
PrimaryServerAddress entry to reflect the TCP/IP address of the Task 
Server workstation assigned to support DI operations for this school 
site/district SASIxp implementation.

Note: Without the modifications, real-time transactions are not 
possible.
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Optimizing Query Searches

1. Locate the SASIxp.ini file the SASIxp installation folder for the specific 
district or school site requiring modification.

2. Open SASIxp.ini with a text editor.

3. Under the [Client/ServerConnection] section of the file, add 
QueryOptimization=True.
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Special Instructions for the District Integration 
Processes

This section lists the changes made to the upload and download 
processes of the District Apps module of the SASIxp software and 
describes the procedures you must run before you execute the district 
integration processes.

Instructions for Schools using Oracle or dBASE IV Databases with Oracle 
Database at the District Level

Installing Oracle Call Interface (OCI)

You must install the Oracle Call Interface (OCI) library on the computer 
where the Task Server application runs. Follow the procedure listed below 
to install the OCI library.

1. Insert the Oracle Client Installation CD into the CD-ROM drive of your 
computer. 

2. If the installation does not start automatically, double-click 
autorun.exe in the CD drive.

3. Click Install/Deinstall products. The Oracle Universal Installer: 
Welcome screen appears. 

4. Click Next. The Oracle Universal Installer: File Locations screen 
appears. 

5. Click Next. The Oracle Universal Installer: Available Products screen 
appears. 

6. Select the Oracle 9i Client 9.2.0.1.0 check box and click Next. The 
Oracle Universal Installer: Installation Types screen appears.

7. On the Installation Types screen, select the Custom check box and 
click Next. The Oracle Universal Installer: Available Products 
Components screen appears. 

8. Select the Oracle Call Interfaces 9.2.0.1.0 check box and click Next. 
The Oracle Universal Installer: Summary screen appears. 

Note: You do not need to run these procedures for schools using 
dBASE IV databases with dBASE IV at the district level.
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9. Click Install and follow the instructions on your screen. 

10. Click Next when the Oracle Net Configuration Assistant appears.

11. Select the Local Net Service Name configuration check box and 
click Next.

12. Select the Add check box and click Next.

13. Select the Oracle 9i or service check box and click Next.

14. Type a new service name and click Next.

15. In the protocol list, click TCP and click Next.

16. Type the host name, select the port number, and then click Next.

17. Select Yes to perform a test to verify that you can connect to the 
database using the information provided, then click Next.

18. Click Next when the message “Connecting... Test Successful” 
appears.

If no message about successful completion of the test appears, click 
Back and verify the configuration settings you specified.

19. Do not configure another service and click Finish. 

New Entries in the RDBMS.ini File of the Task Server Folder

Enabling Uploads

You must modify the district section of the RDBMS.ini file located in the 
Task Server folder if:

! An Oracle database exists at the district as well as the school site.
! An Oracle database exists at the district site while a dBASE IV 

database exists at the school site.

Update the information in the RDBMS.ini file for the parameters given in 
the following table:

Parameter Instructions

SQLUserId You must comment out this entry in the District section of 
the RDBMS.ini file.

SQLPassword You must comment out this entry in the District section of 
the RDBMS.ini file.
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Enabling Downloads

If you use Oracle as the database at both the district and the school sites, 
you must modify or update the district section of the RDBMS.ini file 
according to the following instructions.

OracleServiceName In the District section of the RDBMS.ini file, type the 
OracleServiceName you created for the Oracle database 
for the district. 

OracleServiceNameAlias In the District section of the RDBMS.ini file, type a new 
OracleServiceNameAlias entry. You can create the alias 
by truncating the OracleServiceName you created to 10 
or less characters.

Parameter Instructions

Note: From the SASIxp software, open the User atom to create a new 
user for the district site. You must set your UserId as 
OracleServiceNameAlias. You must have administrator access to the 
SASIxp application to perform this task. See the chapter “Using the 
User Atom” of the SASIxp Setup and Administration Training Guide for 
details on how to create a new user. 
In the SQL pane of the user atom, add the database User identification 
name and Password for this OracleServiceName.

Parameter Instructions

SQLUserId You must comment out this entry in the District section of 
the RDBMS.ini file.

SQLPassword You must comment out this entry in the District section of 
the RDBMS.ini file.

OracleServiceName In the School section of the RDBMS.ini file, type the 
OracleServicename you created for the Oracle database.

OracleServiceNameAlias In the School section of the RDBMS.ini file, type a new 
OracleServiceNameAlias entry for the school. You can 
create the alias by truncating the OracleServiceName 
you created to 10 or less characters.
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Note: From the SASIxp software, open the User atom to create a new 
user for the school site. You must set your UserId as 
OracleServiceNameAlias. You must have administrator access to the 
SASIxp application to perform this task. See the chapter Using the User 
Atom of the SASIxp Setup and Administration Training Guide for details 
on how to create a new user.
In the SQL pane of the user atom, add the database User identification 
name and Password for this OracleServiceName.
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RDBMS.ini File

The RDBMS program enables you to create, update, and administer a 
relational database. An RDBMS takes Structured Query Language (SQL) 
statements from a user or an application program, and creates, updates, 
or provides access to the database. 

Sample RDBMS.ini File for Oracle Database at District and School Level
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Instructions for Schools using Microsoft SQL Server Databases with a 
Microsoft SQL Server Database at the District Level

Enabling Uploads

If you use Microsoft SQL Server as the database at both the district and 
the school sites, you must modify or update the district section of the 
RDBMS.ini file according to the following instructions.

Enabling Downloads

You must modify the district section of the RDBMS.ini file according to the 
following instructions: 

Parameter Instructions

SQLUserId You must comment out this entry in the District section of 
the RDBMS.ini file.

SQLPassword You must comment out this entry in the District section of 
the RDBMS.ini file.

Parameter Instructions

SQLUserId You must comment out this entry in the District section of 
the RDBMS.ini file.

SQLPassword You must comment out this entry in the District section of 
the RDBMS.ini file.

SqlBulkLoadPath In the RDBMS.ini file at the district level, specify 
SqlBulkLoadPath in the School section. This path is at 
the school site and should be accessible to the school 
SQL Server database for Bulk Insert. (The Task Server 
creates intermediate text files at the district. To insert 
these file into a school SQL Server database, the files 
must be transferred to the school SQL Server from the 
district. The SqlBulkLoadPath specifies the folder to 
which the intermediate text files are copied at the school.)
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Sample RDBMS.ini File for Microsoft SQL Server Database at the School and 
District Sites
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Instructions for Schools using dBASE IV Databases with a Microsoft SQL 
Server Database at the District Level

Enabling Uploads

You must modify the district section of the RDBMS.ini file according to the 
following instructions:

Update the information in the Campus Setup atom for the parameters 
given in the following table:

Enabling Downloads

You must modify the district section of the RDBMS.ini file according to the 
following instructions:

Parameter Instructions

SQLUserId You must comment out this entry in the District section of 
the RDBMS.ini file.

SQLPassword You must comment out this entry in the District section of 
the RDBMS.ini file.

Parameter Instructions

District Transfer Path Specify the path for intermediate text files at district in 
Transfer Path in the Campus Setup atom. This path should 
be accessible to the school Microsoft SQL Server database 
for Bulk Insert.

Parameter Instructions

SQLUserId You must comment out this entry in the District section of 
the RDBMS.ini file.

SQLPassword You must comment out this entry in the District section of 
the RDBMS.ini file.
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Update the information in the Campus Setup atom for the parameters 
given in the following table:

Installing and Converting Data

Verify all school sites are set up and running before implementing District 
Integration.

Parameter Instructions

District Transfer Path Specify the path for intermediate text files at district in 
Transfer Path in the Campus Setup atom. 

Note: The Download process involves the export of text files extracted 
from the SQL database to the District Transfer Path. The extracted files 
are copied to the School Download folder.
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Use this chapter to set up and run the District Integration (DI) Automated 
Upgrade process using SASIxp™ atoms at the district office.

When running the automated upgrade process, the district Task Server 
establishes a communications link to the site Task Servers included in the 
process. The district Task Server copies files to the sites. The site Task 
Server runs the patch and does any local updating to the license.ini file 
and running of executables.

Verify these requirements before running the automated upgrade process:

! All SASIxp applications at the sites are closed and no processing is 
taking place. 

! All Task Servers associated with the automated upgrade process are 
running in Transfer mode.

! The upload should not start while the automated upgrade process is 
running.

! The associated site Task Servers are running at the sites.

The district Task Server and site Task Servers log all processing 
information in an automated upgrade log file. At the completion of the 
automated upgrade process, all AUGL log entries are consolidated into 
one log file at the district office.
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Setting Up Automated Upgrade
The installation of the Automated Upgrade atoms enables users to 
perform these functions at the District:

! Add or delete installation option set information, which defines an 
installation setup, including the type of installation, the sites for the 
installation, files included in the installation, source path, installation 
path, and other required installation processing parameters, atoms, 
and applications. The installation option set information is stored in file 
format, which enables you to query the contents of the file.

! Define sites to include in the installation processing.
! Define atoms and applications to include in the installation processing.
! Define information for installing template files.
! Modify installation option set information.
! Add or delete installation option set information.

These scenarios have been implemented and are currently supported for 
Automated Upgrade. It supports all cross-platform installations that with 
Windows and Macintosh workstations.

For information on hardware requirements, see the SASIxp 6.x Hardware 
Requirements Guide.

Active Auto Upgrade Folder

You must turn on the District Integration Automated Upgrade folder within 
the District Apps module. To activate the Auto Upgrade folder with its 
associated atoms, complete these steps.

1. Log into the SASIxp software as a security officer.

2. Open the System Setup module, SASIxp Modules atom.

3. In the list of modules, double-click District Apps. 

4. Scroll through the District Apps atom, and in the Public column beside 
Auto Upgrade select Yes.

5. Click Save.

6. Click Close.

7. Log out of the SASIxp software.

8. Log into the SASIxp software. The Auto Upgrade folder and atoms are 
in the District Apps module.
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Site Setup

Site setup consists of creating Site Task Servers at all school sites where 
you will use the Automated Upgrade process.

1. Create a folder called SiteTaskServer at the same level as the SASIxp 
folder.

2. Copy the SiteTaskServer.exe file and the SASIxp.ini file from the 
SASIxp folder, and paste the executable and the .ini file in the newly 
created SiteTaskServer folder. 

If the upgrade includes a revised version of the Site Task Server.EXE 
you must get the copy from an updated installation, typically this would 
be from an updated version installed at the district.

The Task Server folder on a Mac OS 9 computer must contain Task 
Server, license.ini, sasixp.ini, and CSClassicLib files. See Task Server 
Configuration for Macintosh on page 26.

Note: If the site School server is a Windows server the site Task Server 
should be installed locally on this server. If the School server is a Novell 
system, the Site Task Server must be installed on a Task Server 
supported Windows workstation. You must have the SASIxp software 
Version 5.5 or later. 
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3. Set up the site Task Server like a Task Server. For additional 
information on setting up a district Task Server, see these sections:

! Task Server Installation Considerations on page 18
! Task Server Workstation Installation on page 24
! Task Server Installation Considerations on page 25
! Task Server SASIxp.ini Modifications on page 27.

4. Open the SASIxp.ini file in the site Task Server folder.

5. Change the PrimaryServerAddress and PrimaryServerPort labels in 
the SASIxp.ini file to SiteServerAddress and SiteServerPort 
respectively. Change the IP address to the IP address of SiteTask 
Server. Change port number to the port number assigned to this 
SiteTask Server. Use a unique port number for each SiteTask Server. 
Note both the SiteTask Server IP address and port number, they will be 
required to setup the upgrade function at the district. 

If the SASIXP.ini file is using the Absolute Data Path Option the 
SIteTask ServerSASIXP.ini must be changed to no use the Absolute 
Data Path Option. SiteTask Server does not support this option.
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6. In the section [AutoUpgrade],

(i) InstallationTime - Max Time for the installer to finish in Seconds.

Enter Installation Time in the following format:

"Installation Time = 4000"

4000 in the above example equals time in seconds and can be 
adjusted by the user according to the following values;

!Maximum time - 10000 seconds
!Minimum time - 1800 seconds
!Default value - 5000 seconds

(ii) WaitBetweenCommand - Time in seconds the Task Server should 
wait before sending next command to Site Task Server.

Enter WaitBetweenCommand in the following format;

"WaitBetweenCommand = 3"

3 in the above example equals time in seconds and can be adjusted 
by the user according to the following values;

!Maximum time - 15 seconds
!Minimum time - 1 seconds
!Default value - 3 seconds



50  Setting Up Automated Upgrade Copyright © 2005 Pearson School Systems

Automated Upgrade

Sample SASIxp.ini file

7. Save the changes to the SASIxp.ini file.

8. Close the SASIxp.ini file. 

9. Repeat Steps 1–7 for each school site where the Automated Upgrade 
process takes place. 

Note: You must map the Task Server to the parent folder of the school 
server’s SASIxp folder. The school server and the Task Server must be 
on separate computers. The Task Server can access the school server 
only through a mapped or mounted drive. See Task Server 
Configuration for Macintosh on page 26.
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District Setup

Automated Upgrade district setup consists of setting up campus files, Task 
Server records, Auto Upgrade Servers, and Auto Upgrade Options Sets.

Campus Setup

1. From the District Apps module, District Setup folder, open the Campus 
Setup atom.

2. Verify all schools the Automated Upgrade process will update have 
campus file records.

3. If all campus records have been created, continue with the next step. If 
the campus records have not been created, see Campus Setup 
Screen on page 73 to set up campus records.

Note: The District Upload Path field has been renamed to District 
Transfer Path. Use this field to specify the path of the upload or 
download folder to store the Transfer files. You must have the SASIxp 
software Version 5.5 or later.
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4. After all campus records are correct, close the Campus Setup atom.

The table below lists the path details you must specify according to the site 
and the database type.

Example of Local and Universal Naming Convention (UNC) 
Path

Local — D:\SASIxp_District\SASIxp\Transfer

UNC — \\192.168.0.175\SASIxp_District\SASIxp\Transfer

Task Server Setup

1. From the District Apps module, Auto Upgrade folder, open the Task 
Server Setup atom.

2. From the Data pull-down menu, select Add Task Server Setup.

3. Complete these fields:

! Task Server Name
! Task Server ID
! Task Server Port
! IP Address

Note: You must use an opening parenthesis and a closing parenthesis 
along with the entry in the Data Source field of the Campus Setup atom.
The entries in the District Transfer Path - (UNC format) and District 
Transfer Path - (Local format) fields must point to the same path.

District Site Database School Site Database Path Type

Oracle dBASE Local path or Universal 
Naming Convention (UNC)

Oracle Oracle Local path or UNC

Microsoft SQL Server dBASE UNC path

Microsoft SQL Server Microsoft SQL Server UNC path
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4. Click Save.

5. Repeat Steps 1–4 for each School SIteTask Server in the district taking 
part in the upgrade process.

6. Close the Auto Upgrade Server atom.

Task Server Setup Fields

Field Description

Task Server Name Name of the Task Server.

Task Server ID Identification number of the Task Server.

Task Server Port Setting the district uses to connect to the 
Task Server.

PollPC section Task Server SASIXP.ini

IP Address IP address of Task Server.
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Auto Upgrade Server Setup

For each Campus file set up to run the Automated Upgrade process, set 
up an Auto Upgrade Server by completing these steps.

1. From the District Apps module, Auto Upgrade folder, open the Auto 
Upgrade Server atom.

2. From the Data pull-down menu, select Add Site Server.

3. Complete these fields:

! Name
! IP Address
! Port Number
! Site Home Path
! Site Task Server Application Path
! Server Type

4. Click Save.

5. Repeat Steps 1–4 for all campuses you are going to use in the 
Automated Upgrade process.

6. Close the Auto Upgrade Server atom.
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Auto Upgrade Server Fields

Field Description

Campus Name Name assigned to each school site.

Campus Number Number assigned to each school site.

Launch Campus Atom Fast Access arrow to open the Campus atom 
in the SASIxp software.

Name Name of the SiteTask Server.

IP Address IP address of SiteTask Server.

Port Number Setting the district uses to connect to the 
SiteTask Server.

License Name Name of the license key your school uses.

License Password Password your school uses to access the 
license key.

Site Home Path Menu path to the location of the School 
SASIxp software.

Site Task Server 
Application Path

Menu path to the location of the School 
SiteTask Server.

Server Type School Server OS.
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Auto Upgrade Option Set Setup

1. From the District Apps module, Auto Upgrade folder, open the Auto 
Upgrade Option Set atom.

2. From the Data pull-down menu, select Add Option Set.

3. In the Upgrade Type field, select the type of upgrade to process.

Different upgrade options activate different field options. For more 
information on the upgrade options and corresponding fields, see 
Upgrade Types on page 57.

4. Click Save.

5. Repeat Steps 1–4 for each option set you need.

6. Close the Auto Upgrade Option Set atom.

Auto Upgrade Options Fields

Field Description

Option Set Name Name of the upgrade to run.

Upgrade Type Type of upgrade to run. 

Patch / Installation File 
Name

Location of the patch or installation file to use 
during the automated upgrade process.
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Upgrade Types

Update License.ini File Optional checkbox to update the license key 
during the upgrade process.

Run SASI Modules, 
Merge Tables & Merge 
SCF ?

Optional checkbox to update the SASI 
Modules, Merge Tables, and Merge SCF 
atoms during the upgrade process.

Select Sites Identify the sites to include in the upgrade 
process.

Select Files identify the files to include in the upgrade 
process.

Upgrade Type Available Fields for this Upgrade Type

IN - SASIxp 
Installation

! Option Set Name
! Upgrade Type
! Patch/Installation File Name
! Update License.ini File ?
! Run SASI Modules, Merge Tables & Merge 

SCF ?
! Select Sites

TT - Template to 
Template

! Option Set Name
! Upgrade Type
! Run SASI Modules, Merge Tables & Merge 

SCF ?
! Select Files

TD - Template to 
Datafile

! Option Set Name
! Upgrade Type
! Run SASI Modules, Merge Tables & Merge 

SCF ?
! Select Files

Field Description



58  Automated Upgrade Copyright © 2005 Pearson School Systems

Automated Upgrade

Automated Upgrade
Option 1 – SASIxp Installation

It is necessary to use the SASIxp Installation upgrade option type when a 
SASIxp software patch is released, and you want to install it from the 
district to the school sites.

Running a SASIxp Installation Auto Upgrade

Before running the SASIxp Installation Automated Upgrade, verify the 
patch was installed correctly at the district. Then save the patch in this 
location: <SASIxp HomePath>\Macro\Upgrade. Finally, verify the site Task 
Servers associated with this upgrade are running in Transfer Student 
mode. 

If this upgrade includes an upgrade to the SiteTask Server.exe at all school 
included in the upgrade process need to be updated prior to executing the 
upgrade process. The same rules apply to the district Task Server. if a new 
Task Server.exe is included in the upgrade then the district Task Servers 
need to be upgraded prior to executing the auto upgrade process.

1. Open the Auto Upgrade Options atom.

2. Find the option set to run.

3. Identify the patch location by selecting the Patch Fast Access arrow.

4. Identify the SiteTask Servers to upgrade by selecting the Select Sites 
Fast Access arrow.

5. Click Save to save the records in the database.

6. On the Auto Upgrade menu, click Start Auto Upgrade.
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7. In the message box that appears, click Start to begin the process or 
Cancel to abort it.
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8. When the Auto Upgrade process starts, the SiteTaskServer displays 
the "CS-CONTROL-GET-SERVER - Replied" message.

When the Auto Upgrade process has been completed, a window called 
Status in the Task Server indicates that the Auto Upgrade process has 
been completed.

9. Click Close when the Auto Upgrade process is complete.

10. Validate the upgrade completed correctly by reviewing the district 
Automated Upgrade Log (AUGL) file.

Option 2 – Template to Template

Using this process, you can copy the template file from the datafile or 
template foler (C:\SASIxp\macro\template or C:\SASIxp\macro\datafile) of 
the district site to the corresponding datafile or template folder of the 
selected sites.

Running a Template to Template Auto Upgrade

Verify the site Task Servers associated with this upgrade are running in 
transfer mode.

1. Open the Auto Upgrade Options atom.

2. Find the option set to run.

3. Identify the site Task Servers to upgrade by selecting the Select Sites 
Fast Access arrow.

4. Identify the files to upgrade by selecting the Select Files Fast Access 
arrow.

5. Repeat steps 5 - 8 as decribed in Running a SASIxp Installation Auto 
Upgrade on page 58.

6. Validate the upgrade completed correctly by reviewing the district 
Automated Upgrade Log (AUGL) file.

Note: On Macintosh workstations, the Auto Upgrade process may 
generate the AUGL file even before it actually finishes the installation or 
when it still requires user interaction to complete the installation. This is 
a known issue. You may monitor the installation at school sites regularly 
and intervene at the appropriate time to resolve this issue.



Copyright © 2005 Pearson School Systems Automated Upgrade  61

Automated Upgrade

Option 3 – Template to Datafile

Using this process, you can copy the template file from the datafile or 
template folder of the district site to the datafile folder of the selected site.

Running a Template to Datafile Auto Upgrade

Verify the site Task Servers associated with this upgrade are running in 
transfer mode.

1. Open the Auto Upgrade Options atom.

2. Find the option set to run.

3. Identify the site Task Servers to upgrade by selecting the Select Sites 
Fast Access arrow.

4. Identify the files to upgrade by selecting the Select Files Fast Access 
arrow.

5. Repeat steps 5 - 8 as decribed in Running a SASIxp Installation Auto 
Upgrade on page 58.

6. Validate the upgrade completed correctly by reviewing the district 
Automated Upgrade Log (AUGL) file.

Note: On Macintosh workstations, the Auto Upgrade process may 
generate the AUGL file even before it actually finishes the installation or 
when it still requires user interaction to complete the installation. This is 
a known issue. You may monitor the installation at school sites regularly 
and intervene at the appropriate time to resolve this issue.

Note: On Macintosh workstations, the Auto Upgrade process may 
generate the AUGL file even before it actually finishes the installation or 
when it still requires user interaction to complete the installation. This is 
a known issue. You may monitor the installation at school sites regularly 
and intervene at the appropriate time to resolve this issue.
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Possible Error Messages

Site Error Window Errors

Site Automated Upgrade Log Messages

Error Description

Unable to open the AUGP
File

AUGP file will not open.

Unable to open the AUGL
File

AUGL file will not open.

Message Description

Could not locate the
AutoUpg.ini file.

AutoUpg.ini file not accessed during the upgrade. The 
AutoUpg.ini file written to the root of the School SASIXP 
and SiteTask Server folder at the start of the Auto 
Upgrade Process. Note: If the Auto Upgrade Process 
fails, it is possible that SASIXP cannot be launched at the 
school. To launch SASIXP delete AutoUpg.ini file in the 
school SASIXP folder.

Upgrade not selected. Upgrade type was not defined.

Error running the patch. Upgrade stops because of a problem with the patch.

Error running SASIxp in
silent mode.

Upgrade stops because of a SASIxp error.

Upgrade completed
successfully.

Upgrade runs without error.

District Abort on upgrade
process.

District stops the upgrade process.

Unknown error running the
upgrade.

Upgrade stops with an unexpected error.

Note: Not likely, but still a possible error
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Automated Upgrade Log Messages

Message Description

UPG_BEGIN_UPGRADE_MSG Beginning Auto Upgrade Process.

UPG_CREATE_INI_MSG Error creating AutoUpg.ini file.

UPG_ABORT_MSG User Abort from the Task Server menu.

UPG_NO_MEMORY_MSG Out of memory.

UPG_NO_CONNECTION_MSG Cannot connect to the site Task Server.

UPG_AUGO_FILE_OPEN_MSG Cannot open AUGO file for processing.

UPG_AUGS_FILE_OPEN_MSG Cannot open AUGS file for processing.

UPG_AUGT_FILE_OPEN_MSG Cannot open AUGT file for processing.

UPG_ACAM_FILE_OPEN_MSG Cannot open ACAM file for processing.

UPG_LOAD_UPG_INFO_MSG Cannot load upgrade option set information. 

UPG_SITE_KEY_ERR_MSG Cannot build the key for the ACAM file. 

UPG_SITE_GET_ERR_MSG Cannot retrieve records from the ACAM file for 
processing. 

UPG_SITE_LIST_MSG Cannot build the list of sites for processing. 

UPG_LOG_CLEAR_MSG Cannot clear old log records. 

UPG_AUGO_RECORD_MSG Cannot retrieve AUGO record for option set %s. 

UPG_AUGS_RECORD_MSG Cannot retrieve AUGS record. 

UPG_AUGT_RECORD_MSG Cannot retrieve AUGT record. 

UPG_ADCL_OPEN_MSG Cannot open ADCL file. 

UPG_ADCL_RECORD_MSG Cannot retrieve ADCL record. 

UPG_UPGRADE_INI_MSG Cannot write to AutoUpg.ini file. 

UPG_DATA_CONNECT_MSG Cannot connect to site data path.

UPG_APP_CONNECT_MSG Cannot connect to site application path. 
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UPG_HOME_CONNECT_MSG Cannot connect to site home path. 

UPG_SEND_COMMAND_MSG Unable to send command to the site Task Server. 

UPG_PATCH_CPY_MSG Error copying patch file to the site.

UPG_TEMPLATE_CPY_MSG Error copying template files to the site.

UPG_INI_CPY_MSG Error copying AutoUpg.ini file to the site.

UPG_SITE_FAILED_MSG Site failed to upgrade successfully.

UPG_SITE_AUGP_OPEN_MSG Cannot open site AUGP file for monitoring.

UPG_SITE_AUGP_READ_MSG Cannot read site AUGP file for monitoring.

UPG_DISCONNECT_MSG Unable to disconnect from the site Task Server. 

UPG_COMMAND_ERR_MSG Site Task Server unable to process command. 

UPG_CREATE_DIR_MSG Cannot create temporary directory at the site. 

UPG_NO_SITE_LOG_MSG Site AUGL upgrade log does not exist. 

UPG_CANNOT_COPY_FILE_MSG Cannot copy site AUGL upgrade log file to district. 

UPG_CANNOT_COPY_LOG_MSG Cannot copy site AUGL upgrade log records into district 
file. 

UPG_TSK_GET_TS_INFO Error at site getting site Task Server info. 

UPG_TSK_CREATE_FILES Error at site creating upgrade log files. 

UPG_TSK_GET_EXCL_CTRL Error at site getting exclusive control of the site database. 

UPG_TSK_UPD_LICENSE Error at site updating the License.ini file. 

UPG_TSK_RUN_UPGRADE Error at site running the upgrade process. 

UPG_TSK_RELEASE_EXCL_CTRL Error at site releasing control of the site database. 

UPG_TSK_UPG_COMPLETE Error at site releasing resources from the upgrade. 

UPG_SITE_ERR_MSG Site Upgrade error at the site.

UPG_SITE_WARNING_MSG Site Upgrade completed with a warning.

UPG_SITE_INVALID_MSG Site Upgrade failed validation processing.

Message Description
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UPG_END_UPGRADE_MSG Ending Auto Upgrade Process.

Message Description
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Configuring District Integration

This topic describes the SASIxp™ software configuration procedures 
necessary to enable the DI operation. These procedures include 
configuration changes for school and district SASIxp installations. 
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Overview
To implement District Integration, modify the configurations for each school 
site installation, the Task Server workstations, and the district site SASIxp 
installation.

Before You Begin
Complete the following before configuring District Integration:

! Verify all users log off the SASIxp software and their respective SASIxp 
installations. Pearson School Systems recommends no one logging 
into the SASIxp software until the configuration process is complete, 
and you confirm it is correct.

! Complete all configuration worksheet information available to the 
person performing the DI implementation.

! Perform all school site data modifications before proceeding with the 
DI configuration.
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District Site SASIxp Configuration
This topic describes the configuration procedures for the district SASIxp 
site.

District School Atom Concepts

Use this worksheet to facilitate DI operations and locate individual school 
site data. Use the School atom at the district site to create school records 
for each school site. 

Note: Pearson School Systems recommends you run these 
configuration procedures on the Task Server workstations to facilitate 
the overall configuration process. Pearson School Systems also 
recommends creating permanent drive maps for each SASIxp school 
site server and district site server to the Task Server workstations 
server. 

Note: Pearson School Systems recommends after determining the 
content of the information, notifying the school representatives.
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District School Atom Configuration

1. Open the School atom.

2. Add a school using the information from in the School Record 
Configuration Worksheet.

3. Select the Basic tab and set the District field to Local Processing for 
all schools. 

4. Select the General tab and set the Confirm Add, Change, and Delete 
fields to the User Pref. option.

5. Select the Schedule tab and assign a length to the Section ID Length 
field.

6. Select the Enrollment tab and set the Leave Date field to the Leave 
date is the last day of enrollment option.

7. Complete the creation of the School record and modify the Sch# field, 
if necessary.

8. Repeat these steps for each school in the district, including the district 
office.

Last Day of 
Enrollment

Last Day of 
Enrollment

Last Day of 
Enrollment

Last Day of 
Enrollment

School 
Number

School 
Name

School 
Abbr.

Grades 
Taught

Promote 
To

Beg. 
Period

End 
Period

Section 
ID 

Length
Leave 
Date
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District Files Concepts

Create a number of DI-specific files before using District Integration. 
These files reside only at the district site. The following is a list of the file 
name codes, a brief description of each file, and any file dependency 
relationships.

Primary File Dependent File Code Description

District File ADST Contains demographic information for 
each student at each school in the 
district. Provides up to 10 years of 
school attended history.

District Control File ADCL Sets up district information necessary 
for DI processing. Information in this 
file determines what occurs during the 
nightly process, the district year, and 
the Next ID for new students.

District School Info 
File

ADSI Identifies the operational type, and if 
the school is the central enrollment 
schools in the DI enrollment process.

District
Sub-File

ASUB Transmits student-dependent files 
during the add, drop, and transfer 
process. The district sub-file 
determines what additional student 
information transfers with a student as 
they move from school to school within 
the district.

District Transaction 
File

ATRN Keeps track of concurrent enrollments. 
This file must exist, even if not using 
concurrent enrollment.

Campus File ACAM Identifies the schools a Task Server 
workstation accesses during the 
nightly process.

New Year Rollover 
File

ANYR Contains information necessary to 
establish movement of the current 
school year information to the next 
year.
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Populating District Files

Population of the District files is the process where the files associated 
with District Integration are either configured and populated with 
configuration data to enable District Integration operation.

Campus File/Campus Detail File Configuration

Before you configure the campus file, use some form of Campus Setup 
Atom Configuration worksheet to assist in the configuration process. See 
an example of a Campus Setup Atom Configuration Worksheet on page 
253.

New Year Rollover 
Options File

ANYC

Primary File Dependent File Code Description

Note: In a multiple Task Server environment, perform the configuration 
procedures applicable to a particular Task Server from the Task Server 
that is using the configuration.
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Campus Setup Screen

Campus Setup Fields

Field Description

Campus Name Name of the active campus record. This 
name is the same as the name of the school 
you are creating for the campus.

School School number to attach to the current 
campus record. 

Task Serv # Poll ID number of the Task Server 
workstation that performs the upload 
operations for the school attached to this 
campus.
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Upload Time Time at which the Task Server workstation 
starts the upload process on the campus. 
Express the time in Standard time. Include an 
a or p to indicate a.m. or p.m.

Note: When this field is blank the SASIxp 
software interprets it as zero, and zero 
equals midnight.

Server Type Server type of the SASIxp school site server 
for this campus record.

Remote Site Data Path Path to the SASIxp Datafile directory on the 
SASIxp school site server for this campus 
record. Use the Fast Access atom above this 
field to locate the directory on the remote 
school site server. Enter a UNC network path 
to the remote server and logon information. 
When you install Task Server for a Macintosh 
workstation, you must define an AppleTalk 
zone before the Remote Site Data Path in the 
Campus Setup atom. If you do not define a 
zone you need to place an asterisk before the 
path. For example, 
*:192.168.100.100:sharepoint:SASIxp:Datafil
e:

See Task Server Configuration for Macintosh 
on page 26.

Note: This path provides the SASIxp 
software with the ability to log on to the 
school site server even when the 
permanent drive map is unavailable.

UAM User Authentication Method for attaching to 
an AppleShare Server.

Note: This field is for Macintosh servers. If 
using Windows NT and Novell server 
types, leave this field blank, because 
the SASIxp software automatically fills 
in the field.

Field Description
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Network User Name Network logon account for the school site 
server for this campus record. Pearson 
School Systems recommends creating the 
same account for the Task Server 
workstations, for each school site, and the 
district site if applicable to a particular Task 
Server workstation. For this Task Server 
account use the same network User ID and 
password for all severs.

Network Password Password for the Task Server workstation 
Network User Name account. Use this 
password to gain access to a school site 
SASIxp server. To minimize ongoing 
reconfiguration, Pearson School Systems 
recommends a network user account have the 
password expiration set to Never Expires. 

Note: Pearson School Systems strongly 
recommends you implement some 
form of physical security mechanism 
on the Task Server workstations to 
prevent unauthorized access to 
SASIxp data.

Upload Year School year for which nightly upload and 
overnight update operations perform at the 
school site for this campus record.

Upload File Options Two upload file options: upload all files or 
upload all files that have changed.

Field Description
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District Transfer Path The District Transfer Path links to the SASIxp 
upload and download folders to store 
intermediate files on the district site SASIxp 
server. This path can be represented by a 
Universal Naming Convention (UNC) name 
format. For example, 
\\192.168.8.10\SASIxpshared\Datafile_Berlin

For the upload process, if your district 
database is SQL or Oracle, type the UNC 
path of the Transfer folder where the 
database is present. If your district database 
is dBASE IV, type the path of the Transfer 
folder on the server where Task Server is 
installed. 

For the download process, type the UNC 
path of the Transfer folder where Task Server 
is installed. For bulk load operations, the 
Transfer path must be accessible to the SQL 
Server at the district and school sites. This 
path requires a permanent drive map to the 
SASIxp district site server. To ensure 
optimum operation of the overnight process 
in a Windows environment, the UNC is the 
same UNC you use to create the drive map 
for the HomePathWindows entry of the Task 
Server workstation’s SASIxp.ini file.

Structured Query 
Language Info

If the school site uses a database other than 
dBASE IV, enter the data source from the 
RDBMS.ini file for this school, including the 
square brackets. The Task Server uses this 
definition when connecting to the campus 
database. If entering a data source without 
the square brackets found in the RDBMS.ini 
file, the Task Server uses the [DefaultDS] 
section in the RDBMS.ini file. 

Field Description
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Adding Campus Records

1. Open the Campus Setup atom.

2. From the Data pull-down menu, select Add Campus to add a campus 
record to the Campus file (ACAM).

3. Enter the name in the Campus Name field. 

4. Enter the school number for the campus in the School field.

5. Enter site specific information for the campus.

6. Click Save.

7. Repeat these steps to add all campus records.

8. Click Close.

District Control File Configuration
Use the District Control atom to configure the district control file and 
dependent files. The district control file configures the level of functionality 
of the Task Server workstations operations. 

SASIxp Database Files

District Control file creation and configuration affects the following SASIxp 
database files:

Note: Create a campus for each school for the DI implementation. 
Also, only attach one school to any one campus.

Note: When the record has been added, the screen displays saved 
information.

File (Code) Description

District Control File 
(ADCL)

Primary configuration file for defining District 
Control options. Populate this file through the 
District Control atom.



78  District Control File Configuration Copyright © 2005 Pearson School Systems

Configuring District Integration

The information configured in the District Control atom identifies:

! Schools in the district allowing concurrent enrollment.
! The central enrollment school.
! The data to transfer with students as they move between schools in 

the district.
! The Student ID to assign to the next new student in the district.
! Overrides to the information for the Campus (ACAM) file.
! Which files to include or exclude from an upload.
! Which files to include in a download.

District School Info File 
(ADSI)

Configuration file for configuring District 
Integration to recognize schools as 
concurrent enrollment or summer schools. 
Populated through the School Info screen of 
the District Control atom.

District Transaction File 
(ATRN)

Use the Task Server to make entries in the 
District Concurrent Transaction (ATRN) file 
for each concurrent enrollment during 
transfer operations. 

District Sub File (ASUB) File to control the type of information to follow 
a student as the student moves within the 
school district. Populate this file through the 
Sub-Files screen of the District Control atom. 
Entries define what student sub-file 
information transmits during the transfer 
process.

Upload File (AFLU) List of files to include or exclude from the 
upload.

File Data/Time Stamps 
(AFST)

Date and time stamps for the upload and 
download processes.

District Process Status 
(ADPS)

Use this file to synchronize upload, moves, 
ADST updates, and download processes. 

District Owned Files 
(AFLD)

Lists files the District maintains, and the files 
to download nightly.

Note: Do not upload district files.

File (Code) Description
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Creating a Archive/Inactive School

The Archive/Inactive School contains information for students who were 
previously enrolled in the District in prior years and are no longer active. 
Create this school using the School atom at the district site. The Archive/
Inactive School exists only in the District SASIxp installation. This Archive/
Inactive school is School and Year qualified. 

Set up the Archive/Inactive School with all of grade levels within the 
district. Set the Promote To Levels if the district is reflecting future grade 
level of a student at the end of each year.

Populate the Archive/Inactive School through the New Year Rollover 
process. The only exception is if the district, during the implementation, 
has conversion data, and an inactive school was created and populated by 
the Pearson School Systems conversion team. The Archive/Inactive 
school can grow large in size if the school district decides to rollover the 
inactive school each year.

Note: Do not create data files for the Archive/Inactive school at this 
time. Create these data files after you verify the data file structures 
(FILES.DBF/FILES.MDX/FILES.DBT) are identical at all school sites, 
including the district site. Failure in verifying the file structures can 
result in unpredictable SASIxp operation.
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Creating an Archive/Inactive School

1. At the district SASIxp installation, open the School atom.

2. From the School pull-down menu, select Add School.

3. Complete these fields.

Field Data

School Name District Archive School

Sch Abbrv DAS

Sch# 800

Note: Pearson School Systems recommends 
using a school number of 800 for 
SASIxp support consistency. When 
using an alternate number, notify the 
SASIxp DI Support team.
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Setting Up the District Control File
Configure the district control file and dependent files using the District 
Control atom.

The District Control screen contains the following tabs:

! General 
! Sub Files 
! School Info 
! Enrollment 
! Upload/Download 

General Tab

General Fields

Field Description

District Inactive 
School

Name and number of the Archive/Inactive 
school. Only use this field for the New Year 
Rollover process.
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Students in List Number of student records to send to the 
Task Server when performing a Find in the 
District screen of the Enrollment atom. The 
system default is 35. The value in this field 
must be between 20 and 35. 

Note: A maximum of 35 students display. If 
the Find returns more than 35 
matches, you display additional sets of 
35 by using the scroll arrow.

Next Student ID Student ID to assign to the next new student 
in the district. The next student ID must be 
greater than the highest number already in 
the district file. 

Note: If manually assigning Student IDs, 
leave this field blank.

Allow Characters in ID Whether to allow alpha characters as part of 
the Student ID numbers.

Next Alternate ID This is a Texas specific field.

Contains the Alternate ID to assign to the 
next new student in the district. The next 
student ID must be greater than the highest 
alternate number already in the district file. 

Note: If manually assigning Student IDs, 
leave this field blank.

Allow Characters in ID Whether to allow alpha characters as part of 
the Next Alternate ID numbers.

Maximum Alternate ID This is a Texas specific field.

Maximum assignable number for a student 
ID. All student IDs must be less than this 
number. 

Note: If manually assigning Student IDs, 
leave this field blank. 

Field Description
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Sub Files Tab

Next Temporary ID This is a Texas specific field.

Student ID number to use if the SASIxp 
software reaches the Maximum Alternate ID 
number. 

Note: If manually assigning Student IDs, 
leave this field blank.

Allow Characters in ID Whether to allow alpha characters as part of 
the Student ID numbers.

Maximum Temporary 
ID

This is a Texas specific field.

Maximum assignable number as a 
Temporary Student ID. The Student IDs must 
be less than this number. 

Note: If manually assigning Student IDs, 
leave this field blank.

Field Description
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Sub Files Fields

Each line of the table contains information DI uses to define additional 
information, which follows students as they transfer from school to school 
or when completing a cross year enrollment for a student. These settings 
affect Task Server operation of all campuses within the DI implementation.

Field Description

Ln Sub-file entry of additional student 
demographic information to include as part of 
the DI operational process. 

School Type Type of schools to add demographic 
information for in the DI enrollment process. 
Options include:

! Secondary
! Elementary, No schedules
! Elementary, With schedules
! All schools

File Information to include in the DI enrollment 
process. The following are examples of some 
of the student dependent files you can 
transfer:

! Parent Guardian (APRN)
! Emergency (AEMG)
! Course History (ACHS)

The following are examples of files you 
cannot transfer with a student:

! (ACLS)
! (AGRD)
! (AGRL)

Conc Enr Indicated this sub-file transfers to the 
concurrent school.

Sum Schl Indicates the sub-file transmits if a student 
enrolls in a Summer school.

Select Files Fast Access atom, which enables you to 
select specific files. 
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School Info Tab

The School Info tab displays information set up in the District School Info 
file (ADSI). If a school is not on this list, you need to add a new school in 
the School atom.

School Info Fields

Field Description

School List of schools in the SASIxp district site 
installation.

Concur Enrollment Identifies if the school permits concurrent 
enrollment operations. Only the school the 
student is being concurrently enrolled in 
should be checked.

For example, School A allows concurrent 
enrollment. School B transfers a student to 
school A, but only school A would check 
concurrent enrollment.
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Enrollment Tab

The Enrollment tab enables you to select whether using centralized 
enrollment, or your district will enroll students with restrictions.

Enrollment Fields

School Type Pop-up list to select whether the school is a 
normal school, summer school, or central 
enrollment school.

Note: If selecting normal school this field will 
be blank.

Field Description

Field Description

Using Central 
Enrollment

Checkbox to enable Central Enrollment 
operations.

Using Enrollment 
Restriction

Check box to enable enrollment restrictions.
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Site Options Section: 

Use these fields to set the rules for the Enrollment atom when school 
staff perform enrollment transactions.

Enrollment Add 
Options

The Allow Site Add/Transfer option enables 
School staff to add or transfer students using 
the Enrollment atom.

The Allow Site Transfer option enables 
School staff to transfer students to a school 
site using the Enrollment atom.

The Forbid Site Add/Transfer option denies 
School site staff members from performing 
additions or transfers to the school site and 
district databases using the Enrollment atom.

Student ID Options The Manual Assignment of Student IDs 
option enables the person performing the 
addition of the new student to assign the 
Student ID.

The Automatic Assignment of Student IDs 
option enables the SASIxp software to use 
the District Control file information and 
automatically generate Student IDs.

Note: If selecting the Using Central 
Enrollment checkbox, verify this 
setting is the same as in the Student ID 
Options selection of the CES Options 
fields.

Field Description
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Transfer Options Note: This option is available only when 
selecting Central Enrollment.

The Can Transfer Any Student option 
enables School staff members to transfer to 
their site any student in the District window of 
the Enrollment atom.

The Can Transfer Assigned Students Only 
option enables School staff members to 
transfer only those students who are 
assigned to a school site. Identify the 
students assignment in the District window of 
the Enrollment atom under the School 
Assigned field.

CES (Central Enrollment School) Options Section:

Use these fields to set rules for District staff members to perform 
enrollment transactions.

Assignment Options The Assigned School Is Optional option 
precludes District staff members from 
entering a school assigned to number in the 
school assigned field in the Enrollment atom 
when performing an add to the Central 
Enrollment School.

The Assigned School Is Mandatory option 
enables District staff members to enter a 
school assigned to number in the School 
Assigned field in the Enrollment atom when 
performing an add to the Central Enrollment 
School.

Student ID Options The Manual Assignment of Student IDs 
option enables the assignment of Student ID 
by the person responsible for performing the 
addition to the database. The system does 
not automatically assign a Student ID number 
to a student.

The Automatic Assignment of Student IDs 
option enables the SASIxp software to use 
the District Control file information to 
automatically generate Student ID numbers.

Field Description
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Using Central Enrollment

Defining a central enrollment school at the District provides a way for the 
District staff to control student enrollment to the District. In this process, 
members of the District staff enroll students. School staff members then 
transfer the students to their site. 

If assigning students to your school click, Find Assigned to list all 
students who are assigned to the school. When no students are assigned, 
the SASIxp software displays the following message:

No matching assigned students found.

It is up to the District staff members to assign student to the different 
schools in the District. School staff members can only move those student 
assigned to schools they have access to.

For Central Enrollment operation, complete the following setup at the 
district office only:

1. Create a Central Enrollment school in the School atom. 

2. Add grade levels for all grade levels in the District. 

3. Set the school record to Centralized Processing. 

4. District staff members perform all initial enrollment transactions.

5. If the Pearson School Systems conversion team is providing Central 
Enrollment School data, skip step 6.

6. Create these files and any files you fill in centrally with the Create New 
Files atom for the Central Enrollment School for the current school 
year: 

! Student (ASTU)
! Teacher (ATCH)
! Sequence Control (ASCF)
! Table (ATBL)

7. After creating the files for the current year, run Merge SCF and Merge 
Tables. 

Options for performing enrollment transactions are set up universally for all 
school sites using District Integration. The universal enrollment setup 
options can differ at the district office.

Note: This Central Enrollment school must be different then the 
Archive school.
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Using Enrollment Restriction

Enrollment restriction enables the District to restrict students from enrolling 
in specific district schools or to limit enrollment to one school. You can 
restrict enrollment for reasons such as expulsion, discipline, or lack of 
tuition payment. 

Using enrollment restriction requires setting up enrollment restriction 
reasons in the REN table using the Tables Definition atom.

Upload/Download Tab

Upload/Download Fields

Upload Override Options Fields

This topic of the tab overrides the Task Server operation settings, which 
you configure for individual campuses in the Campus Setup atom. These 
settings affect Task Server operation of all campuses within the DI 
implementation.
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This field group is the same for all tabs within the District Control screen. 
Only modify these fields once.

Upload File List

Use this topic of the tab to specify files to include or exclude from the 
upload.

Field Description

Upload Override 
Options

Type of override:

! No override
! Upload all files
! Upload all files that have changed

Upload Year Global override to apply to the school year 
you select. 

Dist Year Global setting you use to define the year of 
the uploaded school files. Options include All 
Years, This Year and Next, or you can select 
a specific year.

Use these files for demographic information 
updates to the District File (ADST). 

Overnight Start Time Time for the primary Task Server workstation 
to start the Overnight-Update process. Enter 
the time in Standard time followed by a or p to 
indicate AM or PM.

Add Student If Not In 
District File

Add students to the DST file during the 
nightly upload process, if the students do not 
already exist in the file.

Option Description

Include/Exclude Include or Exclude option to specify the files 
you include or exclude from the upload of 
school data. 

Note: The system saves the upload file list to 
the AFLU file.
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Download File List

Use this topic of the tab to specify the files to download to the school sites. 
Identify a District file by selecting Yes in the Dist Owned column. The 
downloaded file overwrites any previous version of this file at the school 
site. District files are never uploaded from school sites. 

If the Dist Owned column setting is No, the file is not a District file and the 
system checks the version of the file currently existing at the school. The 
SASIxp software checks the data and time of the file. If the data and time 
differs from the upload date and time the SASIxp software does not 
download. If the date and time are identical the SASIxp software will 
download. Instead, the system writes an error message in the download 
log file. 

Configuring District Control Files

1. Open the District Control atom.

2. Enter school specific information in the General tab fields.

3. Enter school specific information in the Sub Files tab fields.

File File name to include or exclude.

Frequency Frequency value of either Daily or Weekly. 

Note: If selecting a weekly frequency, the 
upload occurs on Friday.

Field Description

File File to download.

Dist Own Whether the district owns the file. Click in the 
field to display a Y. If this file is a district file, it 
downloads to the school sites and overwrites 
any previous version of the file. 

Frequency Download frequency value of Daily or 
Weekly. 

Note: Leave the Next Student ID field blank. 

Option Description
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4. From the Main pull-down menu, select District…Add Sub File.

5. Select the field information to create the Sub Files transfer operation.

6. Repeat Steps 4 and 5 until you have defined all Sub Files transfer 
operations.

7. On the School Info tab, select the information for each school.

8. On the Enrollment Options tab, select enable Central Enrollment for 
the district or leave the check box empty. If you choose to use Central 
Enrollment, supply the information to the district for Central Enrollment 
options. 

9. Choose whether your district will be using enrollment restriction. 

10. Click Save.

11. On the Upload/Download Files tab, enter the information for the 
Upload Override Options fields. To facilitate the initial DI 
implementation process, complete these fields as follows:

! Select Upload all files.
! If necessary, set Upload Year to All Years; otherwise set to 

current year.
! Set the Dist Year to the current school year.
! Set the Overnight Start Time to any valid time.

12. On the Upload/Download tab, select to include certain files in the 
upload or exclude certain files from the upload.

13. Specify the files to include or exclude. To add a file to the list, use the 
Select Files arrow.

14. Specify any files to download from the district. To add a file to the list, 
use the Fast Access atom. 

15. Click Save.

16. Click Close.

Note: If you later add Sub Files, restart the Task Servers.
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Preparing for Final Configuration
The procedures in this topic perform the final steps of the DI configuration 
before enabling the day-to-day operation. During this stage of the 
implementation, perform a manual upload of school site data. 

After uploading the data, perform additional pre-operational tasks to 
identify final DI settings and ensure data file structure integrity across all 
schools within the district. 

If implementing DI in multiple phases, address the issues in these 
procedures at the School Sites before attempting the DI implementation or 
performing the initial upload. Failure to do this could result in multiple test 
uploads and many school site modifications before developing a 
configuration that works for every school in the district. In this instance, 
coordinate the careful planning and execution of the DI installation plan 
with the District Representative.

In either case, district-wide Next ID setting, common district-wide SASIxp 
file structure, unique Student Number/Permanent Number values, and the 
creation of the district file are issues you must address before District 
Integration can operate properly.

Initial Data Upload for Configuration

1. At the district site, run the District Control atom and modify the Upload 
Override Options to permit a full upload of all years data for all 
schools.
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2. Start each Task Server workstation. From the Windows pull-down 
menu, select Debug Mode. This option enables you to review 
performance during the overnight process.

3. From the Tasks pull-down menu, select Upload Remote Site to begin 
the manual upload process.

Note: This upload copies all qualified files from every school that has 
been configured for the DI operation. 
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4. The system displays a message providing the option to start the 
manual upload process. Click Now to start the manual upload.

5. The Task Server starts the upload process. Open both the Status and 
Errors windows to display the identification of any errors during the 
upload process. 

6. Repeat these steps to start all Task Servers.

7. When the Status window displays the upload process is complete, 
verify there are no errors in the Errors window. 

The cause of most Task Server Upload errors are from incorrect 
Campus or Campus Detail settings. If the problem is with the Campus 
or Campus Detail settings, exit the Task Server program and restart 
after saving changes to Campus or Campus Detail. This process 
ensures the latest ACAM settings are read by the Task Server 
program.

8. After completing the upload successfully, selecting Exit from the File 
pull-down menu.

Note: The system displays this message when attempting to 
complete any of the options from the Tasks pull-down menu.

Note: If errors occur during the upload, resolve the problem and 
perform the manual upload again. Continue this step until no errors 
occur. For assistance in determining the cause of the upload 
failures see the Error Workbook.
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Qualifying Upload Data File Definitions

A file definition is the structure or layout of a file. Use the File Definition Pro 
atom to create custom files and fields for data not currently tracked in a 
standard SASIxp file. You can also use the File Definition Pro atom to 
customize terminology for existing SASIxp fields. 

Use the File Definition Pro atom to determine the records from the school 
site student files to use to update the District file during the nightly process. 

The file structures/layout for the SASIxp software is kept in the Files.dbf 
file. This file exists in the Datafile folder for each SASIxp installation. When 
the Task Server program transfers a student record, it uses the file 
structure to verify that the layout of the destination is the same as the 
source layout. If the file structure/layouts are different, an error from the 
Task Server program generates. 

If modifying a file structure/layout at any school Site, the same file 
modification must apply to all sites, including the District site. 

Checkdta Verification

CHECKDTA.EXE is a SASIxp helper application you can use to identify 
differences between the configured file structures and the actual structure 
of the data files residing in the same SASIxp installation.

When you run CHECKDTA.EXE, the program presents you with selections 
for the type of structure check to perform. To check file definitions do not 
select any of the checkboxes, and click OK.
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Checkdta responds with a status message indicating any file structure 
problems.

Checkdta also writes information to a log file, CHKDTA.LOG. The system 
stores this file in the Datafile folder of the SASIxp software installation. Use 
the information in this file to help you identify the type of actions necessary 
to correct file structure discrepancies at the district level of operation.

If file problems exist, you must correct them for District Integration to work.

Verifying File Structures

1. From the District SASIxp software installation, run CHECKDTA. Verify 
no inconsistencies exist in the file definition and datafile structures.

2. If inconsistencies exist, address and resolve before continuing with the 
SASIxp DI implementation.

District Site File Definition Configuration

Verify all school site data structures are valid for District Integration. Use 
the File Definition Pro atom to make district-specific modifications to the 
file definitions of the District File (ADST) at the district site SASIxp 
installation. Do not propagate these changes to the school site.

The File Definition Pro atom has three screens, List of All Files, File 
Definition, and Field Definition. 

! The List of All Files screen contains all the files in SASIxp software in 
alphabetical order by file name. 

! The File Definition screen contains all the fields for a particular file. 
! The Field Definition screen contains all the parameters and parameter 

values that defines a particular field within a file. 

Modify a field’s parameter values using either the second or third screen of 
File Definition Pro atom.

Note: For District Integration to operate properly, all data file structures 
from all school sites and the district as well as all file structure 
definitions must be identical. 
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Modifying File Definitions

1. Within the District File (ADST), the Dist Upd field parameter require 
value changes for every field within ADST. 

2. The District field parameter indicates if the district office owns a field. 

3. The Dist Upd field parameter indicates the fields to include in all 
district updates and automatically updates during the overnight 
process. A value of Y in this field indicates update during the nightly 
process. 

4. With the exception of the STATUS_INFO, FILLER and 
SUMMMER_SCHL fields, modify all fields to have a Dist Upd field 
parameter value of Y.

5. Use the Schl Trft field parameter during the New Year Rollover (NYR) 
process. When a student transfers from one school to another during 
the NYR process, this parameter determines whether the data of a 
particular field copies from one school to another school. Use this field 
parameter to prevent the transfer of school sensitive information 
between two schools during the NYR process.

6. Select Y to indicate the fields to process during the NYR process.

7. Click Save.

Determining the District Next Student ID Value

After completing the District file (ADST) modifications, determine the Next 
Student Number to use when enrolling a new student into the district. With 
District Integration, automatic student number assignment is determined at 
the District School, not at each school site.

Note: See the File Definition Pro User Guide for additional information 
on modifying file definitions.

Note: If the District is manually assigning student numbers, you can 
skip these steps.
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Use this worksheet to capture student number information, which 
facilitates the determination of the District setting for Next Student IDs in 
the District Control atom.

Determining High and Low Student Numbers

1. From the District SASIxp installation, change from an uploaded school 
database to the district SASIxp server.

2. Open the Query atom.

3. Run a query to display the range of student numbers within a school.

4. Enter the values into the worksheet.

5. Close the Query atom.

6. Repeat Steps 1 through 5 for each school in the district.

7. After finding all student numbers in the District, verify no overlap or 
duplicate student numbers exist in the system.

8. Reassign any students with duplicate student numbers.

School 
Number

PermNum Query Low 
Value

PermNum Query High 
Value
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9. From the information in the School student number queries, select a 
number to use for the DI Next Student ID values in the District Control 
atom configuration. 

10. In the District Control atom of the district SASIxp installation, enter the 
value in the Next Student ID field.

11. Click Save.

12. Click Close.

Populating the District File

After completing the Upload and Update processes, populate the District 
file (ADST) with information from the school site student files. These files 
copy during the overnight process to the district site SASIxp datafile folder. 

Use the Create/Update District atom of the District folder to add student 
record information to the district file. With this atom, update the District file 
for a specific year, range of years, or all years. You can add additional 
school site data at any time. 

In a phased implementation, add those students who were enrolled using 
local processing after the creation of the District file, by using the Update 
District File option in the Create/Update District atom.

Note: In a phased implementation of District Integration, this 
number must be high enough to accommodate any additional 
student enrollment transactions, which may occur between the time 
of the initial DI installation and the completion of the final phase of 
implementation.
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Create/Update District Screen

The Create/Update District screen contains two options. The options 
include Create District File and Update District File. Click the Select 
School Fast Access atom to selection schools to add data.

Create/Update District Fields

Field Description

Create District File Creates the District file for the schools.

Update District owned 
fields

Displays only if selecting Create District 
File. Use this option to have the program 
update district-owned fields.

Update District File Updates school-owned fields from schools to 
the District file. Use this update option if not 
updating student data in the overnight 
process.
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Perform the Create and Update Operation

1. Start the Create/Update District atom. 

2. Select the Update District File and Add Student if not in District 
File options.

3. Select the year range of student data to add to the District file.

4. Click the Select Schools fast access arrow. The Select Schools 
window displays.

Add Student if not in 
District File

Use only for the Update option. Use this 
option to indicate students who are not in the 
District file, but will be added during the 
update process.

Note: Normally you will always select this 
checkbox.

Creating/Updating for Year range to use for the create/update 
operation. Use the create/update operation 
for all years you have data for.

Select Schools Provides access to the Generic Selection 
Fast Access atom and enables you to select 
one or more active schools in the district.

School Name List of school you select to create or update 
for the District file.

Field Description
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5. Select the schools to use for adding student data by:

! Entering the school name in the Locate field.
! Press Enter.
! Selecting the school names in the Available selections list.
! Click >> to add the school name to the Selections list. 
! Clicking Add All >> adds all available schools to the selections list.

6. Click Done.

7. The Create/Update District screen reappears, displaying the schools 
list. Click Update (Create).

Cross-Year Enrollment and New Year Rollover

The Archive school contains all inactive, no-showed, or students who have 
graduated from any school in the district for previous years. During New 
Year Rollover, all of the students from this Archive school, plus all inactive, 
no-showed, or students who graduated in the District this year roll into the 
next Archive school. As a result, the number of students in the Archive 
school grows every year. Eventually, the size can become too large for the 
SASIxp software to handle. The SASIxp software can handle 99,999 
students in a school.

To solve the problem of the Archive school becoming too large, modify the 
New Year Rollover process as follows:

! When running the Create Non-Student Files process, include the 
Archive school. This process creates an empty Archive school for next 
year, ready to receive students during the Update Student Files 
process.

! When running the Update Student Files process, do not include the 
Archive school. Inactive, no-showed, or students who graduated in this 
year roll into next year’s Archive school. Inactive, no-showed, or 
students who graduated in a previous year are in this year’s Archive 
school, but they do not roll into next year’s archive school. As a result, 
next year’s Archive contains students from this year, instead of from all 
previous years.

! Students inactivated in a year prior to this year are no longer available 
for conventional transfer, which only transfers students between 
schools in the current year. Use Cross-Year Enrollment for students 
inactivated in a prior year.
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! Cross-Year Enrollment provides the ability to transfer students from a 
previous year’s Archive school. Students who were left behind in last 
year’s Archive school by modifying the New Year Rollover process, 
can still be re-enrolled. Select last year as the transfer from year, and 
transfer them cross-year.

School Site Configuration
The procedures in this topic describe the configuration necessary at each 
school site. Perform these procedures at the school site installation of 
every school for the DI implementation.

Configuring the School Atom

1. At each Task Server workstation, run the Task Server program.

2. From the Windows pull-down menu, select Debug Mode.

3. From the Tasks pull-down menu, select Transfer Students to enable 
the Transfer mode.

4. At the school site, set the District field in the School atom to the 
Centralized District Processing option.

5. Click Save, then Close to store the changes to the school site 
configuration.

6. Repeat Steps 4–6 for each school site to integrate into the DI 
implementation.

7. At the District site all campuses except CES are set to local 
processing, and each school record is set to local processing.

Configuring School Site Access

Access to District Integration-related atoms and folders should be 
restricted at each school site with the SASIxp modules set up at each site. 

Note: Verify communications between the school site and the Task 
Server by returning to the School screen, where a 
GET_TASK_SERVER_INFO status message displays on the Task 
Server Status window.
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Modifications to the Task Server application enable it to operate either as a 
standard Task Server or as the Task Server Transaction Monitor. Only one 
Task Server Transaction Monitor is needed for the entire district. All other 
Task Servers and Enrollment atoms that perform enrollment transactions 
such as adding, inactivating, or transferring students are monitored by the 
Task Server Transaction Monitor.

This monitoring is done because district enrollment transactions must be 
completed successfully at both the site and the district office. Transactions 
are not reliably transmitted between sites and the district office, and 
because a single logical transaction may consist of a dozen or more 
physical message exchanges, this requirement is not automatically met.

Task Server Transaction Monitor is designed to identify whether 
communications, database, or timeout errors are preventing the 
successful completion of an enrollment transaction. The Task Server 
Transaction Monitor then ensures the transaction is aborted at both district 
and site servers.
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Hardware Requirements
The Task Server Transaction Monitor can run on any Task Server 
workstation. To be most effective, the Task Server Transaction Monitor 
should run on a lightly loaded workstation. This will allow the Task Server 
Transaction Monitor to respond efficiently to requests to coordinate the 
beginning and completion of enrollment transactions. For optimum 
availability, the Transaction Monitor should be the only Task Server 
application running on the Task Server workstation.

Setting Up the Task Server Transaction Monitor
The installation procedure for Task Server Transaction Monitor is identical 
to that for installing a normal Task Server, except that some SASIxp.ini file 
parameters are set to different values. For best performance, the 
Transaction Monitor should be set up as the only Task Server on a 
workstation. 

For additional information on setting up a Task Server, see Task Server 
Workstation Installation on page 24.

SASIxp .INI File Parameters

PollPC ID

To modify a Task Server to run as Transaction Monitor, set this parameter 
in the PollPC section of the SASIxp.ini file. Set only one Task Server as the 
Transaction Monitor.

Note: If no Task Server is set up to act as Task Server Transaction 
Monitor, each Task Server will act as its own transaction monitor. 
Pearson School Systems does not recommend this configuration, 
because there is not optimum availability for the transaction monitor.

Parameter Name Value

Parameter_ID =MON
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Transaction Timing Parameters

A Transaction Monitor section has been added to the SASIxp.ini file. This 
section contains several parameters to control the amount of time for 
various processes in a transaction to complete. These parameters are 
described in this table.

When the Task Server Transaction Monitor is starting up, it reads these 
parameters from the SASIxp.ini file. Any parameters not specifically set 
otherwise use these default values:

Parameter Name Description Valid Range

waitSecondsAbortTransaction Seconds of inactivity on a 
transaction before the 
Task Server will 
spontaneously abort.

>= 3 X waitTimeRejectMessage

waitSecondsBeginIdleTasks Idle seconds before Task 
Server will spontaneously 
abort.

> waitSecondsAbortTransactions

waitSecondsResendAborts Seconds before the 
Transaction Monitor re-
sends Commit or Abort 
commands that have not 
been acknowledged by 
the TaskSever.

>= waitSecondsBeginIdleTasks

maxSecondsIdleTaskDuration Maximum seconds to 
spend at one time 
processing idle tasks.

<= waitTimeRejectMessage

waitHoursOldTransaction Hours to wait before 
deleting a log record for 
an incompletely 
acknowledged transaction 
from the ATML log.

>= 24

Parameter Default Value

waitSecondsAbortTransaction 45

waitSecondsBeginIdleTasks 180
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If any of the parameters are outside the valid ranges, they are adjusted to 
meet the range requirements based on the value of the 
waitTimeRejectMessage parameter from the PollPC section of the 
SASIxp.ini file. The waitTimeRejectMessage parameterhas always been a 
required parameter for District Integration, with a default value of 15 
seconds.

maxSecondsIdleTaskDuration 15

waitSecondsResendAborts 600

waitHoursOldTransaction 48 (hours)

Parameter Default Value
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Example .INI File

If each of the Transaction Monitor SASIxp.ini parameters are set to 10, 
and WaitTimeRejectMessage has its default value of 15 seconds, the 
Transaction Monitor parameters will be automatically set to the values 
assigned in the Transaction Monitor .ini file.
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Running the Transaction Monitor
The Task Server Transaction Monitor runs like any other Task Server. 
Follow these rules when opening the Task Servers and the Transaction 
Monitor:

! Open the Transaction Monitor and place it in Transfer mode before 
opening any other Task Servers. If the Transaction Monitor is taken out 
of Transfer mode or shut down, all other Task Servers must be shut 
down and reopened after the Transaction Monitor is reopened and put 
in Transfer mode.

! If any Task Server is opened and put in Transfer mode while the 
Transaction Monitor is shut down or not in transfer mode, the open 
Task Server will act as its own Transaction Monitor. Pearson School 
Systems does not recommend this configuration for optimum 
protection of district enrollment transactions.

! When a Task Server is run as Transaction Monitor, the application 
window title displays text indicating the Task Server is the Transaction 
Monitor. All other Task Servers will display their PollPC ID.

Transaction Monitor Commands

The Task Server Transaction Monitor uses several new commands. These 
commands can be sent from the Enrollment atom or Task Server to the 
Transaction Monitor or from the Transaction Monitor to the Task Server. 
No transaction control commands are sent from the Enrollment atom to the 
Task Server. These are the new commands and descriptions.

Command Description

TM_BEGIN_TRANSACTION This command is sent from the 
Enrollment atom to the Transaction 
Monitor to enable it to start a new 
transaction. The Transaction Monitor 
assigns a transaction ID and forwards 
the message to the Task Server.

TM_END_TRANSACTION The Enrollment atom sends this 
command to the Transaction Monitor 
to notify it the enrollment transaction is 
complete. The Transaction Monitor 
takes control of the commit/abort 
process for the transaction.
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TM_ABORT_TRANSACTION This command is sent to the 
Transaction Monitor by the Enrollment 
atom or the Task Server to notify it to 
abort the transaction. The Transaction 
Monitor makes sure the transaction is 
aborted by both the Enrollment atom 
and the Task Server by forwarding it as 
appropriate.

TM_PREPARE_TO_COMMIT The Transaction Monitor sends this 
command to the Task Server and the 
Enrollment atom to initiate the first 
phase of the two-phase commit 
operation.

TM_READY_TO_COMMIT 
TM_UNABLE_TO_COMMIT

The Enrollment atom sends one of 
these commands to the Transaction 
Monitor in response to a 
TM_PREPARE_TO_COMMIT 
command from the Transaction 
Monitor.

TM_COMMIT_TRANSACTION The Transaction Monitor sends this 
command to the Task Server and the 
Enrollment atom to initiate the second 
phase of the two-phase commit 
operation.

TM_COMMIT_SUCCESS 
TM_COMMIT_UNCERTAIN 
TM_ABORT_SUCCESS 
TM_ABORT_UNCERTAIN 
TM_ABORT_FAILURE

These commands are sent to the 
Transaction Monitor by the Task 
Server and the Enrollment atom to 
notify the Transaction Monitor of the 
status of the transaction commit or 
abort process.

TM_CHECK_TRANSACTION_
STATUS

The Enrollment atom sends this 
command to the Transaction Monitor if 
it has any open transactions whose 
status is uncertain at the time the 
Enrollment atom closes.

Command Description
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Transaction Monitor Log (ATML)

When the Transaction Monitor commits or aborts a transaction, it writes a 
record in the ATML log file. This record is used to keep track of the 
transaction until both the Enrollment atom and the Task Server for the 
transaction have acknowledged that the transaction has been committed 
or aborted and that they have taken appropriate action.

As soon as all participants in a committed transaction have acknowledged 
the commit, the ATML record for that transaction is automatically deleted 
from the ATML log. ATML records of aborted transactions, however, are 
left in the log, even after all participants have acknowledged the abort, so 
that the log can be queried to show recently aborted transactions.

Aborted transaction log records are automatically deleted from the ATML 
log after a period specified by SASIxp.ini file parameter 
WaitHoursOldTransaction. Any committed transaction log records that 
remain in the log because a transaction participant (Enrollment atom or 
Task Server) has not acknowledged the commit are also deleted.

Task Server Transaction Monitor Status Screen
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Task Server Status Screen

The ATML log has numeric fields for action (abort or commit), participant 
type (Enrollment atom, Task Server, or Transaction Monitor), and 
participant status. Values for these fields and their meanings are listed in 
this table.

Field Value Description

Action 3, 4 To commit the transaction enter 3. To abort the 
transaction, enter 4.

ParticipantnType 
(n = 1–9)

1 Indicates the participant as the Task Server 
Transaction Monitor.
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2 Indicates the participant as the Task Server.

3 Indicates the participant as the Transaction-
owning client, which is the Enrollment atom.

ParticipantnStatus 
(n = 1–9)

32 Ready to commit, but has not acknowledged 
commitment.

33 Unable to commit, but has acknowledged the 
abort.

34 Commit success, participant’s part of the 
transaction has been committed. 

Note: There is no Commit Failure status, because 
the two-phase commit protocol makes 
failure to commit impossible. By the time 
the commit command is issued, all data for 
the transaction has already been 
permanently stored on disk.

35 Abort successful. Participant’s part of the 
transaction has been aborted.

7 Abort uncertain. Participant cannot tell if it has 
succeeded or failed to abort the transaction. This 
can only happen if the participant is restarted 
between the time it sends a 
TM_UNABLE_TO_COMMIT reply to the 
Transaction Monitor and the time the Transaction 
Monitor responds with a 
TM_ABORT_TRANSACTION command.

36 Abort failure. Participant has attempted to abort its 
part of the transaction, but was unable to do so. 
This only happens if the participant shuts down or 
crashes while a transaction is in progress, losing 
information on how to abort the transaction.

Field Value Description
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Error Codes

Several new Client Server manager and Database manager error codes 
have been added to report transaction errors. These codes describe errors 
that occur in the two-phase commit transaction process itself. These are 
the new errors and descriptions.

Manager Error
Error 
Code Description

Client Server csBadParameters -5019 CS Manager function called 
with bad parameters.

Client Server csTransactionInProgress -5020 Two-phase commit transaction 
is already in progress.

Client Server csNoTransactionInProgress -5021 No two-phase commit 
transaction is in progress.

Client Server csTransactionError -5022 Internal error executing 
transaction.

Client Server csTransactionUncertain -5023 Uncertain whether the 
transaction should be aborted 
or committed.

Client Server csTransactionAborted -5024 Two-phase commit transaction 
has unexpectedly been 
aborted.

Client Server csTransactionCommitted -5025 Transaction is already 
committed.

Client Server csInvalidParticipantType -5026 Invalid participant type 
specified in transaction 
command.

Database dbTransactionNotActive -2092 There is no local database 
transaction active.

Database dbTransactionAlreadyActive -2093 There is already an active local 
database transaction.

Database dbInvalidRollbackPtr -2094 Invalid pointer to rollback 
information for a local database 
transaction.
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Database dbRollbackInfoError -2095 Error storing and managing 
information for rolling back a 
local database transaction.

Database dbTransactionAborted -2096 An attempt has been made to 
update the database in a local 
database transaction that has 
been aborted.

Manager Error
Error 
Code Description
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This topic provides an overview of the Task Server and Student enrollment 
operational tasks for the DI implementation of the SASIxp™ software.
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Task Server Operation
The Task Server program enables school sites to perform add, drop, and 
transfer enrollment operations and immediately update the district file 
during the day. Also, the Task Server program automatically uploads 
school site student data files and updates the district file. With this 
program you can also download specific files to school sites.

After setting up the Task Server, all tasks perform automatically. 

In a multiple Task Server environment, all Task Server workstations 
perform the upload portion of the nightly automated processes. Only the 
primary Task Server performs the Update District Student File and 
Download tasks.

Task Server Overview

See the Task Server Workstation Configuration Worksheet on page 252 to 
facilitate the use of Task Server.

The Task Server program uses these menus:

Menu Description

File Menu Use the File menu to:

! Set up the page layout of the automatic 
Task Server reports

! Quit the Task Server program

Edit Menu Not available.

Tasks Menu Use the Tasks menu to:

! Perform real-time enrollment operations 
! Perform school Site Upload operations
! Perform update operations
! Download selected files 
! Terminate the running operation

Windows Menu Use the Windows menu to display the status 
of tasks, and any errors. You can enable 
operational messages by selecting the 
Debug mode option.
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Windows Menu Functions

The Windows menu includes options for displaying the status of tasks and 
errors that occur during the performance of tasks.

Tasks Menu Functions

The Tasks menu includes these options:

! Upload Remote Sites
! Update District Student File (ADST)
! Download to Remote Sites
! Abort Current task

Pearson School Systems recommends performing the Upload, Update, 
and Download functions after hours. After enabling the real-time 
operations, the Task Server program automatically switches between real-

Help Menu The Help menu provides the About option. 
Selecting this option displays the About Task 
Server window, which displays Task-Server 
product information.

Menu Description

Function Description

Show (Hide) Status Displays the Status window, which shows 
status of actions taken by the Task Server 
during the performance of a task.

Show (Hide) Errors Displays the Errors window, which shows 
error information from the Task Server during 
the task performance.

Cascade, Tile, Arrange Controls the view in which the Status and 
Errors window displays within the main Task 
Server window.

Debug Mode Displays detailed information about tasks in 
the Status and Errors windows. 
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time and automated background operations. The Tasks menu permits 
switching between tasks to permit on-demand, manual execution of the 
background processes.

Function Description

Transfer Students Enables real-time enrollment operations 
within the DI implementation. All Task Server 
workstations must initiate this option for 
District-wide enrollment operations to work 
properly. When in the Transfer mode, the 
Task Server automatically switches into 
Upload and Update modes. After completion 
of the Upload and Update operations, the 
Task Server returns to Transfer mode.

Upload Remote Sites Permits scheduled or immediate execution of 
the Upload process. Selection of this option 
disables real-time operations of the Task 
Server. 

Update District Student 
File (ADST)

Permits scheduled or immediate execution of 
the update process. Selection of this option 
disables real-time operations of the Task 
Server.

Download to Remote 
Sites

Downloads the files listed in AFLD to the 
school sites.

Abort Current Task Stops the current operation.
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TASKSERV.ini File

The Task Server can open other applications by creating a TASKSERV.ini 
file. Use the Note Pad application to create the file. You can specify 
whether the application is to run before a download, after the download, or 
before updating the district file. External processes can be any valid 
executable program, that runs in batch mode without operator intervention.

TASKSERSV.ini file example:

*****************************************************************

;This file should be in the same directory as Task Server
; application

;List the applications that will be launched by this Task Server
[ExternalApps]
App1 = UpdateSomeFile ;
App2 = ExportASTU;

;Details about each of the above mentioned applications
[UpdateSomeFIle]
Name = UpdateFile.exe ;name of the application
WaitTillAppDone = TRUE ;should the TS wait until app is done
Parm = file = ATBL ;information to be passed to app as a parm
SupplyLoginInfo = FALSE ;should SASIxp user ID and Pwd be passed to app

; as first two parms
LaunchWhen = BeforeDownload ;can be BeforeUpdateDst, BeforeDownload,

; AfterDownload; BeforeUpload

[ExportASTU]
Name = ImpExp.Exe ;name of the application
WaitTillAppDone = TRUE ;should TS wait until app is done
Parm = group=ExportASTUMap ;any information to be passed to app as a parm
SupplyLogoInfo = TRUE ;should SASIxp user ID and Pwd be passed

; to app as first two parms
LaunchWhen = AfterDOwnload ;can be BeforeUpdateDST, BeforeDownload,

; AfterDownload
*****************************************************************

Automated Task Server Operations

Transfer mode operation is necessary for school sites to perform real-time 
enrollment operations. 

At the Upload time for a particular campus in the District Site Campus 
atom configuration, the Task Server automatically switches to the Upload 
Remote Sites operation. This operation begins uploading the data files 
from the campus file servers to the Upload directory. 

Note: In the [ExternalApps] section, the labels need to be sequential.
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The primary Task Server workstation waits until the Overnight Start Time to 
begin the overnight processing.

However, if any of the Task Servers do not complete the upload process by 
the start time, uploading continues until the process completes. Then the 
Update process initiates.

During upload processing, all files upload to upload folders. When all sites 
complete, each Task Server moves the data to the District datafile.

The Task Server then returns to the real-time Transfer mode of operation.

 

Enrollment Operations
During the day, the Task Server performs the Transfer Student task. The 
Task Server is continually accepting Add and Transfer requests from 
schools, and immediately updating the District file on the district file server. 

Use the Enrollment atom to:

! Add new students as they enroll during the course of the year.
! Inactivate students when they leave.
! Reactivate them if they re-enroll.
! Transfer students from one school to another within the district.

Note: Assign the Overnight Start Time in the District Control atom.

Note: After the Task Server program begins either the Upload or 
Update process, it does not accept any add, drop, or transfer requests.

Note: The Task Server creates the TS<nnn>_<yyyymmdd>Status.log 
and TS<nnn>_<yyyymmdd>Error.log, where <nnn> specifies the Task 
Server ID and <yyyymmdd> specifies the date for status and error 
messages respectively. The Task Server automatically deletes these 
files after fifteen days.
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Adding New Students

1. At a school site, open the Enrollment atom. The District Enrollment 
screen displays. 

2. From the Data pull-down menu, select Add Student. 

3. The District Enrollment window displays.

4. Enter the student's last and first name. 

Note: If you get a message indicating communication with the 
district could not be established, do not proceed with the Enrollment 
of the student. Contact the district office and report the problem.
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5. Click Find. The SASIxp software searches for the student record in the 
District file. A list of similar students display. Scroll through the list to 
verify the student does not exist in the District database.

6. After verifying the student does not exist in the District database, click 
Add. When adding a new student and using the automatic assignment 
of Student ID’s, the Student ID field displays asterisks in the place of 
student’s ID in the District screen. After you click Save, the system 
assigns a Student ID.

7. After adding or transferring the student, the Enrollment screen 
displays. Use this screen to enter the following information:

! Address
! Phone Number
! Parent/Guardian
! Grade

8. Click Save. 

Note: If the student is in the database, highlight the student’s name 
and click Transfer, and the student and all of their information 
transfers to your school database.

Note: Be sure to make any Grade changes in this window. If not, 
the Grade could be recorded incorrectly in the District file.
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9. Use the Fast Access arrows to complete the Enrollment of the student 
into your school.

Inactivating Students

1. At a school site, start the Enrollment atom from the Student Info folder.

2. Click Find.

3. Enter the student’s name to inactivate, and click Find.

4. After finding the record, select Inactivate Student from the Data pull-
down menu. 

5. If necessary, modify the Leave Code and Leave Date.

6. Click Save. 

The following occurs after inactivating a student:

! The Student file at the school performing the operation updates with 
the leave date and leave code from the Current screen of the 
Enrollment atom.

! The enrollment mirror file residing at the district updates with the same 
information from the school site enrollment file.

! The Status screen of the District atom updates with the leave date and 
leave code from the Current screen of the Enrollment atom at the 
school performing the inactivate request.

! All files and update immediately. 
! Inactivating a student changes the student’s status to Inactive.
! After inactivating a student, all sub-files are sent to the district office.

Note: See the Enrollment section in the Basic Applications User 
Guide for more information on enrolling a student.

Note: If the student is transferring to another school on the current day, 
adjust the leave date according to the student’s last day of attendance 
at the school of the Inactivate operation. If this is not done, the student’s 
next school of attendance cannot use the current date to activate the 
student.
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Transferring Inactive Students

Use this procedure to transfer students who are currently inactive but were 
enrolled at a prior time.

1. Open the Enrollment atom. 

2. From the Data pull-down menu, select Add Student. The system 
displays the District Enrollment option.

3. Enter the student's last name and first name.

4. Click Find.

5. After locating the student to transfer, double-click on the student name 
and the Enrollment screen displays. 

6. Click Save.

7. Click Close.

Possible Transfer Date Conflict

If the SASIxp software displays the message, ERROR: Enter date is less 
than the latest district transaction date for this student, complete these 
steps:

1. Click OK.

2. Click Cancel.

3. Change the Enter Date to a date later than the last district transaction 
date.

Note: Inactive student names display in bold type.
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Using the Transfer CHS Atom
The Transfer Course History Atom enables you to transfer course history 
records from concurrent schools to home schools. Use a batch process at 
the District on the mirror files, or transfer data for a group of students at a 
site, using the Task Server in Transfer mode.

Transfer CHS Screen

The Transfer CHS screen contents depend on your selection in the Select 
where you are running from section at the top of the screen.

Transfer Course History Fields

Use the Select where you are running from section to identify where you 
run the transfer course history process:

Field Description

District Uses district mirror files. Displays the 
Concurrent Schools and Home Schools 
matrixes for selecting schools.
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Fields for District Processing

The Concurrent School’s matrix displays the school number and name of 
the concurrent school.

The Home School’s matrix displays the school number and name of the 
home school.

Site Uses the Task Server. Displays the Student 
matrix for selecting students.

Field Description

Year Year containing the data to transfer from the 
concurrent schools. SASIxp file system 
allows retention for up to ten years of data on 
your machine. The year is determined by the 
fifth character of the file name. For example, 
the student file for school 999 for the year 
2005 would be ASTU+5+999 or ASTU5999. 
But, if you have not created a datafile for the 
year 2005 and have the datafile for the year 
1995 on your machine, then the data from 
1995 will be presented for the year 2005.

Field Description

Year Year to transfer data to the home schools. 
SASIxp file system allows retention for up to 
ten years of data on your machine. The year 
is determined by the fifth character of the file 
name. For example, the student file for 
school 999 for the year 2005 would be 
ASTU+5+999 or ASTU5999. But, if you have 
not created a datafile for the year 2005 and 
have the datafile for the year 1995 on your 
machine, then the data from 1995 will be 
presented for the year 2005.

Field Description
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Select Schools Screen

The Select Schools screen contains a double matrix. The left side contains 
the available selections. The right side contains the items you select.

Select Schools Fields

Transferring Course History Data at the District

Transfer course history data from concurrent schools to home schools 
using the District mirror files.

1. Open the Transfer Course History atom.

2. Select District from the Select where you are running from selection.

Field Description

Locate Field to quickly find the school to select. 

Available selections List of the school names available for 
selection. 

Selections Selected schools from the Available 
Selections list. The maximum number of 
selections is 20 schools.
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3. Click the Select Schools Fast Access atom under the Concurrent 
Schools matrix to select the concurrent schools for the source of the 
course history data. 

4. Select the year containing the data to transfer.

5. Click the Select Schools Fast Access atom under the Home Schools 
matrix to select the home schools to update the course history data. 

6. Select the year to update.

7. Click Process.

Transfer CHS Screen

Transfer course history data from concurrent schools to home schools 
from any school site, using the Task Server. This process updates data at 
all schools the student is concurrently enrolled in.

Note: To successfully transfer course history data from a site, connect 
to the District using the Task Server. Verify the Task Server is in 
Transfer mode. Upload the ACHS files so the mirror files reflect the site. 
Also, update the ADST file.
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Transfer CHS Field

The Student matrix displays the student ID and name of the selected 
students.

Transferring Course History Records at the District

1. Open the Transfer Course History atom.

2. Select Site from the Select where you are running from section.

3. Click the Select Schools Fast Access arrow under the Student matrix 
to select the student records to transfer. 

4. Select the year containing the data to transfer.

5. Click Process.

Adding Students Concurrently

Concurrent enrollment is when a student enrolls at more than one school 
at a time. With District Integration, the District sets up specific schools to 
accept the transfer of active students for concurrent enrollment. When the 
transfer is complete, the Student file and sub-files download to the 
concurrent enrollment school from the District. The student now has two 
active records in two separate locations.

1. At a school site, open the Enrollment atom. 

2. On the Current screen, select Add Student from the Data pull-down 
menu. The District Enrollment window displays.

3. Enter the student's last and first name.

4. Click Find.

5. After locating the student record, double-click the student name in the 
matrix. A status messages displays as the District file is read.

6. If the student is currently active and the Enrolling School is set up to 
permit concurrent enrollment, the following message displays:

Do you want to concurrently enroll student Student’s
Name who is already active at home school: School
Number - School Name?”

Field Description

Year Year containing the data to transfer for the 
selected students.
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7. Click OK.

8. After selecting a student, the Enrollment window displays for final 
verification of the student. 

9. Click Save.
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Notes on Concurrent Enrollment

! Students must be currently active to perform concurrent enrollment.
! Perform concurrent transfers in the same way as transfers for inactive 

students with the following exception: A history line does not 
automatically generate for the transfer in the History matrix, because 
the student is still enrolled at the home school. Instead, the SASIxp 
software creates a concurrent enrollment transaction to track the 
effective dates of the concurrent enrollment at the District office. 

Centrally Enrolling Students

The central enrollment process enables a school district to control 
enrollment of students by channeling all students through a central 
enrollment school. Options include the following:

! Add all students to the Central Enrollment School at the District, and 
assign them to individual school sites. The school sites transfer the 
students out of the Central Enrollment School into the site school.

! Set up a school site to limit the transfers of students to those who are 
already assigned.

! Set up a school site to transfer all students in the Central Enrollment 
School. 

! Set up school sites to prohibit the adding of new students or from 
adding a student to the Central Enrollment school. Perform this setup 
in the District Control atom. 

Perform the operation of adding and transferring student records in the 
same manner as a school site. The difference is only district office 
personnel can add students to the Central Enrollment School and the 
Central Enrollment School exists in the SASIxp software installation at the 
district.
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Deleting Records 

The two function for deleting students are to undo a bad transfer, or to 
actually delete a student. 

Delete student records only for troubleshooting purposes. If removing a 
student, perform a No Show or the Inactivate operation from the 
Enrollment atom. 

1. At the School Site, open the Enrollment atom. 

2. Click Find.

3. Enter the student’s name.

4. Click Find. 

5. From the Data pull-down menu, select Delete Student. 

6. Click Save.

Cross-Year Enrollment

Cross-Year Enrollment enables you to transfer a student from a previous 
year.

Adding Students Using Cross-Year Enrollment

1. Open the Enrollment atom.

2. From the Data pull-down menu, select Add Student. 

3. Select the year from the Transfer from Year drop-down.

Note : After deleting a student, the SASIxp software immediately:

! Deletes the student record from the school site file.
! Deletes the student record from the school site mirror file at the 

District.
! Deletes the student record from the District file.

Note: Course history may not update because you can enroll an active 
student. Running Update Course History for the active student in the 
school/year to ensures your course history is complete.
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4. Select Find.

5. Select the student to transfer, and click Transfer.

6. After the student transfers, the student record displays.

7. If necessary, edit the student record.

8. Click Save.

9. Repeat these procedures to add all cross-year enrollment records.

10. After entering all cross-year records, click Close.

Note: When selecting Find, a list of students available for transfer 
from the selected year displays. Eligible students for transfer 
display as normal text in the Student list. Students who are not 
eligible for transfer are dimmed. If there are no files for the specified 
year, a warning message displays, and you need to select another 
year.
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Working with the District File (ADST)
District Integration provides District Office staff members with a 
consolidated District-wide view of student information through the District 
file (ADST). District Office staff use the District atom to interact with the 
District file and extract information available for each student at each 
school in the District. 

Use the District atom to view the sub-demographic data for each student’s 
records in the District file. This information updates on a nightly basis 
during the update process. Do not make changes to the District File 
(ADST) at the District. Any changes made at the District will be overwritten 
during the update process.

Use the District atom to print the One Per Family Labels and the District 
Alpha Directory reports. Select a report from the District pull-down menu. 
The Report Interface for the report displays. Use this interface to run either 
the Generic version of the report or a user-definable Custom report. All 
reports contain the available data from the current date.

Report Description

One Per Family Labels Produces address labels for mailing to 
parents, based on the family number. The 
SASIxp software automatically assigns the 
family number when using the Sibling atom to 
copy data from one sibling to another. Labels 
print two or three across in alphabetical 
order, depending upon the label type you 
select.

Note: The Sibling atom does not work across 
schools.

District Alpha 
Directory

Produces a directory list of the students 
enrolled at each school in the district. This 
report is organized first by school, then by 
student.
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Status Info Tab

The Status Info tab provides District Office staff members with the student 
status history. The information is the last school of residence in each 
school year. Up to ten years of information displays. If the student is 
currently active, the leave date and leave code are blank.

Status Info Fields

Note: To verify the student’s information on the Status Info screen and 
to update and force a search the mirror file, press the Ctrl key and click 
in the Link field. 

Field Description

Year Years of student attendance history.

School Name of the student’s last active school for 
the year.

Grade District grade level of the student for the year.

Leave Date Date the student left the school for the year.
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DI Inspector
The DI Inspector atom enables you to monitor and fix synchronization 
issues between the site, mirror, and district files. This atom helps you 
maintain District Integration.

District Integration requires the site, mirror, and district database files be 
synchronized to function correctly. The DI Inspector atom produces reports 
of existing inconsistencies between database tables, and it provides tools 
for fixing discrepancies. 

The DI Inspector screen has these tabs:

! Log Viewer
! Check ENR
! Overnight Test
! Check ATRN

Leave Code Code the SASIxp software uses to identify 
the reason the student left the school.

Link Student link number for this student for the 
school year for each record line.

Field Description



Copyright © 2005 Pearson School Systems DI Inspector  141

Using District Integration

Log Viewer Tab

The Log Viewer tab enables you to view the contents of seven different log 
files created by Task Server activities.

Top Buttons

Lists names of files and will give a description of what the file contains.

Trimming Actions

The trimming action buttons display at the bottom of the screen. The 
trimming actions are cumulative. First hide older records, then hide 
matching records to further reduce the number of records to display, or 
delete records from the file by using the Trim Log button.

Button Description

Hide Older Hides all records with a later date than the 
entry you select.

Hide Newer Hides all records with a more recent date 
than the entry you select.
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Trimming Log Files

1. Select the file to trim by selecting the file’s button.

2. Select the most recent record to keep.

3. Click Trim Log.

4. The system displays a message to trim the file you select. Click Yes.

Check ENR Tab

The Check ENR tab on the DI Inspector atom opens the district mirror 
ASTU and AENR files for each school and looks for perm number and 
enrollment consistency errors. The SASIxp software checks each ASTU 
and AENR record against the corresponding District Student (ADST) and 
Enrollment (AENR) records. 

The system verifies the enrollment status information matches and 
ensures the perm numbers are unique. When non-matching enrollment 
status information is found, an error is written to the text log file, 
DIInspect.log.

Hide Matching Hides all records in the matrix with matches 
on the field you select.

Show Matching Shows all records in the matrix with matches 
on the field. It hides all non-matching records.

Show All Cancels all filtering and allows the refinement 
process to restart. Resets the matrix to the 
original display, which undoes all of the 
previous button changes, except for Trim 
Log.

Trim Log Permanently deletes fields in the log that are 
earlier than the record you select.

Note: Verify you have selected the correct record before clicking 
Yes. There is no way to undo the trim.

Button Description

Note: To print the log file use the Export List atom, and save the log file 
as a .txt file. Open or print the file using Wordpad.
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Possible enrollment errors are:

! A student is recorded as active in multiple schools.
! A student has inconsistent enrollment information.
! A student has a leave date but no enter date. 

All errors involving enrollment records display in the matrix on this tab. 

Another log file, DISortResults.log, contains the results if selecting any of 
the Show Students... checkboxes.

Field Description

Check Enrollment 
History

Starts the process of checking the enrollment 
history.

Add Missing AENR 
Records

Adds missing records to the AENR file. If 
inconsistencies are found in the enrollment 
history for a student across schools, the 
appropriate updates are made to the AENR 
files.
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Overnight Test Tab

The Overnight Test tab of the DI Inspector atom performs a check of the 
District settings and reports any possible errors in a text log file, 
DIITest.log.

After Executing the Overnight Test, the SASIxp software displays the 
following messages:

While the test is running you will be unable to make
enrollment changes at the district. Proceed with test?

This test may take several minutes for the Task Server
to run. Please wait.

Click OK to continue the test.

Show students with 
same perm num

Examines mirror files to find two students 
with the same perm number. The error log 
displays students’ names, perm nums, and 
whether the students are concurrently 
enrolled in another school.

Show students with 
same last name/
birthdate

Examines mirror files to find two students 
with the same last name and birthdate. The 
error log displays the students’ names, perm 
nums, birthdates, and whether the students 
are concurrently enrolled in another school.

Show students with 
same last name/first 
name

Examines mirror files to find two students 
with the same first and last names. The error 
log displays the students’ names, perm 
nums, and whether the students are 
concurrently enrolled in another school.

Field Description
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The Overnight Test simulates a nightly upload/download process for each 
school by completing the following:

! Mounts the school server.
! Downloads a test file to the school.
! Uploads the same test file to the District server.

It examines the start times in the District Control (ADCL) and Campus 
Setup (ACAM) files, and reports the sequence for the campus uploads. 

It also records configuration errors, which include the following:

! File included as sub-files for transfer but not in the nightly upload.
! Data source names in ACAM, which are not enclosed in square 

brackets, but match one of the bracketed data source parameter 
groups in the RDBMS.ini file.

! Site and District server using the same SQL data source.
! Schedules the Upload start time in the late morning rather than in late 

evening.
! Schedules two Task Servers to start at the same time.
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Field Description

Perform Configuration 
Check

Examines the setup of the Task Server for 
possible configuration errors. 

Perform Overnight/
Update Check

Runs a test while the Task Servers are in 
Debug Mode by simulating a nightly upload/
download process. Errors are reported to a 
log file, which you can view in the Log Viewer. 
After executing the test the SASIxp software 
displays the following messages:

While the test is running you
will be unable to make enrollment
changes at the district. Proceed
with test?

This test may take several
minutes for the Task Server to
run. Please wait.

Display Upload/
Download and 
Overnight Start Times

Displays and sorts contents of the ACAM file 
by upload start time. Displays how the nightly 
process runs.

Execute Starts the processes you select.

Campus Number Information comes from the ACAM file.

Campus Name Information comes from the ACAM file.

School Number Information comes from the ACAM file.

Task Server Information comes from the ACAM file.

Upload Time Information comes from the ACAM file.

Upload Year Information comes from the ACAM file.

Upload All Information comes from the ACAM file.
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Check TRN Tab

Use the Check TRN Tab when the ATRN file is deleted, becomes 
corrupted, or becomes to large. Fix the ATRN by selecting to recreate the 
ATRN file from the District ASTU mirror files, or to synchronize the ATRN 
file with the District ADST files. Click Fix ATRN, to begin the correction 
process.

Check TRN Fields

Field Description

Recreate ATRN from 
ASTU mirror files

Recreates the ATRN file from the District 
ASTU mirror files.

Synch ATRN with 
ADST

Trims the size of the ATRN file by removing 
students no longer in the District.



148  DI Inspector Copyright © 2005 Pearson School Systems

Using District Integration



Copyright © 2005 Pearson School Systems  149

District Consolidation

District Consolidation enables districts to combine data from one or more 
schools into a single database. The District uses these combined files to 
view and produce reports on the consolidated data. For example, this 
feature enables the district to consolidate all of the SASIxp health records 
from your school sites into a district-wide health file. The primary goals of 
district consolidation are:

! Consolidate multiple school data into a single database.
! Consolidate student information into a single database for students 

concurrently enrolled in multiple schools.

This District file has a special naming convention to designate the file as a 
district consolidation file.

The District Consolidation process also creates an enrollment trace file 
(ATRC), which contains the schools each student enrolls in. The SASIxp 
software also creates an error log (DCERR), which contains the 
consolidation processing errors. 
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Setting Up District Consolidation
Define one or more district consolidation file, which specifies the files to 
included in the consolidation. Consolidate each file using one of these 
consolidation methods:

Define one or more district consolidation definitions to specify the schools’ 
data to include in each consolidation. Include each schools’ references as 
a file definition. Schedule the consolidations to run, or run specific 
consolidations manually.

Method Description

Home School Data Only This method applies to student-related files 
only. The method indicates only those 
records from the student’s home school to 
include. Examples files are ASTU, APRN, 
AEMG, and AMED, which would only 
consolidate Home School Data, because the 
home school owns the student’s most current 
information for these files.

All Schools Data This method applies to non-student-related 
files. The method indicates not to apply logic 
when consolidating the files with this method. 
The resulting consolidation simply will be a 
merge of all schools’ files. Configure this 
method for the following files:

! ACRS
! AMST
! ATCH
! ASTF

Home and Concurrent 
Data

Use this method for student-related files 
when the data to consolidate is from the 
home school and all concurrent schools. Use 
the Schedule viewer atom to view student 
schedules.

Exclude Use this non-method to bypass a file setup in 
the CFD type. This option is a convenient 
way to temporarily turn off files you select 
without removing them from the definition.
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Using the Consolidation File Definition Atom
Use the Consolidation File Definition atom to create CFD types. A CFD 
type identifies the files to aggregate during the SASIxp district data 
consolidation process.

For each data file in a CFD type, indicate whether to consolidate data from 
the following options:

! From a student's home school only.
! From home and concurrent schools.
! For all schools attended by the student. 
! Exclude a file to ensure the data is not in the consolidation data file.

The following lists of files are only examples of the files you can include.

For an elementary school, you may include the following files: 

! ASTU – Student
! AENR – Enrollment
! APRN – Parent/Guardian

For a high school, you may want to include the following files: 

! ASTU – Student
! AENR – Enrollment
! APRN – Parent/Guardian
! ACLS – Class Schedule
! ACHS – Course History

Files Supported for Consolidation

Do not include the AATP – Period Attendance or AATD – Daily Attendance 
files in your CFD Types. Data in these files are stored in a manner that is 
not compatible with the data in the other files. To view or report on 
attendance data at multiple schools, use the Attendance Aggregation atom 
to prepare a consolidated data file.

User Files

To get user files for consolidation, you must modify the file through the File 
Definition Pro atom. 

Note: You can choose additional files as needed.
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Modifying User Files for Consolidation

1. Select the user file and open the definition. 

2. Click Keys. 

3. After you are looking at the keys, select the Aggreg1 field in the matrix 
for the first field in the primary key.

4. Select D - Only in District Aggregate Key, for this field.

5. Click Save.

6. Now you can select your user-defined files for consolidation.

Consolidated File Definition Screen

Consolidated File Definition Fields

Field Description

Consolidated File 
Definition Type

File definition descriptions from the CFD 
table of the Tables file (ATBL). Select one of 
the pre-defined values in this field.
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CFD Data File Matrix List of files associated with a CFD Type. You 
can sort the matrix on the file code, file 
description, or consolidation method by 
double-clicking on the appropriate column 
heading.

File Code Four-character code the SASIxp software 
uses to identify the data file. Locate the file 
code in the ACFD File_Code field.

File Description Description of the file code. The data in this 
column is read-only.

Method Consolidation methods:

! Home School Data Only method 
consolidates data from a student's home 
school for the data files you select. This 
option is the default method when adding 
new data files. Use this method for most 
student data files.

! All Schools Data method consolidates 
data from all schools for the data files you 
select. Use this method for non-student 
data files such as MST – Master 
Schedule file, CRS – Course file, or TCH 
– Teacher file. 

! Home & Concurrent Data method 
consolidates data from all schools a 
student is currently enrolled in for the 
data file you select. Use this method only 
for the class schedule file (ACLS).

! Exclude method specifically excludes the 
data file you select from the consolidation 
process. When temporarily changing the 
consolidation status, mark a series of files 
as Exclude, instead of deleting them from 
a CFD Type.

Field Description
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AATG Extract Absence Types Screen

AATG Extract Absence Types Fields

Field Description

Consolidated File 
Definition Type

File definition description from the CFD table 
of the Tables file (ATBL). Select one of the 
pre-defined values in this field.

Absence Types Absence types to extract to the AATG file.

Aggregate All-day 
Absences

Aggregating daily absence codes. Select this 
option to set the system to aggregate Daily 
absences, Half Day absences, and All Day 
Codes from the period attendance files.
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Working With CFD Types

Adding Data Files to a CFD Type

1. Open the Consolidation File Definition atom.

2. In the Consolidated File Definition Type field, select the CFD Type to 
add data files.

3. From the Data pull-down menu, select Add File.

4. In the File Code column, select the data file to add to the CFD Type.

5. In the Method column, select the consolidation method for each data 
file.

6. Repeat Steps 3 through 5 to add additional data files to the CFD Type.

7. Click Save. 

Aggregate Period 
Absences

Aggregating period absence codes. Select 
this option to set the system to aggregate 
Period absences from the period attendance 
files.

Select one checkbox to limit the aggregation 
to Daily absences, Period absences, or 
select both to aggregate all absences. 

Note: You must select at least one checkbox 
for the aggregation process to function.

Field Description

Note: Use the Select Files Fast Access atom to open the Generic 
Selection atom. Select and add multiple data files. The Generic 
Selection atom displays all of the data files in the SASIxp software, 
not just District consolidation files.
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Copying Data Files From One CFD Type to Another

1. Open the Consolidation File Definition atom.

2. In the Consolidated File Definition Type field, select the CFD Type to 
copy data files.

3. From the CFD pull-down menu, select Copy CFD Type.

4. In the Copy CFD Type window, select an existing CFD Type or type a 
three-character code for a new CFD Type in the Table Code field.

5. Click Copy.

Creating District Consolidation Definitions
Use the District Consolidation Definition atom to create consolidation 
definitions that identify the schools to consolidate. The SASIxp software 
uses these definitions to identify how to consolidate school information. 

Note: The system copies all data files from the first CFD Type to 
the second type. If the second CFD Type has data files, the files 
append to the data file matrix.

Note: Each definition includes a group of schools and enables you to 
consolidate data for that group at the district. An example is having one 
definition for the high schools in the district, one for the middle schools, 
and one consolidation file for all schools in the district.
Most districts will have only one district consolidation definition, D01. 
But, if dividing schools into different consolidated data files, it is 
necessary to have multiple district consolidation definitions.
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District Consolidation Definition Screen

District Consolidation Definition Fields

Field Description

District Consolidation 
Definitions

Description of the district consolidation 
definition.

Disable Indicates whether to disable the 
consolidation definition.

School Matrix List of schools associated with the 
consolidation definition. To sort the matrix by 
school number, school name, or CFD type, 
double-click the column heading.

Sch# Three-character code for the school.

School Name Name of the school. The data in this column 
is read-only.

CFD Type CFD type to use when consolidating the 
school. The CFD type identifies which data 
file set to use.

Exclude Temporarily excludes the school from 
consolidation.
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Working with Consolidation Definitions

Creating District Consolidation Definitions

1. Open the District Consolidation Definition atom.

2. From the Consolidation Def. pull-down menu, select Add Consolidation 
Def.

3. In the Consolidation Definition window, enter the 3-character code for 
the consolidation definition in the Cons. Code field.

4. In the Cons. Description field, enter a description for the 
consolidation definition. Make this description unique and informative, 
because only the description displays on the District Consolidation 
Definition screen.

5. Click Add.

Adding Schools to the District Consolidation Definitions

1. Open the District Consolidation Definition atom.

2. In the District Consolidation Definition window, select the consolidation 
definition to add schools using the District Consolidation Definitions 
field.

3. From the Data pull-down menu, select Add School.

4. In the Sch# column, select the school to add to the consolidation 
definition. The system displays the school name in the School Name 
field.

5. In the CFD Type field, select the CFD type. The CFD type identifies 
the data file set to use when consolidating this school.

6. In the Exclude field, select to temporarily exclude this school from 
processing by clicking the cell for each school until the cell displays 
Yes.

7. Repeat Steps 3 through 5 to add additional schools to the 
consolidation definition. 

8. Click Save.
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Using the District Consolidation Atom
Use the District Consolidation atom to consolidate the data from multiple 
schools in your District. Use the Query atom to view and report on the 
combined data. Use the Schedule Viewer atom to view a student's 
schedule that spans multiple schools in the district.

The consolidation process uses the parameters from the Consolidation 
File Definition and District Consolidation Definition atoms when combining 
the data. 

During the consolidation process, the SASIxp software reads records from 
both the district file (ADST) and the concurrent transaction file (ATRN). 
The resulting data files contain data from all schools in the District 
Consolidation Definition.

The output from the District Consolidation process is a part of SASIxp data 
files on the District server, which contains the consolidated data from the 
SASIxp school sites. The consolidated files have the same file layout as 
the site files. Use the Query atom or a third-party tool to prepare reports on 
the consolidated data.

District Consolidation Screen
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District Consolidation Sets Fields

District Consolidation Progress Fields

The status of the consolidation process. The system fills in the columns of 
the matrix as each file processes. 

Creating Consolidated Data Files

1. Open the District Consolidation atom. 

2. In the Process column of the Consolidation Sets matrix, select the 
district consolidation schools to process. Select the schools by clicking 
the cell until the cell displays Yes.

3. Select the Obey Filters checkbox to use the filters in the System Filter 
folder to limit the resulting data file.

4. Click Consolidate. 

5. Click Continue to consolidate the files, or click Cancel to stop 
consolidation. 

Field Description

# Set identifier. 

District Consolidation 
Definition Name

Name of the set.

Process Indicates processes of the set.

Obey Filters Indicates use of filters in the System Filter 
folder when consolidating the files.

Field Description

File Four-character code the SASIxp software 
uses to identify the file.

File Name Name of the file.

Status Indicates if the file was processed.

Note: Selecting this checkbox slows the consolidation process. 
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The system reads District and Concurrent Enrollment Transaction files, 
and populates the Consolidation Progress matrix with the names of the 
files from the first school. As each file consolidates, the system displays a 
Completed message. The number of records processed displays in the 
Status column. When the system finishes processing the first school, it 
begins the next school in the District Consolidation Definition.

After finishing the consolidation, the system displays a Completed 
message in the Message Center.

Automating District Consolidation

Use the Task Server to open a stand-alone application, Autocons.exe, 
which performs district consolidation as part of the nightly Task Server 
processes. 

After automating consolidation, the system produces a log file, 
Autocon.log. This file contains details about the Auto-consolidation 
process. The log file saves to the Datafile folder.

1. Set up District Consolidation using the Consolidation File Definition 
and District Consolidation Definition atoms.

2. Verify all consolidating schools have valid school calendars.

3. Using the District Consolidation atom, perform a manual consolidation 
to verify the process works properly and contains necessary data. 
Modify until everything is accurate.

4. Use the District Consolidation Definition (DCD) atom to disable any 
consolidation definitions to exclude from the automated consolidation.

5. Modify the TASKSERV.ini file to open the Autocons.exe application. In 
the [UpdateSomeFile] section, change the Name parameter to 
Autocons.exe.

Note: If student is not in the District file, they will not be in the 
consolidation file.

Note: Run District Consolidation within the SASIxp software by 
logging into the first school in the DCD definition. If the 
consolidation works properly, the auto-consolidation process works.

Note: By default all DCDs are processed.

Note: The Auto-consolidate for Windows has no window. For 
Macintosh, the Auto-consolidate application displays status 
information.
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Using the Schedule Viewer Atom
Use the Schedule Viewer atom to view a student schedule that spans 
multiple schools. The schedule includes classes from the home school 
and any concurrent schools the student is currently enrolled in.

This atom works with the consolidated school data files. The District server 
stores the data.

Qualified Files

! ASTU
! ADST
! ACLS
! AMST
! AROT
! AATO
! AACT
! ASCH
! ATRC
! AATC
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Schedule Viewer Fields

Field Description

Last Name Student's last name.

First Name Student's first name.

Middle Name Student's middle name.

Grd Student's grade.

Gen Student's gender.

Student ID Student's identification number.

Ln Line number in the matrix.

Sec ID Section number.

Beg Beginning period of the course.

End Ending period of the course.

Trm Term of the course.

Days Day the course meets.

Crs ID Course number.

Course Title Course title.

School School short name.

Tch Teacher number.

Teacher Name Teacher name
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Viewing Student Schedules

1. Select the consolidation school to work with by double-clicking the 
Status Bar. 

2. Select the District school from the Change School/Year window.

3. Click Save.

4. Click Close.

5. Open the Schedule Viewer atom.

6. Select the student record to use from the Schedule Viewer window. 
The system displays the schedule for the student you select.

7. When you finish viewing the schedule, click Close.

Printing Student Schedules

1. Display the student schedule to print.

2. From the File pull-down menu, select Print.

3. In the Print Selection window, select A window in the Format As field, 
and click OK. The system prints the Schedule Viewer window for the 
student.

Using Enrollment Restriction
Use the Enrollment Restriction atom to restrict students from enrolling in 
specific schools in the district, or to limit enrollment to one authorized 
school. Use this atom for District Consolidation.

Restrict student enrollment for reasons such as expulsion, discipline, or 
lack of tuition payment. 

Note: Before viewing student schedules from the District server, be 
sure you update the SASIxp.ini file to point to the consolidated data file 
from the setup checklist. See SASIxp.ini File Example on page 29 for 
additional information on setting up the SASIxp.ini file.

Note: Before printing student schedules on the District server, update 
the SASIXP.ini file to point to the consolidated datafile.
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Indicate an Exclusion School, which is the school the student was enrolled 
in at the time of the exclusion. This data is informational and has no effect 
on the enrollment process. It is possible to designate the Authorized 
School as the only school students can enroll in. 

If a student has an enrollment restriction and you do not select an 
Authorized School to enroll them, the student is not able to enroll in any 
school.

Setting Up Enrollment Restriction

1. Use the Tables Definition atom to set up the enrollment restriction 
reasons for your schools in the REN table. The REN table contains 
one default entry: TR for Truancy. Create the District REN values in 
School 000 on the District server. 

2. Use the School atom to define the Infraction School list and the 
Authorized Enrollment School list.

3. Enrollment restrictions take effect only if you select the Using 
Enrollment Restrictions option on the Enrollment Options tab of the 
District Control atom.

When selecting the Using Enrollment Restrictions checkbox, the 
title bar of the Enrollment Restriction atom displays Enrollment 
Restriction. If not using the Using Enrollment Restrictions checkbox, 
the title bar of the Enrollment Restriction atom displays Enrollment 
Restriction (disabled).

Note: Set up the enrollment restriction reasons using the District 
Consolidation School on the District server.

Note: When making changes to the Using Enrollment 
Restrictions checkbox in the District Control atom, exit and restart 
the Task Server. This process enables the SASIxp software to 
recognize the changes and enforces the enrollment restriction 
when students transfer or are enrolled. When Using Restrictions is 
on and student does not have restrictions, all sites are eligible.
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Enrollment Processing

To support enrollment restriction, the Enrollment atom checks for 
restrictions on students. The SASIxp software processes enrollments if:

! No restrictions are entered for a student and you disable enrollment 
restriction in the District Control atom.

! You enter restrictions for a student, but you disable enrollment 
restriction in the District Control atom.

! You enter restrictions for a student, and you enable enrollment 
restriction in the District Control atom while you are also enrolling the 
student in the Authorized School.

! The SASIxp software displays error messages if all of the following are 
true:
! Entering restrictions for a student.
! Enabling enrollment restriction in the District Control atom.
! The student does not have an Authorized School, or you are 

attempting to enroll the student in an unauthorized school.

Enrollment Restriction Screen
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Enrollment Restriction Fields

If the Student is inactive, a no-show, or if you left out data files in the CFD 
type of consolidation, these fields may be blank.

Field Description

Current Enrollment 
School

School the student is currently enrolled in. 

Note: If the student is currently enrolled in 
a school and you enter an 
enrollment restriction before 
inactivating the student, they could 
be enrolled in an unauthorized 
school.

Enter Date Enter date for the school the student is 
currently enrolled in. 

Enter Code Enter code for the school the student is 
currently enrolled in.

Enrollment Restriction 
Yes

Student has an enrollment restriction.

Exclusion Date Date an enrollment restriction was entered 
for the student. When selecting the 
Enrollment Restriction Yes checkbox, the 
field defaults to the current date. However, 
the Exclusion Date field is not modified 
from the previously entered date.

Exclusion Code Code for the reason the student's 
enrollment is restricted. When selecting 
the Enrollment Restriction Yes checkbox, 
the field defaults to a code of TR, Truancy. 

Clarification Additional information about the 
restriction.

Exclusion School School where the student was enrolled at 
the time of the exclusion.

Authorize enrollment at Only school in which the student can 
enroll.
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Working with Enrollment Restrictions

Adding Enrollment Restriction

1. Open the Enrollment Restriction atom.

2. Select the student record.

3. Click the Yes option for Enrollment Restriction. The system enters 
the current date into the Exclusion Date field.

4. In the Exclusion Code field, select an enrollment restriction reason 
code. The system displays the description.

5. In the Clarification field, enter additional information about the 
enrollment restriction.

6. To indicate the school the student was enrolled in at the time of the 
exclusion, select the school in the Exclusion School field.

7. To limit students from enrolling in a specific school, select the school in 
the Authorize enrollment at field.

8. Click Save.

Removing Enrollment Restrictions

1. Open the Enrollment Restriction atom.

2. In the Enrollment Restriction window, select the student’s record.

3. Click the Enrollment Restriction Yes checkbox to deselect it.

4. Click Save.

Note: You can manually change this date if necessary.

Note: If a student has an enrollment restriction and you do not 
select an authorized school, the student is not permitted to enroll.
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Using the Attendance Aggregation Atom
Use the Attendance Aggregation atom to collect student absence data 
from schools in the district. This atom enables you to select one or more 
schools, and one or more absence types. Based on these criteria, the 
atom reads the data files for the schools you select and extracts the 
student absence data.

This data is in the AATG file, and you can query it for District reporting. The 
file contains one record for each student per All Day absence. The data 
differs slightly between period attendance schools and daily attendance 
schools, and for schools tracking half-day attendance.

The SASIxp software only gathers data from the Home school.

The AATG file contains this information for each record:

! Status
! School Number
! Student District Link Number
! Permanent Student Number
! Absence Date 

For period or daily attendance schools, the file also contains the following:

! All Day Absence Code
! All Day Title
! All Day Abbreviation
! Absence Type
! Absence Description

For half-day attendance schools, these fields contain data for a.m. 
attendance. The SASIxp software creates a second set of fields, ending 
with a 2, to hold p.m. attendance data.

Note: These fields are blank when using class attendance. 

Note: These fields are blank if using class attendance.
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When to Use Attendance Aggregation

Run the attendance aggregation process at the District after completing 
overnight processing for the end date to use for any reports. An example is 
when preparing a report on attendance data up to and including the month 
of January. Run attendance aggregation after overnight processing for all 
school sites is complete for January 31. The data in the resulting file is for 
the current year, beginning with the first day of school, ending January 31.

Attendance Aggregation Screen

Attendance Aggregation Fields

Field Description

School # Number of the school to include in the 
aggregation.

School Name Name of the school to include in the 
aggregation.
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Aggregating Absence Data

1. Open the Attendance Aggregation atom.

2. Click the Select Schools for Attendance Aggregation Fast Access 
atom.

3. In the Select Schools window, select the schools to collect attendance 
data. 

4. Click Done to return to the Attendance Aggregation window.

5. In the Absence Types matrix, select the absence types to include. 

6. Select to aggregate all-day absences, aggregate period absences, or 
both.

7. Click OK.

The system displays a progress bar in the Message Center. When the 
progress bar disappears, the aggregation is complete.

Absence Types Absence types to include in the aggregation. 
You can select one or more absence types by 
holding down the shift key and selecting the 
types you want.

Note: The Positive absence type captures 
attendance information for all students.

Aggregate All-day 
Absences

Select this option to enable the system to 
aggregate Daily, Half Day absences, and the 
All Day Code from the Period attendance 
files.

Aggregate Period 
Attendance

Select this option to enable the system to 
include the period absences from the period 
attendance files.

Field Description
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Use this topic to create and set up files for the new school year. See the 
SASIxp New Year Rollover User Guide for additional information on the 
New Year Rollover (NYR) process.
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Process Overview
New Year Rollover is a multi-step process to create database files for the 
new school year and to move student records to the correct school data 
files for next year’s scheduling. 

In a District Integration environment, New Year Rollover creates the new 
files in the data file of the District server. 

On the District server after a nightly DI upload, all data is centralized, and 
rollover runs on this database. After the rollover process completes, copy 
the files down to each site. 

The New Year Rollover process differs for schools using District 
Integration and those not using District Integration. Because the process is 
data-driven, data affecting New Year Rollover includes student grade, 
grades instructed at a school, District file status information, concurrent 
enrollment flags, and so on. 

Step 1, create non-student files in the new year. 

Step 2, student data rolls into the new year’s files, at their next year 
schools. 

Step 3, perform subsequent rollovers to update students, demographics, 
and grades into the correct files for the new year. This step corrects any 
changes occurring after the previous steps. 

Step 4, students receive a graduation code and date in the Student file. 
These students’ records roll into the Archive school at the District.

Step 5, Course History files from the current year roll into the new year. 
This process updates the student’s grades in the new school or grade. 

Note: The Archive school is a holding tank for the records of graduated 
students and students who are inactive at the end of the year. 
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Preparation
Before attempting a New Year Rollover, complete the following:

! Identify students attending new schools or non-standard grades in the 
next year.

! Ensure a clean and complete upload on the night before processing 
the New Year Rollover Option Sets. Query the District SASIxp log files 
(ADPS, AUFS, and AONL) to verify the upload is clean and complete. 
ADPS has one record for each school and year of data. The Upload 
Status field displays SUC_AND_MOVED with the last upload date for 
the current year files in every school. Also, the AUFS and AONL files 
do not display any failures (Level Code “F”) for the current year files for 
the last upload. Ensure all upload folders are empty, indicating the files 
successfully moved into the District datafile folder. 

! Create a clean District file (ADST) by completing the following 
procedure: 
! Open the Create/Update District atom. 
! Select Create, update District-owned fields, process all schools 

and all years.

Selecting all schools and years preserves ATRN records for previous 
years. The ATRN file records data for students concurrently enrolled in 
multiple schools. 

! Verify the creation of the ALIC file option sets. Use this file to 
determine whether files will be created blank in the new year or carried 
forward from the current year with their existing data. If multiple option 
sets have been created, modify the ALIC file between option sets. 
Some file codes have no records in the ALIC file. These files copy to 
the next year if selected, as if they had ALIC records with the “Create 
New” flags not set.

! Verify the School file. New Year Rollover uses School atom information 
at the District SASIxp installation. This file must be set up properly, The 
School atom mirrors the school sites exactly, with the exception that 
each record at the District is set to “Local Processing”. 

Note: The NextSchool and NextGrade fields in the Student file 
enable the SASIxp software to roll the student’s data into the 
destination school and grade.

Note: Leave out consolidated schools and demo data schools. 
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! Make sure the ADF1, ADF2, ADF3, and ADF4 files are up to date. Run 
Create ADF from the File Definition Pro atom to recreate these SASIxp 
Data Dictionary files if necessary. If using Oracle or MS SQL, update 
the files in a standalone DB4 environment and run XPODBC in the 
Oracle/MS SQL environment to replace the current files.

School Related Rollover (Non-Student Files) 

! Run this process once before processing student-related files. 
! It does not matter the order to run the schools, but be sure to include 

them all.
! Process the Archive school once. Only the default files (ATBL and 

ASCF) need to roll over for the Archive school. The Archive school can 
be run in its own option set, depending on whether you roll over 
archived student records.

! In this phase of New Year Rollover, include all of the non-student files 
you will be using in the next year (for example, Course, Teacher, and 
scheduling files).

! The Table (ATBL) and Sequence Control (ASCF) files copy to the next 
year automatically. They do not appear in the list to select or deselect.

! Distribute modified files to each school from the District. 

Student Related Rollover (First Iteration)

! Decide whether to graduate students to the Archive school now or 
later. New Year rollover includes a process to give seniors a graduation 
date, which the system reads to determine if a student’s record should 
be sent to the Archive school. The graduate process may be run at the 
beginning of this first student rollover process or later, after the school 
is more certain whether students will really graduate. If the graduate 
process is not run before the first student rollover, the graduating 
students appear as errors in the NewYear.log file. Because the system 
skipped the students in grade 12. See Graduate Students Process on 
page 178 for more information.

! Verify that the NextSchool field in ASTU file was properly populated 
during the preparation phase. Use this field to determine which school 
a student’s files will be sent to in the New Year. A blank value indicates 
the student will stay at the current school.

! Verify the NextGrade field in ASTU file. This field specifies which 
grade the student will attend in the new year. A blank value indicates 
the student will be promoted according to the pattern in the School 
atom. 
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! Leave the Next School and Next Grade fields blank for students in 
grade 12.

! Verify the files to process. See Files on page 196 for a list of files to 
process. Select all student-related files you use in the New Year. If files 
are not rolled over, the SASIxp software prompts you to create them 
when opening atoms. 

! The Student (ASTU), Enrollment (AENR), and Schools Attended 
History (ASAH) files automatically process.

! The enter and transfer codes from the ASTU and AENR files populate 
the Enter Code field in next year’s files. The enter codes in the New 
Year Rollover atom are used when a student’s files are rolled over to 
the current school. The Transfer codes are used when files are rolled 
over to a different school. Use different transfer and enter codes for the 
same school in the option set. 

! In the Update Student Files process option, on the selected files tab, 
there are three options for each file: 
! Promote, the student moves to a new grade
! Transfer, the student attends a new school
! Archive, the student is inactive in the new year

Use these columns to indicate whether specific record types will roll 
over students.

! After a student-related New Year Rollover, modified files push down to 
each school using a DI download or simple copy and paste.

Note: An X in the column means corresponding data moves with 
the student. 
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Student Related Rollover (Subsequent Iterations)

! It is necessary to roll student files to the new year again after school is 
complete. This process copies new student demographics, grades, 
and other changed data to next year’s files.

! Do not attempt to reassign students to different schools using 
subsequent rollovers. When student-related files process, the program 
does not read the NextSchool and NextGrade fields in the Student 
file. Instead, it reads ADST fields to find where student records are 
already located in the new year. Use status info buckets to find each 
student’s destination school. These fields display on the Status Info tab 
of the District file. 

staxxxxxxx[year]: staGrade, staLeavecode, staLeavedate

! If ADST is rebuilt after the first student rollover, it includes next year.
! New Year Rollovers for student-related data updates records for each 

student, not files. Each subsequent rollover will overwrite changes with 
data from the current year. 

Graduate Students Process

! The Graduate Students option set populates GradDate and 
GradCode in the Student file (ASTU).

! Select only high schools when graduating students to the archive 
school. 

! A subsequent New Year rollover must run after processing the 
Graduate Students option set to move graduated students to the 
Archive school.

! Populate the graduation date and code in the current year’s student 
files. The next nightly upload will overwrite this data with school site 
data, so the next rollover must be run on the same day as the graduate 
process.

! The Graduate Students process uses the first grade in which the 
corresponding Promote Grade Level to field is blank in the School 
atom.

Note: Students cannot be reassigned to new schools or grades 
through rollover during subsequent iterations of the process.
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Update Course History Process

! This process is an option on the Update Student Files tab of the New 
Year Rollover atom. When selecting the Update Course History 
checkbox, the file matrix disappears and you have the option to include 
ACHN. This process rolls course history information to the new year 
files.

! The Update Course History process is nearly identical to the Update 
Student Files process, except the only files updated are Course 
History (ACHS) and optionally Course History Narrative (ACHN). 

! The only difference is how records match from the target ACHS file to 
the source ACHS file. The records are considered matching only if all 
of the following fields match:
! Course
! Grade
! CalMonth
! CalYear
! Term
! SchoolAttn

If all of these fields match one of the target records for a student, the 
matched target record updates using the school-transferable fields 
from the matching source record. 

Otherwise, the source record’s school-transferable fields copy to a 
new record in the target ACHS file.

District Integration Processing Checklist
Use this checklist to create and set up files for the new school year using 
the New Year Rollover atom. These steps are for schools using centralized 
processing. Process these steps using any school year, unless otherwise 
stated. 

Perform these steps as they appear in this section to successfully roll over 
files. 

Note: Pearson School Systems recommends reading this entire topic 
before starting the NYR process.
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System Setup – School Sites

Complete these steps at each School site in the current year, including any 
new schools.

Step School Site Procedure (Current Year)

1. Student atom, Page 2 tab

If a student will attend another school within the District 
because they are moving, change the Next Grade Level and 
Next School of Attendance fields to reflect the move.

2. Student atom, Page 2 tab

When retaining students, enter the retention grade in the 
Next Grade Level field.

Note: The Retain checkbox in the Student atom, Page 3 tab 
does not retain students.

3. Next ID atom 

Complete this process of updating Next IDs at each School 
site before uploading:

Before the upload process completes, update the Next IDs at 
the District site. This step ensures no duplicate IDs exist in 
your school District’s data.

From the Next ID pull-down menu, select the Update All Next 
IDs option. 

Note: Do not do this step if deleting students.
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System Setup – District Site

For NYR, process Steps 1–4 once.

Step District Procedure (Current Year)

1. School atom

1. Verify the Grade Levels Taught field has the correct 
value.

2. Verify the Promote Grade Level To field is correct for 
each school in the School file. 

Note: The highest grade level will not contain a Promote 
Grade Level To. Any grade level falling after the 
highest grade level is not processed.

2. School atom, Enrollment tab

1. Verify the Graduation Code is correct.

2. At the District you can complete the following query to 
change schools Graduation Code to equal the Table file 
if it is not defined: 

Change ASCH GradLvCode = ?? if GradLvCode = ’ ’

Note: ?? = the Leave code (LVE) for graduation found in the 
Tables Definition atom.
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3. License file

The license file contains all files necessary to run the SASIxp 
software.

1. See Files to Process on page 196 to identify the files 
Pearson School Systems recommends creating new 
without rolling over last year’s data, and the files to copy 
from last year’s data. 

Note: Examples of files to create new, without copying last 
year’s data are AATC and AATP. Create these files and 
others new because the existing data changes for one 
year to the next.

Examples of files to copy from last year are AIMM and 
AEMG. Copy these files from last year because the 
data does not change from one year to the next.

2. Use the following to query the License file: 

Display, ALIC FileCode Descript CreateNew

Note: An X in the CreateNew field will create a blank file, and 
the previous year's data will not roll over. 

3. To change the file and bring over the previous year’s 
data, run the following query statement: 

Change, ALIC CreateNew to ’ ’ if FileCode = XXXX

Note: XXXX = the file’s code to change.

4. The License file is not school or year qualified. When 
changing the CreateNew field, it changes for every 
school. 

Note: Because the ALIC file is a non-qualified file, there is 
only one way to process it.

Note: The files to populate with data for the new school year 
is a District decision. 

Step District Procedure (Current Year)
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NYR Option Set
An Option Set is a selection of schools, and a set of files to create or copy 
to a new school or year. Add a new Option Set for each set of schools with 
different files to create or copy by modifying the License file.

NYR Option Set – Non-Student Files

Perform the tasks in this section at the District, and verify you have 
exclusive use of the District datafiles.

Note: The SASIxp software automatically creates the ATBL and ASCF 
files when running the Create Non-Student option of the NYR process.

Step District Procedure (Current Year)

1. New Year Rollover atom, Process Options screen

Note: Complete this step once before rolling over the first 
student.

1. Open the New Year Rollover atom.

2. From the Data pull-down menu, select Add Option Set.

3. In the Option field, add the process title. For example, 
Non-Student.

4. In the Current School Year field, select the current 
school year. For example, if the current school year is 
1999-00 and the new school year is 2000-01, the year to 
select is 1999-00.

5. In the School Type section, select School is Connected 
to District via WAN.

Note: School is connected to the District via WAN = Using 
District Integration.

School is not connected to the District via WAN = Not 
using District Integration.

6. In the Process Options section, select Create Non-
Student Files.

7. Click Save. 
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2. Create Non-Student Files screen

1. Select Create Non-Student Files from the Screen 
Selection field.

2. In the Selected Schools to Process matrix, click the 
Select Schools Fast Access arrow to select schools.

3. Select all schools.

4. In the Selected Non-Student Files matrix, click the Select 
Files Fast Access arrow to select files.

5. Select the file codes to process. 

6. Click Done.

7. Click Save.

Step District Procedure (Current Year)
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NYR Option Set – Graduate Students

When processing this Option Set, place a graduation date in the Grad 
Date field on the Page 2 tab of the Student atom. With these dates in the 
Student file, the seniors will not appear on the New Year Rollover log when 
the Student Files Option Set runs. These dates will only be in the mirror 
files and will not affect the files at the school sites. 

Perform the tasks in this section at the District server, logged into the 
Archive school in any year.

Step District Procedure

1. New Year Rollover atom, Process Options screen

1. Open the New Year Rollover atom.

2. From the Data pull-down menu, select the Add Option 
Set.

3. In the Option field, add the process title. 

4. In the Current School Year field, select the current 
school year. 

5. In the School Type section, select School is Connected 
to District via WAN.

6. In the Process Options section, select Graduate 
Students.

7. Click Save. 

2. Graduate Students screen

1. Select Graduate Students from the Screen Selection 
field.

2. In the Selected Schools to Process matrix, click the 
Select Schools Fast Access arrow.

3. Select all of the high schools. 

4. Click Done.

5. Enter the graduation date for each school in the 
Graduation Date field.

6. Click Save.

Note: Graduate Student only refers to the high school.
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NYR Option Set – Student Files

In the District Control atom verify there is a District Inactive School in the 
District Options.

Perform the tasks in this section at the District Server, logged into the 
Archive school in any year.

Perform the tasks in this section at the District Server, logged into the 
Archive school in any year.

Note: The SASIxp software automatically creates the AENR and ASTU 
files when running the Update Student File option of the New Year 
Rollover process.

Step District Procedure 

1. New Year Rollover atom, Process Options screen

1. Open the New Year Rollover atom.

2. From the Data pull-down menu, select the Add Option 
Set.

3. In the Option field, add the process title.

4. In the Current School Year field, select the current 
school year. 

5. In the School Type section, select School is Connected 
to District via WAN.

6. In the Process Options section, select Create Student 
Files.

7. Click Save.
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2. Update Student Files screen

1. Select Update Student Files from the Screen Selection 
field.

2. In the Selected Schools to Process matrix, click the 
Select Schools Fast Access arrow.

3. Select the schools to process with the necessary Option 
Sets. 

4. The schools you select will be processed with this Option 
Set.

5. Complete the following:

! Enter the first apportionment date for the new school 
year in the Effective Date field.

Note: When choosing effective dates first check with the 
state code for any requirements. If the state does not 
have start date requirements, Pearson School 
Systems recommends the effective date be one week 
before school.

! Select the Enter Code.
! Select the Transfer Code.

6. In the Selected Student Related Files matrix, click the 
Fast Access arrow to Select Files.

7. Select the file codes to process. 

8. Click Done. 

9. Select the Parent/Guardian file (APRN) and Locker 
Assignment file (ALKA) to transfer the data to the new 
year. When opening the Student atom in the new year, if 
this information did not transfer during the New Year 
Rollover, the SASIxp software displays this message:

File does not exist, would you like to
create it? 

Note: If it is created at this time, it will not transfer the data 
over from the previous year.

10. Click Save.

Step District Procedure 
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Mandatory Steps
Complete these steps:

1. Manually upload all files, excluding the Pictures file:

! Open the District Apps folder, District Setup folder, and District 
Control atom.

! Select the Upload/Download Files tab.

! Click Save.

2. There cannot be any errors to proceed. If any errors occur, query the 
AONL file to find the errors and correct them. Re-upload and complete 
these steps:

! Open the District Apps folder, District folder, and Create/Update 
District atom.

! Select Create District Option. 
! Select the Update District Owned option.
! In the Creating for field, select Year of.
! Select the current school year.
! Click the Select Schools Fast Access arrow.
! Click Add All, then remove central enrollment, summer, and 

consolidated schools from the list.
! Click Update.

3. After the Update Process, review the DSTERR file in the SASIxp 
Datafile to verify the data updated properly.

Note: Before starting the first NYR, insure the Upload Override 
Options are set to Upload All Files and the Upload Year is set to 
Current Year. Perform the upload without errors before starting the 
NYR.

Note: When completing subsequent NYR on future dates where 
school sites already added or modified new students in the next 
year, insure the Upload Override Options are set to Upload All 
Files and the Upload Year is set to All Years. 
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Processing the Option Sets

Pearson School Systems recommends a District roll over a file for all 
schools and create new for schools not moving student data. 

For example, six schools are rolling over Master Schedule (AMST), and 
one school does not. Roll over Master Schedule for all schools and 
recreate the AMST file for the one.

Perform the tasks in this section at the District Server, logged into the 
Archive school in any year.
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Step District Procedure

1. Turn off all Task Servers.

2. Processing Non-Student files

Note: You must perform this Option Set prior to running the 
following Option Sets once for each school. 

Before processing each Non-Student Option Set, modify the 
license file to accommodate the schools and files to process.

1. Select each new Option Set for the Non-Student Files, for 
example, Non-Student.

2. From the New Year Rollover pull-down menu, select Run.

This process completes when the message bar in the 
lower left corner of the SASIxp desktop no longer 
displays.

3. Review the NYR Log file.

3. Processing Graduate students 

Run this Option Set once. 

1. Return to the new Option Set for the Graduate Students.

2. From the New Year Rollover pull-down menu, select Run.

This process completes when the hourglass disappears.

4. Processing Student files 

Before processing each Student Files Option Set, modify the 
license file to accommodate the schools and files to process.

1. Return to each new Option Set for the Student Files.

2. From the New Year Rollover pull-down menu, select Run.

Note: The process completion time may vary depending on 
the number of schools and files to process.

3. Review the NYR Log file.

Note: After completing additional rollovers and before the District 
moves files down to the school sites, Pearson School Systems 
recommends all school sites do a backup of the new year data. This 
step ensures the original data can be replaced, if necessary.
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Moving Qualified Files to Individual Schools 

Choose one of the following processes to copy or transfer the new year 
data to the school sites.

Step District Procedure – Process 1

1. Datafile at the District

1. Shut down the Task Server before copying the qualified 
files down to the individual schools.

2. Copy all the qualified files from the District datafile to the 
individual schools. For example, ASTU9991, AENR9991, 
and so on to the datafile folder of each school.

Note: This step enables individual schools to view the new 
year’s data on their own servers.

3. Copy all schools’ new files down to the individual school 
sites at the same time.

4. Turn the Task Server back on after copying the qualified 
files down to the individual schools, or perform Step 2.

2. District Control atom

1. Open the District Control atom.

Note: You can also use the download process to transfer the 
new year data to the school sites. See District Control 
Download on page 247.

2. In the Upload Override Options section, change the 
Upload Year to the current school year.

3. Click Save. 

4. After making the modifications in Step 3, quit and restart 
the Task Server software. The Task Server starts in 
transfer student mode.
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NYR Option Set – Update Course History Only

Run this Option Set after the last marks transfer to Course History in the 
current school year. It appends to and makes any mark changes to the file 
that already exists in the new year. 

Step District or School Site Procedure 

1. Perform an upload of all sites from both this year and next 
year before starting Step 2.

2. New Year Rollover atom, Process Options screen

1. Open the New Year Rollover atom.

2. From the Data pull-down menu, select Add Option Set.

3. In the Option field, add the process title.

4. In the Current School Year field, select the current 
school year. 

5. In the School Type section, select School is Connected 
to District via WAN.

6. In the Process Options section, select Create Student 
Files.

7. Click Save.
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.3. Update Student Files screen

1. Select Update Student Files from the Screen Selection 
field.

2. Select Update Course History checkbox, then select 
Update Course History Comments checkbox.

3. In the Selected Schools to Process matrix, click the 
Select Schools Fast Access arrow.

4. Select all necessary schools.

5. Click Done.

6. Complete the following:

! Enter the first apportionment date for the new school 
year in the Effective Date field.

! Select the appropriate Enter Code.
! Select the appropriate Transfer Code.
! Leave the Assign New Numbers field blank to keep 

the current Student IDs. 

Note: If your school does not use unique permanent IDs and 
you select Y in the Assign New Numbers field, the 
Assign New Numbers field retains the Y when you 
run subsquent rollovers.

7. Click Save.

Step District or School Site Procedure 
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NYR Option Set – Graduate Students

Run this Option Set after the current year has ended and all retained 
students have their grade level changed at the high schools. The first 
process enters the graduation date in the Grad Date field in the Student 
atom for all students who are in the highest grade level. This date prints on 
the transcript as the graduation date. This process does not move a 
graduating student to the Archive school.

4. Processing Update Course History

1. In the new school year, open the Backup/Restore atom.

2. Select ACHS to back up and continue with the backup 
process. This step ensures there is always a good copy 
of the file.

Note: Take the Task Server off-line to process the ACHS file.

3. Return to the new Option Set for the Student files.

4. From the New Year Rollover pull-down menu, select Run.

5. Review the NYR Log file.

6. If the process is done at the District, copy the ACHS and 
ACHN files to the necessary school sites. See Moving 
Qualified Files to Individual Schools on page 191 for the 
process to copy the files down to the school sites.

Step District or School Site Procedure 

Note: Only select high schools for processing with the Option Set for 
Graduate Students.



Copyright © 2005 Pearson School Systems Mandatory Steps  195

New Year Rollover

Step School Site Procedure

1. New Year Rollover atom, Process Options screen

1. Open the New Year Rollover atom.

2. From the Data pull-down menu, select Add Option Set.

3. In the Option field, add the process title.

4. In the Current School Year field, select the current 
school year.

5. In the School Type section, select School is Connected 
to District via WAN.

6. In the Process Options section, select Graduate 
Students.

7. Click Save.

2. Graduate Students screen

1. Select Graduate Students from the Page Selection field.

2. Click the Select Schools Fast Access arrow.

3. Select all high schools. 

Note: Do not select the Archive school.

4. Enter the graduation date in the Graduation Date field.

5. Click Save.

3. Processing Graduate Students

From the New Year Rollover pull-down menu, select Run.
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Files to Process
The values in the CreateNew column are the defaults in the License file 
(ALIC). 

An ’X’ in the Create New Flag column indicates the file is blank when the 
file rolls. A blank in the Create New Flag column indicates data copies 
from the previous year, when the file rolls over.

Files

Note: Use the Query atom to modify these files as necessary. 

Non-Student Files

Create 
New 
Flag Student Files

Create 
New 
Flag

AATC – Calendar X AATD – Daily Attendance X

AATO – Attendance Options X AEMG – Emergency

AATR – Attendance Reasons AHLN – Home Language

ADVA – Vaccination Descriptions AHLT – Health

AEPD – Enrollment Process Def. AIMM – Immunization Vaccinations

ASH3 – User Reports AMED – Medical

ATCH – Teacher APRN – Parent/Guardian

ASCR – Medical Screening Info

ASGR – Student Groups

ACRS – Course ACLH – Class History X

AMST – Master Schedule ACLS – Class Schedule X

ATCD – Teacher Course Def.

AGCD – Grading Control Definition AATP – Period Attendance

AGCL – Grading Control ACET – College Entrance

AGCM – Grade Comments ACHN – Course History Narrative
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AGCR – Credit Definition File ACHS – Course History

AGDF – Grade Reporting Definition AGRD – Grade Reporting X

AGED – Eligibility Definition AGRH – Grade Reporting History X

AGHD – Honor Roll Definition AGRL – Grade Reporting Detail X

AGMK – Marks Definition AHRT – Temporary Honor Roll Def

AGPA – GPA Definition ASSS – Student Course Requests X

AGPL – GPA Definition Detail ALKA – Locker Assignment

AGRP – Grade Reporting Periods X ASGR – Student Groups

AGRA – Grade Rpt Additional 
Attend

X

ALKR – Locker

AREQ – Graduation Requirements

ARTD – Repeat Tag Definition

ASMA – Scheduling Mass Assign

ASMS – Scheduling Master 
Schedule

ASMT – Seat Totals X

ASOP – Scheduling Options

ASSD – Scheduling Control 
Definition

ASSL – Scheduling Control

ASSO – Course Request Options

ASST – Seat Totals

ASSX – Course Request Cross Ref

ATDF – Transcript Definition

Non-Student Files

Create 
New 
Flag Student Files

Create 
New 
Flag
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AADD – Discipline Descriptions ACNF – Conference

AADR – Name and Address ADIS – Discipline

AATB – Attendance Bell Schedules AFEE – Fees

ACNR – Conference Description AGAD – Gate X

ACPR – Classroom Preference X ANOT – Notes X

ADMS – Message Description APMT – Payments

AFID – Fee Definition APRF – Proficiency Test Scoring

ALSE – Student Entry Definition APRG – Progress Reporting X

ALSL – Student Entry Def Line ASPE – Special Education

APCD – Progress Control Definition ASRD – Student Recognition 
Detail

APCL – Progress Control ASRM – Student Recognition 
Master

APRD – Proficiency Testing 
Definition

ASTR – Standardized Test 
Response

AROT – Period Rotation/Sched 
Cycle

ASTS – Standardized Test Scoring X

ASEA – Seating X AVOC – Vocation Education

ASTA – Standardized Test Admin X

ASTC – Standardized Test Controls X

ACLR – Course Link Relation

ACRA – Course Room Allocation

ACTA – Course Teacher Allocation

ACTR – Course Restriction & 
Allocation

Non-Student Files

Create 
New 
Flag Student Files

Create 
New 
Flag
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Tips and Explanations

Undoing a Failed Rollover

1. Delete all files for next year at the school sites and the District mirror 
datafile. Clear out ANYL, and modify or recreate the option sets 
(contained in ANYC). 

2. Recreate ADST, leaving out next year to empty the status info buckets.

ADUR – Duration Starting Term

AGSS – Global Scheduling Specs

AGTR – Global Time Restrict/
Allocation

AMDP – Meeting Day Patterns

ARLD – Rules List Definition

ARLL – Rules List Detail

AROD – Scheduler Report Option

AROM – Room File

ARSD – Scheduler Report Set

ARSL – Scheduler Report Set List

ARTR – Room Restrictions & 
Allocation

ASCS – Student Scheduling Status

ASIM – Simulation Options

ASLR – Section Load Restriction

ATTR – Teacher Restrictions & 
Allocation

Non-Student Files

Create 
New 
Flag Student Files

Create 
New 
Flag
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3. Modify NextSchool and NextGrade fields at the school sites if 
necessary, and upload the changed ASTU files.

Rollover can double the amount of disk space usage. Available disk 
storage space also plays a key role in New Year Rollovers.

Use this logic to determine whether to create files in the new year or to 
copy last year’s data. 

If a file you select to process in the rollover does not exist in the current 
year, an error is written to the NewYear.log file and the file is created for 
the new year. Because there is no data to copy, the SASIxp software 
creates an empty file.

Non-Student File Rollover Tips

! Non-student files must be processed first. If ASCF or ATBL files are 
missing from both the source year and target year, rollover will stop. 

! After running the non-student option, you can update Next IDs if 
schools are running out of Stulinks. Stulink is a 5-digit field, so there is 
an effective limit of 99,999. 

! Non-student copies Next ID and does not copy new.
! Set the Next ID and Scan Sheets back to 1 before rolling the first 

student. 

Note: This fix should not be done if students have transferred in the 
New Year or if New Year files have been modified. 

Is the file in the 
option set? Is it in ALIC?

If applicable, read the 
ALIC CreateNew flag.

Will the file be 
created in next 

year?

No Ignored N/A No

Yes No N/A Create empty file.

Yes Yes CreateNew is No (“ ”) Create and copy 
last year’s data.

Yes Yes CreateNew is Yes (“X”) Create empty file.
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Student-Related File Rollover Tips

! Process students who are concurrently enrolled, or enrolled in 
Summer schools at their home schools only. For example, if a high 
school student has a home school number 200 and takes an advanced 
math class at another high school number 300, the records do not roll 
forward to the next year at the concurrent school, number 300. The 
student file rollover process looks at the active school listed on the 
Status Info tab of the District file. The student rolls over for this school 
only.

! ANYL is a New Year Rollover log file for recording the results of school 
processing during the Update Student Process option. It is a DBIV file, 
even if the system is using Oracle or MS SQL Server. This file is 
defined as follows:

! Option sets are controlled by the source school. They represent the 
files chosen at the originating school, not the files requested by 
particular destination schools.

! Use the Scho Tfrt option in the File Definition Pro atom, for each field in 
any file. This option indicates whether fields defined or updated in the 
current year will be rolled over to a student’s new school in the next 
year. If the Schl Tfrt field is set to Y, the specified field will always be 
updated during New Year Rollover. If the option is set to N, the field will 
not be updated for students being rolled into a new school for next 
year. It will still be updated for students moving to a new grade in the 
same school.

! When performing subsequent rollovers on student files, Stulinks are 
preserved for each student. 

Field

Status

Option_Name

Schl_Name

Start_Date

Start_Time

Finish_Date

Finish_Time

Finish_Status
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Question: 

If a student has transferred around the District, for example attending 3 
different schools, and those 3 schools are in 3 different groups set up for 
NYR being run at 3 different times, how does the program know to wait 
until it gets to the most recent transaction to put the student in the right 
place for the new year?

Answer: 

NYR only moves records from the school where the student is currently 
enrolled according to the ADST file. It avoids moving outdated, inactive 
records.

Transfer Course History Process

During the Update Course History process, the Schools Attended History 
file (ASAH) is updated with new information.

Post-Rollover Operations
! After performing a New Year Rollover, if a new student is added to a 

school, the system will prompt you to enroll the student in the new year 
as well. 

! After an initial student rollover, when inactivating a student in the 
current year, the following message displays:

A New Year Rollover has already been generated. Do
you want to no show this student for the next year?

If you select Yes and the student will attend the same school in the 
new year, the student’s enrollment is inactivated in the current year 
and no showed in the new year. If Yes is selected and the student will 
be attending another school in the new year, the student’s records is 
inactivate for the current year only. Student records for the new year at 
the new school will not change.

! Update the District Year field in the District Control atom after all work 
in the current school year is complete. For example, school year is 
1999-2000, the final rollover is complete, and students course history 
carries forward to the new year. District year can now change to 2000, 
and you will no longer modify data in the 1999 year.
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! After the final rollover is complete and you have been instructed to use 
the next year when working in the SASIxp software, it is possible to 
identify when users change files for the last year. Configure the 
SASIxp software to upload all years of data and run the following 
query:

Display ADPS all IF Year=1999 AND UploadDate >'06/05/00'

Where 1999 is the previous year and 06/05/00 is the date of the final 
rollover. If the query returns records, query AUFS and AONL to 
discover which previous year files were modified.

Process Changes

Non-Student Rollover Process Changes

When Non-Student files roll over, the Sequence Control file (ASCF) is 
included automatically. This file stores the displaying data in the Next ID 
atom. 

Stulinks start over in the new year with the next highest value. For 
example, use Stulinks 1–500 in the current year at a school; after the 
rollover next year’s Stulinks begin at 501. If data is improperly copied to 
the New Year, the records do not match with any students because 
Stulinks do not overlap. 

Student Rollover Process Changes

Effective Dates and Codes

If a feeder school pushes students to a target school that is not a feeder 
school, the Effective Date, Enter Code, and Transfer Codes information 
from the feeder school will be used when adding the student to the target 
schools. Normally, if a student is transferring schools, the effective date for 
the target school is used for all incoming students. However, if the target 
school, as specified in a student Next School field, is not a selected 
school NYR, the system must assume it can use the same values as the 
feeder school. 

All schools with varying values for these fields must be selected in the 
Update Students Files screen of New Year Rollover atom, and the proper 
values supplied. 
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New Year Rollover can now resume from the last school in case of an 
interruption.

The Update Student process keeps a log of schools processed. The 
process flags the time it started processing a school, and the time it 
completes processing a school. If the process is interrupted, and then 
restarted, use this log to determine if a previous run completed or not. If 
the log indicates the process was interrupted, you are prompted to 
continue with the previous run or to start over. You are also prompted to 
run Checkdata regardless of whether you choose to re-run the entire 
process or continue with the previous run. If a corrupted file is located, 
repair it before running Update Student again. 

In case of an interruption, you are prompted to run Checkdata, and cancel 
the process or continue. After you verify the files’ integrity with Checkdata 
and has choose to continue a previous run of the Update Student process, 
the process skips all schools flagged with a completed time stamp, and 
processes all schools with no time stamp. It then processes schools in the 
Update Student selection matrix but not in the log.

You can choose to restart the process or continue.

! If you choose to Continue, the Update Students process looks through 
the ANYL log and processes only schools not having a finish code of 
Complete. If a school has a finish code of Processing, it is processed 
from the beginning as if it had a blank code.

! If you choose to Restart, the Update Students process clears all values 
from the finish code record for every school, and processes every 
school for this Update Students.

Caution:

If you choose to Continue with a previously incomplete process run is if 
data for a school has changed since the last run, and the school completes 
the process in the last run, modified data for students in the school will not 
update to the next year. 

! The Continue option is primarily intended for immediately re-running a 
process recently interrupted. 

Graduation Process Changes

The Graduate Students process in New Year Rollover in previous versions 
of the SASIxp software considered the last grade on the Grade Levels 
Taught field to be the graduating grade. Some schools have extra grades 



Copyright © 2005 Pearson School Systems NEWYEAR.log file Messages  205

New Year Rollover

on this field after the true graduating grade, usually 12. The Graduate 
Students process now considers the first grade in which the corresponding 
Promote Grade Level to field is blank; for example,

Grades Taught: 09 10 11 12 UN

Promote to: 10 11 12 

In this example, the Graduate Students process would consider 12 as the 
graduating grade, and would populate the Graduation Date field of the 
ASTU file for all 12th graders. Because the promote to field for UN is not 
the first blank promote to field, it is not processed as a graduating grade. 
You should ensure there are no blank promote to fields other than the 
grade you intend to graduate.

NEWYEAR.log file Messages
The following list contains messages appearing in the NewYear.log file and 
possible causes:

! If there is a problem of any kind opening the ANYL Student Update 
Log, the system will abort the New Year Rollover process. Problems 
could include another user who has an exclusive lock on the file, or the 
system does not have enough memory to open the file. The following 
message is written to the NEWYEAR.log text log:

Encountered problem initializing the ANYL log file,
aborting Student Transfer process

! If you restart a NYR Update Student’s process that was previously 
interrupted before completion, the following message is placed in the 
NEWYEAR.log text log:

The previous process was interrupted…

Run the check data utility and fix any errors before
you continue.

! If you chose to cancel the NYR Update Students process as a result of 
a dialog about a previously interrupted process, the following message 
is placed in the NEWYEAR.log text log:

User chose to cancel the Transfer Student process.

! If this is the first time a particular NYR Update Students Option has 
been run, or schools have been added to the option since the last run 
of a particular option, the following message is written to the 
NEWYEAR.log text log:
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Adding school <500> to the New Year Rollover Schools
Updated Log (ANYL).

! If schools have been removed from a particular NYR Update Students 
Option since the last time the option has been run, the following 
message is written to the NEWYEAR.log text log:

Removed school <500> from Schools Updated Log
(ANYL), it is no longer processed as part of this
Update Students option.

! If you chose to continue with a process that was previously 
interrupted before completion, the following message is put in the 
NEWYEAR.log text log:

User chose to "CONTINUE" with previous Transfer
Students process, previously processed schools will
be skipped…

! If you chose to restart a process that was previously interrupted before 
completion, all schools will be processed again regardless if 
completion status when interrupted, the following message is put in the 
NEWYEAR.log text log:

User chose to "RESTART" the entire Transfer Students
process, all schools will be processed.

! During the NYR Update Student processing, some schools may be 
skipped because they completed during a previously interrupted 
process. If you chose to continue with that previous process, when the 
process encounters a school that should be skipped, the following 
message is put in the NEWYEAR.log text log:

Skipping School <500>, it completed processing
during the last run of this NYR option.
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Additional Information
! Error –2035 on one student causes all subsequent students to be 

skipped with same error. In this case, updating all Next IDs at the 
school returning the error in the next school year clears and processes 
all students in the next immediate rollover.

! Errors on students where Next School or Next Grade does not exist 
are reported in the log. If all these errors pertain to seniors, ignore the 
errors. Seniors did not carry into the Archive school because 
Graduation Date in the student file is missing. 

! If the students are not seniors but are the highest grade level at your 
District, the same graduation rule applies.

! If the students move to another school, Elementary to Middle school or 
Middle school to High school and the list is short, use the Enrollment 
atom at the School site to Cross-Year enroll the students who missed 
the rollover. Re-run an Option Set, which includes only the school after 
having made corrections in the Next School, Next Grade fields of the 
Student atom for all students who appear in the NewYear.log file list.

! Run the non-student files before student files process once. 
! After processing New Year Rollover once for the new school year, the 

Status Info screen of the District atom populates with next year’s 
information. Changing the Next School field or the Next Grade Level 
in the Student atom and running New Year Rollover again will not 
transfer the student to the new school or change the grade level. The 
student must be no-showed and transferred to the new school, or the 
grade change will have to be made manually.

! New Year Rollover, for the student files, can run as many times as 
necessary after a successful upload and update without any errors at 
the District server. Each time it runs, it updates the ASTU and AENR 
files and makes any demographic changes (addresses and telephone 
numbers). Add a new Option Set to update the demographics for 
ASTU and AENR. Pearson School Systems recommends the 
individual schools do a complete backup of the new year school files 
before copying the qualified files down to the site.

! After starting the course request input in the new year, do not roll over 
the files associated with scheduling (ASSS, ASMS, ASMT, ASOP, 
ASSD, ASST, ASSX, ASMA, ASSL, and ASSO). 

! Do not roll over files for the new year until the new school year begins 
(ADIS, AHLT, AIMM).

! When selecting the files to process, Pearson School Systems does not 
recommend selecting the Add All button. Do not create files your 
school does not use.



208  Additional Information Copyright © 2005 Pearson School Systems

New Year Rollover

! Add Option Sets to the rollover of single schools for scheduling 
purposes. For example, high schools can roll over the students 
enrolled in their school to start the scheduling process.

! When enrolling a new student in the current school year after doing the 
new year rollover process, there will be an option to enroll the student 
into the next school year. Enter the appropriate Enter Date and Enter 
Code and click OK. If the student is in the highest grade level of the 
school or will be attending a different school in the next school year, go 
into the next school year and cross-year enrollment of student.

! Only make changes to demographics of existing students to the 
current school year. The New Year Rollover process transfers the data 
to the necessary school year.

! For information to copy from the previous year, select the Locker file 
(ALKR) as a file to process in the Option Set to run for Non-Student 
Files.

! For information to copy from the previous year, select the Parent/
Guardian (APRN) and Locker Assignment (ALKA) files to process in 
the Option Set to run for Student Files.

! For the Graduate Option Set to process correctly, there must be a 
Graduation Code defined on the Enrollment screen in the School atom. 

! The Grad Date field populates in the mirror files for the current year 
only when the Graduate Option Set is processed. These dates are not 
seen at the school sites. With these dates in the Student file, the 
seniors do not appear on the New Year Rollover log when the Student 
Option Set runs.

! A District Inactive School is defined in The District Control atom for 
students to transfer to the Archive school.

! All schools, including new schools for the new year and the Archive 
school, must have the Table (ATBL) and Sequence Control (ASCF) 
files for the current school year.

! Update Next IDs in the new year before and after subsequent 
rollovers.

! Do not update any existing student records in the new school year. 
Always make the changes in the current school year. 

! The Archive school is a qualified school like all other schools. The files 
are the same as the other schools.

! All schools in the district school file are considered as possible target 
schools and are automatically considered in all Option Sets.
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! Codes display in the Leave Code field of the Status Info screen in the 
District atom after the rollover process: 
! Inactive = +
! Graduate = –
! No Show = *

! Process the Archive school prior to processing all of the other schools 
for both non-student and student files. 

! Verify all grade levels are valid in the District file.
! Verify all grade levels and promote to grade levels are correct for each 

school.
! The Schools Attended History (ASAH) file automatically creates when 

doing the rollover, provided an ASAH file exists for the current school 
year. The data in the current file transfers to the new year. 
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Use this section for creating and setting up the files for summer school 
using the Summer School atom. These processes are for schools using 
District Integration to connect to the district office. Complete all steps in the 
appropriate school year. 

Before You Begin
Complete these tasks before setting up a summer school:

! Read the entire chapter before attempting to set up a summer school.
! Verify all of the file definitions in use at the district are the same as the 

summer school file definitions.
! Verify all schools are using the same version of the SASIxp 

educational software.
! Verify you log into the correct school year.
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Summer School Site Setup
Use this atom to set up the school site summer school in the year the files 
will roll toward. 

1. Open the School atom.

2. From the Data pull-down menu, select Add School.

3. Complete the School Name and School Abrv fields. 

4. In the District field, select District Processing.
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5. Select the General tab.

6. Complete these fields:

! Grade Levels Taught 
! Periods Begin
! Periods End
! Attendance Type 

Note: To use the Summer School Attendance report, set the 
Attendance Type field to Period.
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7. Select the Schedule tab.

8. Complete these fields:

! School Type 
! Gen. Section ID 
! Term Type 
! Section ID Length
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9. Select the Enrollment tab.

10. Complete these fields:

! Effective Date
! Leave Date
! No Shows
! Default Enter Code
! Default Leave Code 

11. Click Save.

12. From the School pull-down menu, select Change School # and Name, 
and enter the school number for the summer school. 

13. Click Save.

Note: You can add an enter code for summer school after 
creating the Table File.

Note: Do not use the summer school number for any other 
school in the district.



216  Summer School Site Setup Copyright © 2005 Pearson School Systems

Setting Up Summer Schools

14. Select the Term Duration tab.

15. Enter the Term Title in the Title field. 

16. Complete these fields:

! Starting
! Ending
! 1, 2, 3, 4, 5, and 6 (Term Code)

17. Click Save.

Note: The number of terms is defined in the Term Type field on the 
Schedule tab.

! Year Schedule—1 Term (YR)
! Semester Schedule—2 Terms (YR, S1, S2)
! Quarter Schedule—4 Terms (YR, S1, S2, Q1-Q4)
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18. Select the Localization tab.

19. Select State, Province, or Country in the Localization field.

20. Click Save.

Note: For the School atom field definition information, see the 
SASIxp™ Basic Applications Guide.
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District Site Setup
Add each summer school to the School file at the district site.

1. Open the School atom. 

2. From the Data pull-down menu, select Add School.

3. Set up the summer school the same way you set it up at the school 
site. The only difference is that both the school site and the district site 
share the same School atom information for a summer school. 

4. Set the District field to Local Processing.

5. Click Save.

6. From the School menu, select Change School # and Name and enter 
the school number for the summer school. 

7. Click Save.

8. Open the District Control atom and select the School Info Tab.

9. In the School Type column, select Summer for all schools holding 
summer school.

10. Click Save.
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11. Select the Sub Files tab.

12. In the Sum Schl column, select Yes for each subfile. 

13. Click Save.

Creating Non-Student Files
Create non-student files after logging into the summer schools for the 
appropriate school year at the district site.

Note: If you select Yes, the files transfer during future enrollment 
transactions.

Note: For additional information on the District Control atom, see 
Setting Up the District Control File on page 81.

Note: If the summer school is created using Next Year Summer School 
option, the school year is relative to the current school year.
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1. Open the Create New Files atom.

2. In the School Name field, select the summer school.

3. Select the Show all file names checkbox.

4. Before rolling the students into the summer school, create these files:

! ASCF – Next ID Definition (Sequence Control File–subfile of 
Table Definition)

! ATBL – Table Definitions
! AEPD – Enrollment Definition (sub file of Student)

5. Create the following non-student files:

! AMST – Sections (if using Basic Scheduling) or ASMS – 
Scheduling Sections (if using Mass Scheduling)

! ACRS – Course
! ATCH – Teacher
! AATO – Attendance Options
! AATC – Attendance Calendar
! AATR – Attendance Reasons

Note: Create these files at this time or after enrolling students into 
the summer school.
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! AATB – Bell Schedule
! ALKA – Locker Assignments

6. Click Create.

Preparing Feeder School Files
1. Open the Student atom at the school site, and select the Page 2 tab.

2. For all students attending summer school, enter the summer school’s 
number in the Summer School field.

3. Click Save.

Note: For the School atom field definition information, see the 
SASIxp™ Basic Applications Guide.
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Manual Upload of Files

Perform a manual upload of all files, excluding the pictures file. It is crucial 
to ensure a clean, complete upload before processing the summer school. 

1. Open the District Control atom from the District Setup folder, which is 
in the District Apps module.

2. Select the Upload/Download Files tab.

3. In the Upload File List section, select the Exclude option button.

4. Select the fast access arrow below the Upload File List section to add 
a matrix line in the Upload File List section.

5. Click in the new line and select PICT-Pictures.

6. Insure the Upload Override Options field is set to Upload All Files 
and the Upload Year field is set to the current year.

7. Click Save.
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8. If there is an error, query the ADPS file to detect the error and correct 
it.

9. Repeat Steps 1–8 until all errors are corrected. 

10. Shut down the Task Server before processing the Summer School 
option.

Processing Feeder Schools Into the Summer School
1. At the district office, log into the summer school.

Note: Query the district SASIxp log files (ADPS, AUFS, AONL) to 
verify the upload. The ADPS file should have one record per school 
and year of data. The Upload Status field should display 
SUC_AND_MOVED with the appropriate upload date for the 
current year files in every school. In addition, AUFS and AONL 
should not display any failures (Level Code F) associated with 
current year files for the last upload. All upload folders should be 
empty, indicating the files successfully moved into the district 
SASIxp datafile folder.

Note: When creating a summer school as a current year school, select 
Update Current Year School when updating the feeder school. When 
creating a summer school as a next year school, select Update Next 
Year School when updating the feeder school or the school the student 
will be attending in the next year.
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2. Open the Summer School atom, which is located in the File 
Management module.

3. In the Type of Processing section, select the District option button.

4. In the Process section, select the Create Summer School option 
button.

5. Below the Summer Schools to Process matrix, click the Select 
Schools fast access arrows to select the summer schools.

6. In the Enter Date column, enter the start date for summer school.

7. In the Enter Code column, select the enter code to use for summer 
school.

8. Below the Feeder Schools to Process matrix, click the Select Feeder 
Schools fast access arrow to select schools to process for the 
summer school.

9. Below the Student Related Files matrix, click the Select Files fast 
access arrow to select files relating to the students to use for summer 
school.
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10. Click Process.

11. After running the process, check the SUMMER.LOG to review any 
errors that occurred during the process. Locate the log in the Datafile.

Summer School Options

Type of Processing

Process

Note: When this process runs, students with one of the specified 
summer school numbers in the Sum Schl field in the student atom 
are transferred to that summer school.

Option Description

District Summer school processing at the district 
level.

Local Summer school processing at the individual 
school site.

Option Description

Create Summer School Rolling students into summer school, along 
with any additional optional files.

Update CHS Updating student course history at feeder 
schools at the end of summer school.
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Grade Selection

Option Description

Default Checks the NxtGrd field from the Student 
atom, Page 2 tab.

! If the NxtGrd field is populated, the new 
grade level is the value in the NxtGrd 
field.

! If the NxtGrd field is blank, the new grade 
level is the value in the Grd field from the 
Student atom, Page 1 tab.

Next Grade ! Only students with a value in the NxtGrd 
field will be processed, and the new 
grade level is the NxtGrd field value.

! When the NxtGrd field is blank, an error 
log entry with the student’s ID, name, 
current grade level, and a message 
indicating the student does not have a 
next grade value is created.

Current Grade New grade level is the value in the Grd field 
from the Student atom, Page 1 tab.

NextGrade NYR ! New grade level is the value in the 
NxtGrd field from the Student atom, Page 
2 tab.

! When the NxtGrd field is blank, the new 
grade level is the value defined in the 
Promote Grade Level to field from the 
School atom, General tab.
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Summer School Year Selection

School Time Line

Moving Qualified Files
Choose one of the following processes to copy or transfer the summer 
school data down to school sites.

Process 1

1. Open the datafile at the District.

2. Shut down the Task Server before copying the qualified files down to 
the individual schools over the WAN.

Option Description

Next Year Summer 
School

Summer school records update to the new 
year.

Current Year Summer 
School

Summer school records move to the school 
year just completed.

Note: When rolling files back to the feeder schools, all records in the 
file are appended to the feeder school file. Duplication of records can 
occur if the file was originally rolled into the summer school.
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3. Copy all the qualified files from the district datafile to the individual 
schools. 

4. Copy all schools new files down to the individual school sites at the 
same time.

5. After coping all qualified files to the individual schools, log into the Task 
Server.

6. Set the Task Server to transfer student mode.

Process 2

1. Open the District Control atom.

2. Use Process 1 to move the qualified files down to the school sites.

3. In the Upload Override Options section, modify the Upload Year field 
to the next school year. 

4. Select the Upload/Download tab.

5. Select the fast access arrow below the Download File List section to 
add a new matrix line to the Download File matrix, enabling you to 
include a file in the download process. Repeat this step until you define 
all the download files.

6. Click Save.

Task Server Procedure

1. Open the Task Server application.

2. From the Tasks pull-down menu, select Download to Remote Sites. 

Note: Individual schools can then view the summer school data on 
their server.

Note: Before using this process, add campus records to the Campus 
atom for the summer school sites. If the summer school data is not 
uploaded to the district, remove the campus records for the summer 
schools from the campus atom.

Note: This option temporarily disables real-time operations of the 
Task Server.
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District Procedure

1. Open the District Control atom.

2. Change the Upload Year to the appropriate school year in the Upload 
Override Options section. 

3. Select the Upload/Download tab and remove the files from the 
Download Files List. 

4. Click Save. 

5. Quit and restart the Task Server application and set it in transfer 
student mode.

Preparing Course Files
If you use the Summer School Attendance Summary report (ATP60), 
setup courses and tables to use the course file to correctly calculate 
apportionment minutes. Perform these procedures at the School site:

1. Open the Table Definition atom, which is in the System Setup module.

Note: The Upload Year is related to the Creation Year selection.

Note: This option enables real-time operations of the Task Server.
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2. Select the APC (Apportionment Category) table type.

3. Click Add.

4. Add one code and description for Proficiency and one code and 
description for Core.

5. Select the CRT (Course Type) table type.

6. Click Add.

7. Add the types of courses the summer school will be offering. 

8. Click Save.

9. Open the Course atom, which is in the Basic Scheduling module.

10. From the Data pull-down menu, select Add Course. 

11. Complete the Course ID, Course Title, and any other fields you 
require for each course offered in the summer school. 

! If course numbers are unique at each school in the district, course 
numbers must also be unique for the summer school. 

! Add these course numbers to each school for course history to 
transfer back to the feeder school.

! If course numbers are the same at all schools in the district, use 
the same numbers for the summer school.
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Adding Summer School Courses

Complete this process for each course added to the Summer School file.

1. Open the Course atom.

2. In the Page Selection field, select Summer School.

3. In the Apportionment Category field, select Proficiency or Core.

4. In the Course Type field, select the type for the course.

5. In the Proficiency/Core field, select the area the course minutes 
should count toward. 

6. Click Save.

Note: For most schools the Proficiency/Core field value is the 
same as the Apportionment Category field.

Note: For the Course atom field definition information, see the 
SASIxp™ Basic Scheduling Training Guide.
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Preparing Files to Schedule Students

Adding Teachers – Site Procedure

1. Open the Teacher atom at the school site.

2. From the Data pull-down menu, select Add Teacher.

3. Complete the Last Name, First Name, and any other fields you 
require for all teachers teaching in summer school.

4. Click Save.

5. Click Close.

Adding Sections or Scheduling Sections

1. Depending on your process, open the Sections or Scheduling Sections 
atom.

2. From the Data pull-down menu, select Add Section. 

3. Add sections for all courses being taught in summer school.

Note: For the Course atom field definition information, see the 
SASIxp™ Basic Scheduling Training Guide.
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Scheduling the Students
1. Add student course requests in one of these processes: 

! If scheduling all students at a time, open the Scheduling atom, 
which is in the Mass Scheduling module, and enter the students’ 
course requests.

! If scheduling one student at a time, open the Walk-in Scheduling 
atom, which is in the Basic Scheduling module, and enter the 
course requests.

2. From the Scheduling pull-down menu, select one of these processes 
to schedule the students:

! To schedule all students with course requests, select Schedule All 
Students.

! To schedule one student at a time, select Schedule Student.

Attendance Setup
To print the Summer School Attendance report (ATP60), use positive 
attendance to show apportionment minutes.

Site Procedure – Calendar

1. Open the Attendance Setup atom. 

2. Complete the Beginning Date and Ending Date fields for the summer 
school session.

3. Click OK.

4. When the Attendance Setup screen displays, click Save.

Note: If you are opening the Attendance Setup atom for the first 
time, the SASIxp software prompts you to create files. Click OK to 
create all files.
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Setting Reporting Periods 

1. Select the Report Periods tab.

2. Complete the Start Date and Stop Date fields for the reporting 
periods. 

! The default for any attendance summary reports is 20 days.
! As long as the report dates do not overlap, you can set them up to 

run for any duration.

3. Click Save.
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Setting Absence Reasons 

1. Select the Abs Reasons tab.

2. From the Data menu, select Add Reason for any additional absence 
reasons for summer school.

3. Complete these fields:

! Cd (Code)
! Title
! Abbr (Abbreviation)
! Type (must be positive)
! Receives Apportionment (Yes)
! Included in Reports (Yes)

4. Click Save.
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Entering Scanner Options

If the summer school is using a scanner to scan in the attendance, 
complete these steps:

1. Select the Scanning tab.

2. Complete the field information to identify the type of the scanner in use 
by the summer school.

3. In the Absence Reasons section, define one bubble for the Positive 
absence reason.

4. Click Save.

Note: For Attendance Setup field definition information, see the 
SASIxp™ Attendance Training Guide.
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Taking Attendance

To print the Summer School Attendance report (ATP60), the summer 
school must use positive attendance to show apportionment minutes.

1. Open the Period Attendance atom, which is in the Attendance module.

2. Enter the Positive reason for each period the student is present.

! You can post attendance manually for each period a student is 
present.

! You can scan attendance in for each class.

3. Click Save when posting attendance manually.

4. Open the Period Attendance atom.

5. From the Period Attendance pull-down menu, select the Summer 
School Attendance report (ATP60). 

Note: If you are opening the Period Attendance atom for the first 
time, the SASIxp software prompts you to create files. Click OK to 
create all files.
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6. Fill in the report parameters taking into consideration the following 
information:

Fields Description

Report Period If report periods are defined in the 
Attendance Setup atom, enter which one is to 
print in this field.

Minutes Per Period Number of minutes are the same for each 
period. 

Note: If all periods are 60 minutes long, enter 
60 in this field.

Proficiency category Maximum number of apportionment minutes 
per day a student can enroll in. 

Note: If the summer school day consists of 4 
periods at 60 minutes per period, the 
proficiency is 240. 

Length X Minutes = Proficiency

Core category Maximum number of apportionment minutes 
per summer school session. 

Note: If the length of summer school is 30 
days and the proficiency is 240, the 
core is 7200.

Length X Proficiency = Core
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Processing Grades and Updating Course History 

School Site Grading Setup

Process Grade reporting is the same as it is in the regular school year.

1. Open the Grading Setup atom from the Grading Setup folder, which is 
in the Grade Reporting module.

2. Complete the field information for this atom to process grades, and to 
print report cards for students.

Updating Grades

1. Open the Update Grades atom from the Grading folder, which is in the 
Grade Reporting module.

2. Verify the Reporting Period is correct. 

Note: If you are opening the Period Attendance atom for the first 
time, the SASIxp software prompts you to create files. Click OK to 
create all files.

Note: If you are opening the Period Attendance atom for the first 
time, the SASIxp software prompts you to create files. Click OK to 
create all files.



240  Processing Grades and Updating Course History Copyright © 2005 Pearson School Systems

Setting Up Summer Schools

3. In the Select Operation field, select Update Grade Reporting File from 
the Student Schedules.

4. Click Run.

Processing Students Marks and Printing Report Cards

1. Enter marks for students in one or all of the following ways:

! Enter marks into Class Grades.
! Enter marks into the Grade file for each student.
! Create and print scan sheets and to enter the marks for each 

student.

2. Open the Grades atom.

3. From the Grade pull-down menu, select the Report Card report 
(GRD04) to print the student's report cards.

Updating Course History 

1. Open the Update Course History atom from the Course history folder, 
which is in the Grade Reporting module.

Note: If you are opening the Period Attendance atom for the first 
time, the SASIxp software prompts you to create files. Click OK to 
create all files.
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2. Select the mark or marks to transfer to the Course History.

3. Click Transfer.

Updating Course History to Feeder Schools 

For information on updating Course History files, see Manual Upload of 
Files on page 222.

Moving Marks to the Current School Year

Update Course History

Use this process at the district site to update the Course History from the 
summer school to the feeder school.

1. Open the Summer School atom.

2. In the Type of Processing section, select District.

Note: Only do this step one time, or multiple marks will transfer into 
the Course History file for the feeder school.
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3. In the Process section, select Update CHS.

4. Under the Summer Schools to Process matrix, click the Select 
Schools fast access arrow, and select all summer schools.

5. Under the Feeder Schools to Process matrix, click the Select Feeder 
Schools fast access arrow, and select all feeder schools.

6. Click Process. 

7. Review the Summer.log for error messages.

8. Open the Course History atom to ensure the courses and marks were 
transferred correctly.

Summer School Options

Updating Course History for New Year Rollover

Run this option set after transferring the last marks to Course History in the 
current school year. The resulting process adds marks and makes any 
mark changes to the file already in existence in the new year. Perform 
these procedures at the district site.

Option Description

Update Files Moves selected files from the summer school 
to the feeder school.

Update Schools 
Attended

Updates the schools attended information 
from the summer school.

Note: Requires a 4 digit School flag code.
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1. Open the New Year Rollover atom.

2. From the Data pull-down menu, select Add Option Set.

3. In the Option field, add the process title. 

4. In the Current School Year field, select the current school year.

5. In the School Type section, select School is Connected to District 
via WAN. 

6. In the Process Options section, select Update Student Files.

7. Click Save.

Note: Example: Course His xx/xx/xx   (xx/xx/xx = the date the 
process is run).
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Updating Student Files Page

1. In the Page Selection field, select Update Student Files.

2. Select the Update Course History checkbox.

3. Select the Update Course History Comments checkbox.

4. Below the Selected Schools to Process matrix, click the Select 
Schools fast access arrow.

5. Select schools by double-clicking the school name.

6. Click Done.

7. Enter the first apportionment date for the new school year in the 
Effective Date field.

8. Complete the Enter Code field.

9. Complete the Transfer Code field with the same code as the enter 
code.

10. Click Save.

For more information on the New Year Rollover atom, see New Year 
Rollover on page 173.
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Updating Course History Only

1. In the new school year, open the Backup/Restore atom.

2. Select ACHS to back up the file and continue with the backup process. 

Task Server

Log off of the Task Server to process the ACHS file.

1. Return to the option set created for the Student Files.

2. From the New Year Rollover pull-down menu, select Run.

3. After running the process, check the SUMMER.LOG for any errors. 

Note: Selecting the backup option ensures there is always a good 
copy of the file.

Note: Example: Course His xx/xx/xx”.
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4. If performing the process at the district server, copy the ACHS and 
ACHN files to the appropriate school sites.

Moving Qualified Files to Individual Schools
Choose one of these district processes to copy or transfer the summer 
school data down to school sites.

Datafile at the District

1. Open the Task Server screen, and from the Tasks pull-down menu, 
select Abort Current Task.

2. Copy all the qualified files from the district datafile to the individual 
school’s datafile. 

3. Copy all new school files down to the individual school sites at the 
same time.

4. Open the Task Server screen, and from the Tasks pull-down menu, 
select Transfer Students.

Note: Before the district moves files down to the school sites, all 
school sites must do a backup of the new year data. 

Note: This step is necessary before copying qualified files to the 
schools over the WAN.
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District Control Download

Use the District Control atom’s download process to move qualified files to 
the school sites.

1. Open the District Control atom.

2. In the Upload Override Options section, modify the Upload Year field 
to the school year in which the summer school was created. 

3. Select the Upload/Download tab.

4. From the District pull-down menu, select Add Download File. A new 
matrix line is added to the Download File matrix, permitting you to 
select a file to include in the download process. Repeat this step to 
define all of the download files.

5. Click Save.

Note: Before using this process, add campus records to the Campus 
atom for the summer school sites. If the summer school data is not 
uploaded to the district, remove campus records from the summer 
schools using the campus atom.
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Task Server Download
1. Open the Task Server application. 

2. From the Tasks pull-down menu, select Download to Remote Sites. 
This option temporarily disables real-time operations of the Task 
Server. 

District Control Atom

1. Open the District Control atom.

2. In the Upload Override Options section, change the Upload Year field 
to the current school year.

3. Select the Upload/Download tab, and remove the files from the 
Download Files List. 

4. Click Save. 

5. Quit and restart the Task Server application.

6. From the Tasks pull-down menu, select Transfer Student.

Note: Hold the summer school in the school year for which you want to 
update the transcripts. 

If summer school is held in the current year, the Update CHS in 
Summer School atom does not update next year’s course history.
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Uploading Summer School Files
Do not upload summer school files to the district. Any changes made to 
the files in the summer school will not be moved back to the files at the 
feeder schools. 

! After you run the Summer School process, the system tags each 
student’s file internally with specific data in the School_Attend and 
SchoolStuLink fields. This insures the transfer of the course history to 
the correct students. Populate the School_Attend with the feeder 
school number, and populate the SchoolStuLink with the StuLink the 
student has in the feeder school.

! Students keep the courses they are enrolled in for the entire summer 
school session if using the Summer School Attendance Summary 
report (ATP60). Use one of the following processes for this purpose:

1. Inactivate a student who is not enrolled in any classes after summer 
school has started:

! Inactivate the student, but do not drop the classes. The period 
attendance for this student will show N/E for all the days after the 
leave date. 

! The student will not show on attendance scan sheets.
! The student will be on the ATP60 report with the correct number of 

hours of attendance.

Note: For the days the student was present, the attendance 
should show the positive attendance reason.
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2. A student is dropping one or more classes, but still attending one or 
more classes:

! In the School atom, add an extra period to the end of the day for 
the summer school. Do not use this additional period in the 
calculations of the ATP60 report. Only use it to accommodate the 
dropped class.

! Add a section for each course with the new period and exclude it 
from attendance scan sheets. 

! Drop the student from the original class.
! Add the section to the student with the extra period. Change the 

start date of this section to the original start date of the class the 
student dropped.

Note: If the summer school is offering 10 courses, add 10 new 
sections. 

Note: The ATP60 report looks at the positive attendance and 
the course this attendance was taken. It does not look at the 
specific period the student attended the class. Therefore, by 
adding the extra period to the student’s schedule, with the 
original start date. The student will get credit on the report for 
the number of hours they attended the class.
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This appendix provides samples of these configuration worksheets for 
your District Integration implementation:

! Task Server Workstation Configuration
! Campus Setup Atom Configuration
! District Site User Information
! School Configuration Information Worksheet
! District Next Student ID
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Task Server Workstation Configuration Worksheet

Task Server 
Name TCP/IP Address

Server 
Port Poll ID

Account Name on 
District Server

UNC Resource For 
District SASIxp 

Apps

Drive Map to 
UNC 

Resource
Path District 
SASIxp Apps

/SASIxp



Copyright © 2005 Pearson School Systems Campus Setup Atom Configuration Worksheet  253

Campus Setup Atom Configuration Worksheet

Task Server 
Name

TCP/IP
Address

Task Server #
(Poll ID) District Upload Path

\\TSKSVR1 192.168.0.25 1 M:\SASIXP\UPLOAD

Campus
Name Upload Time Remote Site Data Path

Network 
User 

Name
Network

Password
Upload
Year

Upload 
Options
(A/C) School #

Upload 
Year

HighSchool 2200 \\SASIHS\NCS\SASIXP\DATAFILE hstsksvr test 97-98 C 901 97-98
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District Site User Information Worksheet

Network Access District Integration Atoms Accessibility

Name

SASI 
User
Name

Network
Account

(Directory
Services)

Server 
Account Server

SASIxp
Resource

SASIxp
Drive 
Map

SASIxp 
Directory

District 
Control 
Atom

Campus 
Setup 
Atom

District 
Atom

Create/
Update 
District 
Atom

New 
Year 
Roll-
over 
Atom

School 
Atom

File 
Defin-

ition Pro 
Atom

Security 
Atom 

SASI 
Modules 

Setup 
Atom

Smith, Joe joes jsmith dstsvr ncs m: SASIxp X X X
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School Configuration Information Worksheet

School 
Number School Name Sch Abrv Grades Taught Promote to Beg Per End Per

Section 
ID Length Leave Date

Last Day of Enrollment

Last Day of Enrollment

Last Day of Enrollment

Last Day of Enrollment

Last Day of Enrollment

Last Day of Enrollment

Last Day of Enrollment

Last Day of Enrollment

Last Day of Enrollment

Last Day of Enrollment

Last Day of Enrollment

Last Day of Enrollment

Last Day of Enrollment

Last Day of Enrollment

Last Day of Enrollment

Last Day of Enrollment
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Sample Configuration Worksheets

District Next Student ID Worksheet

School 
Number

PermNum Query 
Low Value

PermNum Query 
High Value
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This section provides additional information to assist in the troubleshooting 
of Task Server program operational errors.

The SASIxp™ software maintains Task Server operational status 
information in three log files at the District Site. These three files are 
AUFS, AONL, and ATEL. 

School Site client workstations update a local school site log data file for 
District Integration enrollment operations (ATLL).

Using the Query atom, you can interrogate these log files.

These log files are cumulative and can grow to be extremely large. 
Periodically you must manually delete some of these files to improve 
performance. Deleting these files ensures they do not consume a large 
amount of disk space on the school and district site file servers.
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Troubleshooting the Upload Process
During the upload process, the DI Task Servers maintain a log of upload 
transaction status messages in the Upload File Status file (AUFS). The 
following table provides information on the messages in the AUFS file. 

The Level Type key equivalents are:

! F=Failure
! W=Warning
! S=Success

Level 
Type Code

Message 
Description Possible Reasons

F 11 Error copying the 
file

! Not enough space on the District 
file server

! Not enough privileges to see 
directories or copy files from the 
site file server

! Hard disk corruption
! Network connection problems

F 21 Volume cannot 
be mounted

Cannot map 
drive to the 
volume

! Invalid user ID or password
! User ID does not have connect 

authority
! School network does not permit 

connections after a specific time
! Password encryption at school 

server

F 31 Wrong server 
type

Windows Task Server tried to 
upload from an AppleShare site file 
server

F 51 Internal error Unknown; note the IntCode field 
and call Pearson School Systems 
Support

F 52 Internal error Unknown; note the IntCode field 
and call Pearson School Systems 
Support
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F 58 User abort User aborted the Upload process 
from the Task Server

F 59 Error Detected One of the above errors was 
detected

W 61 Cannot set time 
stamp for 
successfully 
uploaded file

Internal error; call Pearson School 
Systems Support

W 62 Cannot un-
mount volume

Cannot 
disconnect 
volume

! The current drive is in use for 
another process

! The system is not connected to 
the current drive

W 63 Warnings during 
upload

One of the above warnings was 
issued

S 71 File copied 
successfully 

Status message

S 81 Begin uploading 
one school

Status message

S 89 End uploading 
one school

Status message

S 91 Begin upload 
process

Status message

S 99 End upload 
process

Status message

Level 
Type Code

Message 
Description Possible Reasons
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Troubleshooting the Download Process
During the download process, the DI Task Servers maintain a log of 
download transaction status messages in the Download File Status file 
(ADFS). The following table provides information on the messages in the 
ADFS file. 

The Level Type key equivalents are:

! F=Failure
! W=Warning
! S=Success

Level 
Type Code

Message 
Description Possible Reasons

F 11 Error copying the 
file

! Not enough space on the district 
file server

! Not enough privileges to see 
directories or copy files from the 
site file server

! Hard disk corruption
! Network connection problems

F 21 Volume cannot 
be mounted

Cannot map 
drive to the 
volume

! Invalid user ID or password
! User ID does not have connect 

authority
! School network does not permit 

connections after a specific time
! Password encryption at school 

server

F 51 Internal error Unknown; note the IntCode field 
and call Pearson School Systems 
Support

F 52 Internal error Unknown; note the IntCode field 
and call Pearson School Systems 
Support

F 58 User abort User aborted the Download process 
from the Task Server
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F 59 Error Detected One of the above errors was 
detected

W 61 Cannot set time 
stamp for 
successfully 
downloaded file

Internal error; call Pearson School 
Systems Support

W 62 Cannot un-
mount volume

Cannot 
disconnect 
volume

! The current drive is in use for 
another process

! The system is not connected to 
the current drive

W 63 Warnings during 
download

One of the above warnings was 
issued

S 71 File copied 
successfully 

Status message

S 81 Begin 
downloading one 
school

Status message

S 89 End 
downloading one 
school

Status message

S 91 Begin download 
process

Status message

S 99 End download 
process

Status message

Level 
Type Code

Message 
Description Possible Reasons
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Troubleshooting the Overnight Process
The Task Server uses the Overnight Log file (AONL) to record Overnight 
transaction status messages. Some of the errors in the AONL file may also 
indicate problems with the Upload process. Query the AUFS and AONL 
files to identify all errors.

The Level Type key equivalents are:

! F=Failure
! W=Warning
! S=Success

Level 
Type Code

Message 
Description Possible Reasons

F 21 Cannot create 
TEMP directory 
in the SASIXP/
DATAFILE 
directory

! Not enough space on the District 
file server

! Problems with the hard drive

F 31 Cannot move file 
from dump 
directory to the 
SASIXP/
DATAFILE 
directory

! SASIxp software is running on 
the District file server

! Problems with the hard drive

F 32 Error during 
uploading this 
school. Data will 
not be moved 
from dump 
directories to the 
SASIXP/
DATAFILE 
directory

Error during the Upload process - 
query the AUFS file to determine 
the upload error

F 58 User abort User aborted the process from the 
Task Server

F 59 Error detected 
during overnight 
process

One of the above errors occurred 
during the Overnight process
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Analyzing the ATEL File
When generating the real-time transactions add, inactivate, transfer, 
delete, or no-show, the SASIxp software performs several mini-
transactions. The SASIxp software records these mini-transactions in the 
ATEL file.

The fields in the ATEL file and their possible contents are:

S 71 Moved one file 
successfully 
from the dump 
directories to the 
SASIXP/
DATAFILE 
directory

S 81 Begin moving 
files for one 
school

S 89 End moving files 
for one school

S 91 Begin overnight 
process

S 99 End overnight 
process

Level 
Type Code

Message 
Description Possible Reasons

Field Description

School Number School number the student is enrolled in or 
dropped from.

User ID User ID of the enrollment clerk at the school 
site where the enrollment transaction takes 
place.
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Command Transaction Messages

Log Number Consecutive number assigned to each record 
in the log file. When the Task Server is re-
started, this number resets to zero.

Task Server Number the Task Server creates for the 
record. Each Task Server assigns a number 
in the [PollPC] section of the SASIXP.ini file.

Trans Date Date of the transaction.

Trans Time Time of the transaction.

Command A number identifying the transaction.

See Command Transaction Messages on 
page 264.

Level Error identified by the Task Server. 

See Level Error Messages on page 266.

Error Error identified by the database or operating 
system. 

Permanent Number Student’s permanent ID number.

Field Description

Number Displayed Message Description

1 TSK_GET_TASK_SERVER_INFO School atom confirms 
Centralized District 
Processing.

2 TSK_GET_N_STUDENTS_GIVEN_NAME Enrollment atom gets list 
of student names to find.

3 TSK_GET_N_STUDENTS_GIVEN_ID Enrollment atom gets list 
of students.

4 TSK_GET_STUDENT_RECORD_GIVEN_ID  Enrollment Atom gets 
student record to show 
prior to save.
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5 TSK_ADD_STU_DST_RECORD_GIVEN_NAME   Enrollment Atom adds 
student to District and 
site, and gets perm ID.

6 TSK_ACTIVATE_STU_DST_RECORD_GIVEN_ID Enrollment Atom 
transfers or re-activates a 
student.

7 TSK_INACTIVATE_STU_DST_RECORD_GIVEN_ID  Enrollment Atom 
inactivates a student.

8 TSK_DELETE_STU_DST_RECORD_GIVEN_ID   Enrollment Atom deletes 
a student.

9 TSK_GET_LIST_OF_SUB_FILES Enrollment Atom needs 
list when transferring or 
dropping a student.

10 TSK_GET_SUB_RECORDS_GIVEN_ID_AND_SUB   Enrollment Atom gets one 
sub-file at a time, when 
transferring.

11 TSK_GET_STU_PICTURE_GIVEN_ID Enrollment Atom retrieves 
the photo to show prior to 
saving.

12 TSK_WRITE_STU_PICTURE_GIVEN_ID Enrollment Atom sends 
the photo to the archive 
file when inactivating a 
student.

13 TSK_WRITE_SUB_RECORDS_GIVEN_ID_AND_SUB  Enrollment Atom sends 
one sub-file at a time, 
when inactivating.

14 TSK_NOSHOW_STU_DST_RECORD_GIVEN_ID   Enrollment atom No-
Shows a student.

Number Displayed Message Description
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Level Error Messages

Number Displayed Message Description

1 TSK_NO_ MEMORY The Task Server does not have 
enough memory. On a Macintosh, 
use Get Info to increase the Task 
Server’s memory. On Windows, 
acquire more memory.

2 TSK_CANT_GET_DST_RECS Error retrieving a list of students.

3 TSK_CANT_FIND_ONE_DST_REC  Cannot open a sub-file, or cannot 
get the student’s district record 
using the Perm ID. 

4 TSK_INVALID_MIRROR_SCHOOL Due to an error in the ADST file, 
cannot determine the student’s 
mirror school.

5 TSK_INVALID_MIRROR_STU_LINK  Due to an error in the ADST file, 
cannot determine the student’s 
mirror StuLink.

6 TSK_CANT_FIND_ONE_STU_RE Cannot find the student in the 
mirror ASTU file using the Perm 
ID.

7 TSK_CANT_OPEN_STU_MIRROR Cannot open the mirror ASTU file.

8 TSK_CANT_UPDATE_STU_REC Cannot update the student record 
in the mirror ASTU file.

9 TSK_CANT_DELETE_STU_REC Cannot delete the student record 
in the mirror ASTU file.

10 TSK_CANT_DELETE_DST_REC Cannot update the student record 
in the ADST file.

11 TSK_CANT_OPEN_STU_PICT Cannot create the photo file when 
inactivating the student.

12 TSK_CANT_READ_STU_PICT Error reading the photo file when 
transferring a student.
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13 Invalid subfile (lacks StuLink or SchNum field) 
in list.

No StuLink or SchNum found 
during the transfer of subfiles in 
the enrollment process.

14 TSK_XMIT_CPY_ERROR Not used.

15 TSK_CANT_CREATE_FILE Not used.

16 TSK_CANT_WRITE_TO_FILE Not used.

17 TSK_CANT_READ_FROM_FILE Not used.

18 TSK_CANT_WRITE_STU_PICT Not used.

19 TSK_TASK_SERVER_ERROR Not used.

20 TSK_CANT_GET_SUB_LIST Not used.

21 TSK_CANT_FIND_SCHOOL_REC Cannot get the school record in 
the ASCH file.

22 TSK_NO_SUB_FILES No sub-files were entered in the 
District Control atom.

23 TSK_CANT_ADD_STU_REC Not used.

24 TSK_TRN_SCH_SAME_AS_MIRROR_SCH Attempting to transfer or reactivate 
a student in a school, and the 
student record in the ASDT file 
shows the student is already active 
in that school.

25 TSK_FILE_INFO_ERROR Not used.

26 TSK_KEY_INFO_ERROR Not used.

27 TSK_CANT_UPDATE_SUB_FILE When inactivating or no-showing a 
student, cannot update records in 
the mirror sub-file.

28 TSK_CANT_DELETE_SUB When inactivating or no-showing a 
student, cannot delete records in 
the mirror sub-file. 

Number Displayed Message Description
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29 TSK_CANT_OPEN_SUB Cannot open a mirror sub-file, or 
the data sent from the site is 
invalid. 

30 TSK_CANT_LOCK_DCL_FOR_NEXT_ID Not used.

31 TSK_CANT_UPDATE_DCL_FOR_NEXT_ID Error trying to get the next Perm 
ID from the ADCL file when 
adding a new student to the 
District.

32 TSK_CANT_READ_DCL_FOR_NEXT_ID  Error trying to get the next Perm 
ID when adding a new student to 
the District.

33 TSK_CANT_ADD_STUDENT_TO_MIRROR  Cannot add the student to the 
mirror ASTU file.

34 TSK_CANT_ADD_STUDENT_TO_DST  Cannot add the student to the 
ASDT file. Reorganize the ADST 
file if this error persists.

35 TSK_CANT_GET_NEXT_STU_LINK  Not used.

36 Unable to get student (ASTU) record from 
mirror file

The Task Server is not 
communicating with the District 
office.

37 Unable to activate student at the district office The Task Server is not 
communicating with the District 
office.

38 Unable to inactivate student at the district office The Task Server is not 
communicating with the District 
office.

39 Unable to delete student at the district office The Task Server is not 
communicating with the District 
office.

40 Unable to add student at the district office The Task Server is not 
communicating with the District 
office.

Number Displayed Message Description
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41 TSK_CANT_GET_NEXT_DST_LINK The next District Link cannot be 
retrieved from the ASCU file. 
Make sure the Next ID Atom has 
an entry greater than zero for 
ASDT, DST_LINK.

42 TSK_UNABLE_TO_UPDATE_TRN Cannot update the ATRN file. The 
SASIxp software only uses the 
ATRN file when students are 
concurrently enrolled in two or 
more schools.

43 TSK_UNABLE_TO_ADD_TRN Cannot add to the ATRN file. The 
SASIxp software only uses the 
ATRN file when students are 
concurrently enrolled in two or 
more schools.

44 TSK_NO_ACTIVE_TRN_RECORD_FOUND Attempting to delete, inactivate, or 
no-show a student from one of the 
concurrently enrolled schools, and 
there is no record of the student in 
the ATRN file.

45 TSK_CANT_OPEN_ENR_MIRROR Cannot open the AENR file.

46 TSK_UNABLE_TO_NOSHOW_ONE_STU_TS Not used.

47 TSK_CANT_OPEN_LAST_STU_MIRROR   When undoing a transfer, the 
ASTU file for the student’s 
previous school cannot be 
opened.

48 TSK_CANT_UPDATE_DST_REC Cannot update the student’s 
record in the ADST file with the 
Enrollment code and date or the 
leave code and date.

Number Displayed Message Description
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New Year Rollover Error

Number Displayed Message Description

1 ’Cannot get valid enter codes for school XXX 
and year ??’

Verify the current school year is 
selected. Verify the Table (ATBL) 
and Sequence Control (ASCF) 
files are created for the Archive 
school, for the current school year.
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